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Caution
Electrostatic Discharge
Some devices can be damaged by improper handling. Use appropri-
ate electrostatic discharge (ESD) procedures when handling these 
devices. See http://www.esda.org/ for additional information on ESD 
procedures.

Caution
USB Security Key Damage
Before Sentinel System security key drivers are installed, all Sentinel 
USB keys must be removed from the PC. Installing a system driver 
with a USB key in the port causes the key to be unusable.
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1.1 Overview

Neurons in the brain communicate by firing action potentials (spikes). These 
brief voltage spikes can be picked up by electrodes placed near the neurons. Each 
neuron typically generates a spike with a distinct waveform shape. Neurons can 
generate similarly-shaped spikes. The shape differences are mainly due to elec-
trode-to-neuron distances. Thus, if cells have similar morphology and they are at 
the same distance from an electrode, their waveform shapes can be indis-
tingquishable. Assigning spikes to particular neurons is an important step in most 
experiments. To do so, the spikes must be accurately assigned to specific neurons 
with a high degree of reliability.

The most prominent feature of a spike is its amplitude. If there are several elec-
trode sites (stereotrodes or tetrodes) that are picking up the same neurons, it is 
less likely that the neurons are equidistant from the electrode sites. A voltage-
threshold trigger is one of the simplest ways to detect spikes. The range of a 
detection device can also be set to display the portions of the waveform before 
and after the threshold crossing. This enables the characteristic shape of the 
waveform to be visible. The Multichannel Acquisition Processor (MAP) system 
(Harvey Box) is a combination of hardware and software that enables the wave-
forms to be viewed, the action-potential waveform segments around a voltage-
threshold crossing to be captured, and permits them to be sorted in real time 
according to their shape.
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1.2 RASPUTIN Software

The following illustration shows the relationship between the various compo-
nents of the MAP system and the RASPUTIN Software.

The RASPUTIN Software is a suite of client/server programs that runs on the 
Microsoft Windows* operating system. A client is an online data or control pro-
gram that accesses or uses a service provided by another program, in this case, a 
server program. The RASPUTIN Software controls spike sorting in the MAP sys-
tem and it provides data visualization and data analysis in real time. 
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1.3 MAP

The MAP system provides programmable amplification, filtering, and real-time 
spike sorting of multi-electrode signals. The MAP is a modular system of plug-in 
circuit boards mounted in a stand-alone box that is scalable from 16 to 128 chan-
nels. The following illustration shows a 128-channel MAP system.

 

The MAP system can also record up to 256 continuous signals, such as field 
potentials, eye position, blood pressure, etc., using one or more National Instru-
ments™ Data Acquisition (NI DAQ) devices. The RASPUTIN Software pro-
grams can record these continuous signals together with the spike and digital-
event data in a single data file. The MAP includes the following key features:

• Simultaneous 40 kHz (25 msec) analog-to-digital (A/D) conversion on each 
channel at a 12-bit resolution.

• Multiple digital inputs for external synchronization and experiment-state 
variables from behavioral equipment, such as individual TTL lines or multi-
bit strobed-word data.

• Optional non-spike analog-signal data acquisition for continuous digitization 
of field-potential data, physiological signals, behavioral signals, etc.



 

Version 2.6 5

1.4 RASPUTIN Software Components

The RASPUTIN Software suite includes several components. The components 
are as follows: 

• Sort Client

• MAP Server (Configuration)

• Ref2

• PLX Utilities (PlexUtil)

• PlexNet

• Graphical Activity Client (GAC)

• PeriEvent Client (PEC)

• Grid Monitor (GridMon)

• Client Development Kit

• Continuous Signal Recording

1.4.1 Sort Client

Sort Client is the primary control program for the Plexon Multi-channel Acquisi-
tion Processor (MAP) system hardware (the Harvey Box). The MAP system pro-
vides real-time spike sorting based on digital signal processors (DSP). Sort Client 
may be used to adjust the MAP operating parameters (amplification, filtering, 
etc.) and to set the specific sorting parameters for each channel. If a NI DAQ sub-
system is installed in the PC, Sort Client also enables viewing of continuous sig-
nals.

With Sort Client, the user can:

• Visualize spike waveforms

• Display simple raster plots

• Record spikes and continuous data (e.g. field potentials) to a file

• Control the MAP system to threshold and sort spikes by using:

— time-amplitude window discriminator boxes

— template matching

1.4.2 Installation

The Installation appendix contains the instructions for installing the MAP soft-
ware and the required hardware security keys.

1.4.3 MAP Server (Configuration)

MAP Server is the low-level interface for configuring the MAP. MAP Server 
transfers commands such as gain and filter changes or parameter settings from 



1 Introduction 

6  RASPUTIN Software

the various clients to the MAP box. MAP Server also accumulates data coming 
from the MAP box in a circular buffer memory. The client programs connect to 
MAP Server to gain access to that data. MAP Server also mediates communica-
tion between the clients, keeping them informed of commands sent to the MAP 
from other clients.

1.4.4 Ref2

Ref2 is channel-connection control software. With Ref2, the user can:

• Designate up to seven reference channels for each preamp

• Control programmable referencing in up to four Plexon PBX preamplifiers

• Connect spike channels to the connectors on the MAP system OUT board

1.4.5 PlexNet

PlexNet broadcasts MAP data in real time to other computers within a TCP/IP 
(Ethernet) network. This allows running clients or NeuroExplorer (NEX) in real 
time on a remote computer. With PlexNet, the user can also remotely analyze data 
using MATLAB* or a custom client program.

1.4.6 PLX Utilities

PLX files are Plexon data files containing spike timestamps and waveforms, 
event timestamps, and continuous waveform data. PLX Utilities (PlexUtil) is a 
program for merging and extracting portions of PLX data files.

1.4.7 Graphical Activity Client 

Graphical Activity Client (GAC) is a real-time observation tool for monitoring 
spike activity or continuous waveforms. 

1.4.8 PeriEvent Client

PeriEvent Client (PEC) is a tool for displaying histograms and perievent rasters 
in real time.

1.4.9 Grid Monitor

Grid Monitor (GridMon) displays spike-rate activity in real time as an animated 
color grid.

1.4.10 Client Development Kit

The Client Development Kit contains sample code that can be used to develop 
custom applications. The kit also includes  information on sample C programs for 
the MAP and MATLAB® Extensions. The Event-triggered Field Potential GUI 
(graphical user interface) is a MATLAB extension to the MAP software that plots 
a field potential signal around a spike, or external event, in real time.
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1.4.11 Continuous Signal Recording

Continuous Signal Recording contains setup information and specifics on how to 
record continuous signals.

1.5 Hardware Requirements

The following hardware is required to use the RASPUTIN Software suite:

• A PC equipped with one of the following Microsoft operating systems:

— Windows XP

— Windows NT

— Windows 2000

• A complete Plexon MAP (Harvey Box) system with the MAP-system PC 
components (cards and cabling) installed in a PC that is running the MAP 
software.

• A signal source

1.6 Terminology

1.6.1 Analog

Terms like analog and analog channels appear in various areas in Sort Client. 
These terms usually refers to analog data that is continuously recorded.

1.6.2 Continuous

In general, continuous is used throughout this manual to refer to any signal 
recorded continuously for as long as the data acquisition switch is turned on. 
Continuous excludes spike waveform segments and digital event data. Continu-
ous includes both continuous signals sampled at high frequencies (spike and 
wide-band signals, EMG, etc.) and continuous signals sampled at low frequencies 
(field potentials and other external signals such as x,y, eye position, etc.).

1.6.3 Digital

The term digital refers to digital events, where Sort Client only looks for a rising 
edge on a signal and only saves the timestamp of that trigger crossing.

1.6.4 Fast and Slow

The terms fast and slow describe sampling rates, when there is a need to distin-
guish between two rates.

1.6.5 Spike Waveform Segments

The term spike waveform segments describes the waveform segments around 
threshold crossings.
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2.1 Overview

This overview includes information about spike sorting and Sort Client, which is 
the main user interface in RASPUTIN Software. MAP Server supports Sort Cli-
ent. For more information, see Chapter 3 “MAP Server” on page 137.

In general, neurons can produce similar waveform shapes. Electrode-to-neuron 
distance, neuron type, and cell morphology can all have an effect on the on the 
waveform shape (spike) detected by an electrode during extra-cellular recording. 
Each neuron typically has a characteristic spike waveform shape. Thus, ampli-
tude is the most prominent feature of a spike. A voltage-threshold trigger is one 
of the simplest ways to detect spikes. The user can also set the range of a detec-
tion device to display the portions of the waveform before and after the threshold 
crossing. This enables the user to see the characteristic shape of the waveform. 
Sort Client enables the user to capture action-potential waveform segments 
around a voltage-threshold crossing and sort them in real time according to their 
shape.

Sort Client is the primary MAP control program for real-time DSP-based spike 
sorting. With Sort Client, the user can adjust the MAP operating parameters 
(amplification, filtering, etc.) and set the specific sorting parameters for each 
channel. If a NI DAQ subsystem is installed in the PC, Sort Client also enables 
the user to view and save spike rasters, spike waveforms, and continuous signals. 
Sort Client is real-time MAP-control software that enables the user to sort and 
classify spikes. An illustration of the Sort Client main-window follows.

The user can use Sort Client to save the following items to Plexon data (PLX) 
files:

• Thresholded and sorted action potential (spike) waveform segments, with 
timestamps of threshold crossings

• Timestamped external digital events (TTL and strobed words)
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• Continuous channel data (field potential and others)

2.2 Principles of Spike Sorting

This section contains basic tutorial information on the principles of spike sorting. 
For additional information, see “Related Documents” in the “About This Docu-
ment” section.

Neurons in the brain communicate by firing action potentials (spikes). These 
brief voltage spikes can be picked up by electrodes placed near the neurons. Each 
neuron typically appears as a spike with a distinct waveform shape.

In most cases, each electrode receives spikes from more than one neuron. There-
fore, to assign spikes to particular neurons is an essential step in most experi-
ments. To do so, the user must be able to accurately assign the spikes with a high 
degree of reliability.

However, to accurately assign a spike to a specific neuron, the user must con-
sider:

• Background noise

• Neurons in the same area with spikes of similar shape and amplitude

• Neurons in the same area with smaller spike amplitudes

• Signals from other cellular activity like axonal fibre bundles, which are typi-
cally smaller and more localized

• Local field potentials (LFPs) and other low-frequency signals upon which 
spikes can be superimposed

For example, look at the raw wave-
form in the illustration. There are sev-
eral spikes. Does each spike come 
from a different neuron? If so, which 
one? There is also a considerable 
amount of background noise. The 
spikes from some neurons can also be 
overlapped due to nearly-coincident 
firing times.

2.2.1 Spike Sorting Fundamentals

Spike sorting consists of two basic tasks: detection and classification.

2.2.1.1 Detection

The most prominent feature of a spike is the amplitude of its peaks and troughs. 
The user can typically trigger the detection of spikes with an amplitude (voltage) 
threshold and then capture the waveform segment defined by a specified amount 
of time before and after the threshold crossing.
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2.2.1.1.1 Detection Issues: Detection errors occur when the detection threshold is 
set too far from the zero (0) position. Although such a setting separates major 
spikes from the background activity, the user can miss smaller spikes altogether. 
For example, in the following illustration of a typical segment of a WaveStrip dis-
play from Plexon Recorder the threshold (horizontal line) is set too far from zero 
to detect all spikes. Set the voltage threshold close enough to zero to pick up 
smaller spikes without picking up background noise. Do not to set the threshold 
so low that noise is included.

2.2.1.2 Classification

After detection, a waveform must be classified by assigning it to a particular neu-
ron, based on its distinctive waveform shape. As shown in the following illustra-
tion, neurons 1 and 2 have different waveform shapes. In the waveform window, 
the shapes are overlaid and aligned about the threshold crossing.

Large spike

Small spike
Missed spike

http://www.plexoninc.com/Recorder.htm
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2.2.1.2.1 Classification Issues: Classification issues can occur when spikes are 
misclassified with or as another neuron, or as noise. There are three types of clas-
sification errors: omission, inclusion, and superposition.

• Omission

— Omission occurs when the user detects a spike from a neuron (Neuron 
A) and misclassifies it as another neuron (Neuron B) or as noise. The 
spike is incorrectly omitted from its classification as Neuron A.

• Inclusion

— Inclusion occurs the user detects noise or a spike from a neuron (Neu-
ron B), and it is misclassified with another neuron (Neuron A). The 
spike or noise is incorrectly included in the classification for Neuron A.

• Superposition

— Superposition occurs when two distinct neurons fire nearly simulta-
neously, which causes their spike waveforms to be superimposed. 
Superposition often leads to omission errors.

2.2.2 Detecting and Classifying Spikes

Although threshold detection is effective for the detection of spikes from a single 
neuron, spikes from multiple neurons received by the same electrode require clas-
sification. As shown in the following illustration, there are several spikes that 
have roughly the same amplitude, but different waveform shapes.

Neuron DNeuron BNeuron A Neuron C

Combined View

Discrete Unit Views
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The individual colors that appear in the previous illustration reflect sets of sorted 
spikes that are classified by using one of the following techniques:

• Time-voltage boxes: spike waveforms are classified as a unit when they pass 
through a fixed set of boxes, which the user sizes and places, to distinguish 
only those waveforms that originate from the same neuron; see “To use the 
Boxes sorting method” on page 39. Time-voltage boxes remain fixed and 
waveforms from some neurons can slowly drift out of the boxes over time.

• Waveform templates: templates are derived from a subset of waveforms by 
selecting bundles or clusters of waveforms whose mean values serve as tem-
plates for each unit; see “To use the Templates sorting method” on page 45; 
waveform templates can be set to adapt to signals that drift slowly as sorting 
progresses. For more information, see “Template Adjustment” on page 89.



Version 2.6  15

2.2.2.1 Multiple Electrodes (Stereotrode and Tetrode)

The waveforms from neurons that are in close proximity to each other can be dif-
ficult to separate and classify. The user can use the signals from grouped multiple 
electrodes to separate the waveforms and classify them by assigning them to the 
appropriate neurons. Unlike individually recorded multiple electrodes, grouped 
multiple electrodes (stereotrode or tetrode) receive neural signals almost simulta-
neously from neurons that are in close proximity to each other.

The signal strength at an electrode depends on three major factors: neuron type, 
neuron morphology, and neuron location relative to the electrode. The following 
illustration shows two different neuron cells with nearly identical waveforms and 
their signal strengths relative to each individual electrode in the tetrode group. 
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2.2.2.1.1 Tetrode Detection: In the preceding illustration, when Cell #1 and Cell 
#2 fire, discriminating between them is difficult with a single electrode. For 
example, Electrode 3 is equidistant from both cells and the waveform shapes 
appear to be from the same cell. With a tetrode (4-electrodes) however, the signal 
strength is directly related to the proximity of the electrode, which makes it easy 
to locate the individual cell that generated the spike. The shapes detected on the 
remaining electrodes (1, 2, 4) clearly indicate the presence of two distinct cells.

To use tetrode detection, set the threshold for each of the four electrodes indepen-
dently. If a threshold is crossed on any of the electrodes, the MAP hardware and 
Sort Client capture and store all four waveform segments for subsequent classifi-
cation using Plexon Offline Sorter (OFS).

2.2.3 Importance of Manual Sorting

Although Sort Client includes several algorithms that can be applied to automati-
cally sort and classify spikes, they work best only under ideal conditions. Manual 
sorting methods continue to provide a robust and reliable way to sort and classify 
spikes. Sort Client supports a variety of manual sorting methods and provides a 
wide variety of adjustments and settings to ease the task. However, the user can 
use the automatic sorting features in Sort Client as a starting point for additional 
manual adjustments. For information on Sort Client automatic sorting features, 
see “Auto Procedures” on page 130.

http://www.plexoninc.com/OFS.htm
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2.3 Sort Client Procedures

The following table shows the steps for using Sort Client and the MAP system to 
view, sort, and record spikes.

2.3.1 Setup

There are two major setup steps:

1 Start Sort Client, which automatically starts MAP Server. For information on 
MAP Server, see Chapter 3 “MAP Server” on page 137.

2 a) Create a sorting parameters (.exp) file (See “Create a New Sorting Parame-
ters File” on page 19.)
or
b) Load an existing .exp file (See “Load a Sorting Parameters (.exp) File” on 
page 60.)

Note: If the user is using Sort Client for the first time, or if the user is beginning a new 
experiment, a new .exp file will typically be created.

Step Action: Follow this link:

1 Start Sort Client Chapter 2 “Start Sort Client” on page 18

2 If a new .exp file is not needed, go to 4.

3 Create a new .exp file and go to 5. Chapter 2 “Create a New Sorting Parameters File”
on page 19

4 Load .exp file Chapter 2 “Load a Sorting Parameters (.exp) File”
on page 60

5 Click Start

6 Check Sort Client settings Chapter 2 “Check Sort Client Settings” on page 60

7 Sort and Record Chapter 2 “Sort and Record” on page 67

8 If parameters need checked... Chapter 2 “Check Sort Client Settings” on page 60

9 Monitor recording Chapter 2 “Monitor Recording” on page 71

10 Click Stop
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2.3.1.1 Start Sort Client

Before starting Sort Client, turn the MAP system on. When starting Sort Client, 
Server automatically starts. For information on starting Server independently, see 
“Startup” on page 141. 

To start Sort Client, double-click SortClient.exe in the directory where 
the RASPUTIN Software is installed, or double-click the Sort Client 
icon on the desktop.

The following illustration shows the Sort Client main window immediately after 
startup. The illustration also identifies the four major areas of the main window 
that apply to the procedures that follow. For detailed information on the features 
of the main window, see “The Sort Client Main Window” on page 73.

Multi-Display WindowWaveform WindowControl Table

Units Display
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2.3.1.2 Create or Load a Sorting Parameters (.exp) File

A parameter file contains the Sort Client settings for data acquisition, display, and 
control. When starting Sort Client, it automatically loads default sorting parame-
ters and labels them Plexon1.exp. The default parameters only provide basic 
default settings that can be used to start data acquisition and to create a sorting 
parameters file that matches the characteristics of the experiment.

If using Sort Client for the first time, or if beginning a new experiment, a new 
.exp file to match the requirements is normally created. If continuing an existing 
experiment, the .exp file can be loaded directly, data acquisition can be started, 
sorting parameters can be checked, and sorting and recording can be started. If 
continuing an existing experiment, skip the file creation procedures and go 
directly to “Load a Sorting Parameters (.exp) File” on page 60. If using Sort Cli-
ent for the first time, or if beginning a new experiment, continue with the follow-
ing procedures.

2.3.1.3 Create a New Sorting Parameters File

To create a new sorting parameters file, proceed through a multi-step process 
from initial file creation and naming to resaving the file after the final parameter 
is set. Several procedures must be separately repeated for each channel. Sort Cli-
ent saves all settings, both global and for each channel, to the parameters file.

To create a new sorting parameters (.exp) file

1 From the File menu, click Save Sorting Parameters File As.

2 In the Save As dialog box, type a new name to replace the default file name 
Plexon1. Click Save. 

Note: If someone has previously used Sort Client, and saved .exp files, an 
existing .exp file that approximates the experiment may be loaded 
and used it as a basis (instead of Plexon1) to create a new .exp file. 
For the procedure to load an existing .exp file, see “To load an exist-
ing sorting parameters (.exp) file” on page 60. After loading the file, 
return to this step.

3 The new name replaces the default name Plexon1 in the Sort Client title bar. 
For example, as shown in the following illustration, the new sorting 
parameters file name is Test1.exp.

4 Complete as many of the “Create .exp file” procedures as necessary to 
configure the new sorting parameters file as needed.

Note: Plexon recommends to save the sorting-parameters file fre-
quently. From the File menu, click Save Sorting Parameters 
File, or click the Save button on the toolbar.
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2.3.1.4 Start Data Transfer

Data transfer must be started to see waveforms in Sort Client. Start data transfer 
from either one of the following locations.

To start data transfer

• Above the Waveform Window, click the Start button.

or

• From the Server menu, click Start Data Transfer.
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2.3.1.5 Enable the Spike Channels

When Sort Client starts, the Settings window opens with a display of the digital 
signal processor (DSP) spike channels. As shown in the following illustration, all 
the DSP channels are enabled by default when Sort Client starts. 

 

The previous illustration shows that 16 channels have been enabled. If additional 
channels have been licensed, they must be enabled through Server. To verify the 
number of DSP licensed channels in Server, see “View > Hardware Configura-
tion” on page 144.

Note: The tables in the Settings window have certain interface characteristics and 
behaviors that are common to other tables in Sort Client. For a description of 
these characteristics, see “Typical Sort Client Interface Characteristics and 
Behaviors” on page 75.

2.3.1.5.1 Disabling Channels: Sort Client enables all available channels by 
default. Disable the channels not needed. Also, disable channels with noisy or 
unusable signals.

There are two methods of disabling channels in Sort Client - the Settings window 
and the Multichannel Display. For more information, see “Multichannel Display” 
on page 92.

To disable channels in the Settings window

1 In the Settings window, click the Channels tab.

2 Clear the Enable checkbox to disable each channel that needs to be 
disabled.

Note: Each time a channel is disabled, Sort Client disables that channel in 
the Multichannel Display.
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To disable channels in the Multichannel Display

1 Click to select a channel in the Multichannel Display screen. Right-click to 
open the menu.

2 To disable a channel, click to clear the Enabled check mark.
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When a channel is disabled, Sort Client automatically sets the threshold for the 
channel to the maximum value so that no waveforms are acquired on that chan-
nel. When the channel is re-enabled, the threshold returns to its original setting. 
When a channel is disabled, the display for that channel is crossed out in the Mul-
tichannel Display. For example, in the following illustration channels sig002, 
sig005, sig007, sig008, and sig014 are disabled.
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2.3.1.6 Enable the Continuous Channels

Sort Client does not enable the continuous channels by default. They must bee 
enabled as needed. The following illustration shows the Settings window with the 
Analog Channels tab selected.

 

Note: If there are multiple NI-DAQ devices, Sort Client provides individually-num-
bered AnalogChans tabs for each device. For an example, see “Continuous 
Channels” on page 85.

2.3.1.6.1 Enabling Continuous Channels: The Analog Channels table is the only 
area in Sort Client where the continuous channels can be enabled. To see the con-
tinuous channels, enable NIDAQ in Server; for more information, see “Options: 
NIDAQ” on page 152.
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To enable continuous channels

1 Click each checkbox in the Enable column. To enable all channels 
simultaneously, use the “Set all rows as the top row” feature. For more 
information on this feature, see “Typical Sort Client Interface Characteristics 
and Behaviors” on page 75.

2 Click Update Server to store the settings.

2.3.1.6.2 Changing A/D Frequency: For digitization of higher frequency signals, 
increase the sampling rate on the continuous channels by changing the analog-to-
digital (A/D) frequency. For more information, see “Options: Waveforms And 
Frequency” on page 151.

To change the A/D Frequency in the Analog Channels table

1 Click the A/D Frequency value. Type a new value from 100 to 20 000 (older 
TIM boards) or 40 000 (newer TIM boards).

2 Click Update Server to store the setting.

2.3.1.6.3 Changing Channel Name: Sort Client assigns default channel names. The 
default continuous channel names start with AD followed by the channel number. 
The user can change the name of any channel to suit the requirements.

To change the Channel Name in the Analog Channels table

1 Double click the channel name in the Name column. Type a new channel 
name.

2 Click Update Server to store the setting.

2.3.1.6.4 Changing the NI Gain: Sort Client can be used to change the gain on the 
National Instruments (NI) data acquisition (DAQ) device in the PC. The gain can 
be changed on individual channels or on all channels simultaneously.

To change the NI Gain in the Analog Channels table

1 Click the table cell in the NI Gain column to see a drop-down list of available 
gains. Click a gain setting. To set the same NI Gain setting for all channels, 
use the “Set all rows as the top row” feature described on page 75.

2 Click Update Server to store the setting.

2.3.1.7 Enable Event Channels

The MAP system can detect, time stamp, and record external events. External 
events typically originate in behavioral control systems or stimulus generation 
devices. Sort Client defines four types of events under the Events tab in the Set-
tings window:

• The first type is individual TTL events such as the start of a trial, the press of 
a lever, or the switching on of a light. These individual events are a single bit 
of information (thus the signal can be carried on a single wire or a wire pair) 
that can be recorded on separate channels.

• The second type of event is a “strobed” word. For information on the second 
type of event, see “Strobed Words” on page 27.
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• The third type of event is a TTL signal that starts or stops data recording.

• The fourth type of event is manual input from the keyboard. If there is no 
TTL signal available for an event, a keyboard event can be entered to indicate 
the approximate time. Up to nine individual events can be entered by using 
the ALT key plus any number from 1 to 9.

The following illustration indicates that the following channels are selected to 
“Show” in the Activity Display:

• Event001

• Event002

• Strobed

• Keyboard1

• Keyboard2 
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2.3.1.7.1 Showing Event Channels: Sort Client provides a real-time display of 
event channels in the Activity Display window. The user can display the activity 
on any of the event channels. For more information on the Activity Display, see 
“Activity Display” on page 99.

Note: All Events Are Saved: Events need not be shown in the Activity Display to 
save them to disk. Sort Client saves all event data, even if the event channel 
does not show in the Activity Display.

2.3.1.7.2 Changing Event Channel Names: Sort Client assigns a default name to 
each event channel. The user can change event channel names to suit the require-
ments. The event names entered appear in the Activity Display window.

To change Event Channel names

• Click in the cell in the Name column. Double click the channel name. Type a 
new channel name.

2.3.1.7.3 Strobed Words: The second event type is for events that an external 
device encodes as an 8-bit or 15-bit data word. For example, a visual stimulus of 
up to 256 patterns, or a trial number from 0 to 255, can be encoded as an eight-bit 
word. The external device that generates the digital word must also provide a 
pulse to indicate when the data word is valid. This data-ready signal is called a 
strobe pulse. To use strobed words, set the Digital Signal Processor (DSP) digital 
input (DI) board to strobed-word mode by setting jumpers on the board. For com-
plete information on DI board modes, refer to the Setting Up MAP System Digital 
Input and Output, 01-01-C-3003.

2.3.2 Channel Specific Procedures

The following procedures must be sequentially applied to each channel of interest 
until all the channel-specific parameters have been set for each channel. Repeat 
the “apply filter” through “adjust sort parameters” procedures for each channel. 
Return to this point for each channel to be configured.

2.3.2.1 Apply Filter

Apply a filter to remove low-frequency noise and artifacts, if required. The MAP 
provides a software-switchable per-channel analog 2-pole low-cut filter that can 
be applied from the Control table, or from the Settings table in the Multi-Display 
Window.

http://www.plexoninc.com/pdf/DigitalInput.pdf
http://www.plexoninc.com/pdf/DigitalInput.pdf
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Before applying the filter, view the raw unfiltered spike signals on an oscillo-
scope. Connect the oscilloscope to a BNC connector on the OUT board. Use Ref2 
to assign the channel to the BNC connector. For information on Ref 2, see “Using 
Ref2 with the OUT Board” on page 160. Set the oscilloscope time base to view 
60-Hz signals (waves with ~16-millisecond periodicity). See the examples in the 
following illustration.

Before applying the filter, try to minimize any 60-Hz hum or other low-frequency 
noise, by applying shielding, using additional grounding, or by other means. For 
general information on grounding principles, see “Grounding and Referencing 
Basics” on page 169. Then apply the software-programmable filter to remove any 
remaining low-frequency noise. The filter can be enabled from two areas in Sort 
Client.

Without low-cut Filter With low-cut Filter Applied
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To apply the low-cut filter from the Control Table

• In the Control Table, click the Fil-
ter checkbox. This applies the filter 
to the current channel only. To 
apply the filter to another channel, 
select the channel as the current 
channel and click the Filter check-
box. To disable a filter, click to 
clear the Filter checkbox.

To apply the low-cut filter from the Multi-Display Window

• From the Settings tab 
in the Multi-Display 
Window, click the 
Channels tab. Click 
the checkbox in the 
Filter column to apply 
the filter to a channel. 
To apply the filter to all 
or several channels simultaneously, use the “Set all rows as the top row” fea-
ture on page 75. To disable the filter, click to clear the Filter checkbox.

2.3.2.2 Set the Zoom Factor

Make sure that the display vertical scale is set to one. To make the entire dynamic 
range of the window available, set the Zoom factor (vertical scale) to the lowest 
value before setting the gain. For more information on Zoom and Gain, see 
“Gain” on page 77.

To set the Zoom from the Control Table

• Click the table cell next to Zoom and type or select 1.

Current
                Channel
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To set the Zoom from the Multi-Display Window 

• From the Settings tab in the Multi-Display Window, click the Channels tab. 
Click a table cell in the Zoom column and type or select 1. To set the same 
Zoom setting for all channels, use the “Set all rows as the top row” feature on 
page 75.

2.3.2.3 Set the Gain

Set the gain at a value that allows viewing waveforms in the Waveform Window 
without clipping. Set the gain so that the largest-amplitude waveforms take up 
approximately 2/3 of the total voltage range (Y axis) of the Waveform Window. 
Do not set the gain so high that the waveforms are “clipped” by exceeding the 
maximum voltage range. See the following illustrations for examples.

Correct Gain Setting

2/3 
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Gain Setting Exceeds Maximum Voltage Range

To adjust the gain using the Control Table

1 In the Control Table, to adjust the gain for the 
current channel only, set Gain scope to Cur. 
chan. To adjust the gain for all channels 

simultaneously, set Gain scope to All chans. 

2 Click the table cell next to Gain and type or 
select a gain setting that displays the largest-
amplitude waveforms in approximately 2/3 of the 
waveform window.

To adjust gain settings using the Channels table

• Under the Settings tab in the Multi-Display Window, click the Channels tab. 
Click the table cell in the Gain column and type or select a gain setting. To set 
the same gain for all channels, set the gain for one channel and then use the 
“Set all rows as the top row” feature on page 75.

Clipped 
Waveforms
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2.3.2.4 Set the Threshold

To capture spikes, set the threshold for each channel to a setting that allows dis-
tinguishing between noise and spikes. Distinguishing noise from spikes requires 
an understanding of waveform shapes.

When a signal crosses the threshold, it triggers the MAP system to capture a 
waveform segment and the MAP cannot capture a new waveform segment for the 
duration of the capture window. If the threshold setting is too close to zero, noise 
can cross the threshold and trigger the capture of spurious waveform segments, 
which typically results in actual spikes firing within the duration of the spurious 
capture window. For more information, see “To Avoid Missing Spikes” on 
page 34.

Set the threshold by dragging the threshold slider in the Waveform Window. To 
set the threshold, use the following procedure.

To set the threshold by using the slider in the Waveform Window

1 In the Waveform Window, drag the threshold slider to the center line.
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2 Progressively drag the slider away from the center line until the captured 
waveforms are small-amplitude noise signals as shown in the following 
illustration.

3 Continue to drag the slider away from the center line until larger-amplitude 
waveforms with consistent repeating shapes appear. 

Noise

Threshold 
setting

Threshold 
slider

Repeating 
Shapes
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4 Drag the threshold slider up or down until the following conditions exist:

• Only a few small-amplitude noise signals cross the threshold.

• Smaller- and larger-amplitude spike waveforms of interest cross the 
threshold. The user can distinguish these waveforms from noise signals 
by their distinctive size and shape. 

• The display shows enough waveforms to reveal a pattern of similar wave-
form shapes. Use the following illustration as a guide.

Guide to waveform shapes

 

HINT
To Avoid Missing Spikes
Because only one waveform can be detected per thresholded-capture 
window (typically 600 to 800 µsec), drag the threshold far enough 
from the center line to avoid picking up too many noise signals and 
secondary spikes. Every threshold crossing by a noise signal intro-
duces a 600- to 800-µsec “dead time” before the next threshold 
detection can occur. However, to avoid missing spikes, do not drag 
the slider an excessive distance from the center line. See the follow-
ing illustrations for examples of incorrect threshold settings.

Larger- 
amplitude 
spikes

Minimal 
amplitude 
(noise)

Center 
line

Smaller- 
amplitude 
spikes
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Threshold Setting too close to the center line (e.g. -10%)

Threshold Setting too far from the center line (e.g. -35%)

Secondary 
spike is 
triggered

Excess 
noise

Noise is 
absent 
(compare to 
the 
previous 
illustration)

Some 
lower-
amplitude 
spikes are 
undetected

Threshold 
is set too 
far from 
zero
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5 As an additional verification of the threshold setting, use the Gaussian 
distribution of the noise as a guideline. A good initial location for the threshold 
slider is where the peak histogram data begins to diverge from a smooth 
Gaussian distribution.

From the View menu, click Histogram of Peaks to open the histogram win-
dow, which appears in the right side of the Waveform Window area. To plot a 
histogram, from the Tools menu, select Auto Threshold Current Channel, 
which starts the AutoThr counter at the bottom right side of the Sort Client 
window.

When the AutoThr counter stops, Sort Client plots a histogram similar to the 
following illustration.

Verify the position of the threshold slider. The previous illustration shows the 
slider positioned where the peak histogram data begins to diverge from a 
smooth Gaussian distribution.

Also, set the threshold for one, several, or all channels simultaneously by using 
the Channels table.
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To adjust threshold settings using the Channels table

• Under the Settings tab in the Multi-Display Window, click the Channels tab. 
Click the table cell in the Thresh column and type or select a threshold set-
ting. To set the same threshold setting for all channels, set the threshold for 
one channel and then use the “Set all rows as the top row” feature from 
page 75.

2.3.2.5 Select a Sorting Method

After setting the threshold, choose a sorting method, either boxes or templates. 
Either method may be used on different channels to sort spikes into units.

If the waveforms in the Waveform Window are distinct, appear in well-separated 
groups, and the peaks are easy to distinguish, the boxes method is the quickest 
and easiest method to use for that channel. The user can quickly set pairs of boxes 
to classify the units on the channel and move on to the next channel. However, if 
the waveforms in the Waveform Window are mixed together, not clearly grouped, 
and their peaks intermingle, the templates method is the preferred one to ensure 
good separation and accurate unit classification. The templates method uses the 
principal component analysis (PCA) statistical method to plot each waveform as 
a point in two-dimensional (2D) or three-dimensional (3D) space. Use these plots 
to create sorting templates.

In practice, the boxes method uses pairs of corresponding colored boxes in the 
Waveform Window. The boxes represent voltage/time windows. The MAP sys-
tem classifies waveforms that pass through both boxes as a unit.

In practice, the templates method uses a set of collected and plotted waveforms to 
create templates that represent the mean spike waveform of each unit in the set. 
Sort Client sends the templates to the MAP system and the MAP compares all 
incoming waveforms to each unit template and sorts them accordingly.

As shown in the illustration, to choose a sorting 
method for the current channel, click next to the Sort-
ing field in the Control Table and select Boxes or 
Templates.

2.3.2.5.1 1. Boxes: The box sorting method uses pairs 
of time-voltage windows (boxes) in the Waveform 
Window to sort spike waveforms. Waveforms that pass 
through both boxes are sorted as a unit. Boxes can be 
sized and positioned to classify groups of waveforms 
of the same shape.
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The boxes method uses a sequence of up to four pairs of boxes. The four pairs of 
boxes are identified as Units a, b, c, and d. Sort Client attempts to match each 
incoming waveform first against Unit a boxes. If the waveform passes through 
the Unit a boxes, Sort Client classifies the waveform as Unit a. If the waveform 
does not match Unit a boxes, Sort Client sequentially attempts to match the 
waveform against Unit b, Unit c, and Unit d boxes before it leaves the waveform 
unclassified. When Sort Client classifies a waveform with one set of boxes, it 
cannot be reclassified by subsequent boxes.

2.3.2.5.2 2. Templates: The template sorting technique uses a set of spike wave-
forms that are collected to create templates to sort spikes. There are three steps to 
creating templates:

1 Collect a set of waveforms—the Template Set.

2 Apply Principal Component Analysis (PCA) to create a cluster plot of the 
Template Set.

3 Mark “bundles” or “clusters” of waveforms, which are subsets of the template 
set, to create a template for each unit on the current channel.

Sort Client averages the bundles or clusters that are marked to create templates 
(mean waveforms) for each unit. Sort Client sends the templates to the MAP sys-
tem. The MAP uses the templates to sort incoming waveforms into units.

To mark (select) waveforms for the current channel, use one, two, or all three of 
the following displays:

• Waveform Window—to mark bundles of waveforms

• Cluster Display—to circle clusters of PCA points in two dimensions

• 3D Cluster Display—to orient and circle clusters of PCA points in three 
dimensions

Note: For complete information on how to open and use the cluster displays, see the 
detailed instructions that describe how to use the “Multi-Display Window” on 
page 79.

Sort Client uses principal component analysis (PCA) to create the 2D and 3D 
cluster plots of each waveform as data points in PCA space. PCA is a projection 
that maximizes the variance of the waveforms.

2.3.2.6 Adjust Sorting Parameters

After choosing a sorting method, use the following procedures to adjust the sort-
ing parameters to deliver the best unit classification with that method. The first 
procedure covers the Boxes sorting method. The second procedure covers the 
Templates sorting method. These procedures are the last in the loop of setup pro-
cedures that apply to each channel. 
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To use the Boxes sorting method

1 In the Control Table, click next to Sorting to open 
the menu. Click Boxes.

2 To prompt Sort Client to display the first pair of 
boxes, click Add Unit. Sort Client displays a pair 
of boxes of the same color in the top left corner of 
the Waveform Window: one box has a solid 
outline; the other box has a dotted outline. 

3 Position and size each pair of boxes to classify incoming waveforms as a 
particular unit, either a, b, c, or d. Use each pair of boxes according to the 
following rules:

• Rule 1: To be classified as a unit, waveforms must pass through both 
boxes in the pair.

• Rule 2: At least one digitized point representing the waveform path must 
appear in each box.

• Rule 3: Waveform paths must enter the solid box only once.
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As the following illustration shows, drag the boxes to appropriate locations to 
capture a distinct feature (i.e., a peak or a trough) of the waveform of the first 
unit to be sorted. Resize the boxes to selectively capture waveform peaks by 
dragging the handles on the boxes. While positioning and resizing the boxes, 
note that the vertical edges of the boxes are constrained to align to the sam-
ple time positions; the Waveform Window illustration in Step 5 on page 41 
shows a Points view, which shows the boxes aligned with the digitized points.

Note: If digitized points on the waveform path appear in the solid box and a 
subsequent point on the path appears outside the solid box, Sort Cli-
ent classifies the waveform as a unit. However, if an additional subse-
quent point on the path (representing reentry of the waveform) 
appears in the solid box, Sort Client rejects the waveform for that unit.
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4 By default, the Waveform Window shows each 
waveform as the curve that connects its individual 
digitized points. However, when using the box 
sorting method, the user can also choose to view 
the digitized points alone. This “Points” view can 
be useful to see if particular points on a curve are 
actually inside the relevant boxes. To display a 
Points view, click next to Draw and select Points.

5 The illustration that follows is a Points view of the Waveform Window. Sort 
Client plots each data point that generates the curve for each digitized 
waveform. The data points occur at evenly-spaced time intervals, which can 
eventually appear to be a series of vertical lines as the data points abut or 
overlap.
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In the preceding illustration, the waveform sorted by the boxes method is 
sig001a (Unit a). The waveform shape represented by the digitized points 
appears in the units display at the bottom of the illustration. Two yellow points 
in the dotted box and a single yellow point in the solid box represent the digi-
tized path of the waveform through the boxes. The sorted waveform also 
appears as a yellow dot in the cluster plot. The raster plot (tick marks) across 
the bottom shows the times of occurrence of the captured spikes. The gray 
ticks represent unsorted spikes. The yellow ticks represent the sorted Unit a. 

The following illustration shows the “Unit a” boxes (yellow) roughly positioned 
to intercept the largest amplitude waveforms. With the largest-amplitude 
waveforms classified as Unit a, the remaining waveforms in this view are 
more distinct, which makes it easier to position subsequent boxes to correctly 
classify the remaining waveforms. Then the Unit a boxes may be repositioned 
more precisely.

HINT
Capture Largest Amplitudes First
The largest-amplitude spikes are usually distinctly visible. Position 
the “Unit a” boxes to capture the largest amplitudes first. This makes 
the other spikes easier to distinguish. 
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6 To prompt Sort Client to display a second pair of boxes, click the Add Unit 
button. Sort Client displays a second pair of different-colored boxes (Unit b) in 
the top left corner of the Waveform Window. In this case, Unit b is green. Drag 
the boxes to an appropriate location to capture a distinctive feature of other 
waveforms to be sorted. Resize the boxes as needed by dragging the handles 
on the boxes.

HINT
Large Amplitude Waveforms
Although it goes against the normal gain setting rules, a mixture of 
large- and small-amplitude waveforms can require an intentional 
gain setting that sets the peak of some large-amplitude waveform 
outside the boundaries of the Waveform Window. To ensure captur-
ing of these waveforms, reverse the order of the “Unit a” boxes on 
the waveform path (dotted box first, solid box second), which helps 
to include these waveforms. As shown in the previous illustration, 
the trough of several waveforms can pass out of a solid box and thus 
be excluded from classification. Because a dotted box does not reject 
reentries, alternating the order of the boxes accepts these otherwise 
out-of-bounds waveforms for classification.
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In the following illustration, the second set of Unit b boxes are green.

7 As shown in the 
illustrations, Steps 2 through 
6 may be repeated up to 
two more times as needed 
to classify a total of four 
sorted units on the current 
channel.
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The PCA Cluster plot and Units Display for the four sorted units appear as fol-
lows:

To use the Templates sorting method

Although bundles of waveforms or clusters of PCA points must be used, to select 
the waveforms for a particular unit, add subsequent units to the current channel 
by using either method.

1 In the Control Table, click next to Sorting to 

open the menu. Click Templates.

2 Click the Collect Template Set button.

Sort Client collects waveforms to be marked as 
templates. As shown in the following illustration, 
Sort Client displays a running count of the wave-
forms as it collects them.

Note: Sort Client collects a template set for the current channel only. The 
user can collect templates sets for all channels by using the Auto pro-
cedures on the Tools menu. For more information, see “Auto PCA 
Algorithm” on page 131.

By default, Sort Client collects 1000 waveforms on the 
current channel to create a template set. However, 
when enough waveforms to create templates have been 
collected, stop waveform collection by clicking the Stop Template Collection 
button.

Note: If a channel has little or no activity on it, template collection can run 
on indefinitely until the Stop Template Collection button is clicked. To 
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avoid this problem, disable the affected channels. For more informa-
tion, see “Disabling Channels” on page 21. 

3 Click the PCA button. Sort Client performs PCA calculations on the 
waveforms in the collected template set and shows the results in the Cluster 
Display and 3D Cluster Display.

4 To mark subsets of the waveforms in the template set, click Add 
Unit. The cursor changes to this shape.

5 In the Waveform Window, drag 
the cursor to mark a bundle of 
waveforms to average and serve 
as a template. Sort Client selects 
all the waveforms that cross the 
line drawn. In the accompanying 
illustration, the first bundle of 
waveforms has already been 
marked (yellow) and the cursor is 
marking a second bundle of 
waveforms.

HINT
Collect fewer waveforms for easier marking
If collecting a template set to mark bundles in the Waveform Win-
dow, observe the waveforms as they accumulate in the Waveform 
Window. As soon as there are a sufficient number of waveforms to 
identify each unit, click the Stop Template Collection button. This 
reduces the number of waveforms in the window, which makes the 
bundles more distinct and easier to accurately mark for template cre-
ation. However, if marking clusters in PCA space, a full template set 
makes the clusters easier to distinguish. For more information, see 
“Select a Sorting Method” on page 37.
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In the Cluster Display, use 
the cursor to mark clusters of 
waveform points that have 
been plotted in two-dimen-
sional space. For informa-
tion on how to open and use 
this two-dimensional display, 
see “Cluster Display” on 
page 93. In the accompany-
ing illustration of a Cluster 
Display, the first cluster of 
waveform points has already 
been marked (yellow) and 
the cursor is marking a sec-
ond cluster of points.

As the following illustration 
shows, when marking clusters of waveform points in the Cluster Display the 
corresponding spikes appear as marked bundles in the Waveform Window.
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In the 3D Cluster Display, use the cursor to orient and mark clusters of wave-
form points that have been plotted in three-dimensional space. For informa-
tion on how to open and use this three-dimensional display, see “3D Cluster 
Display” on page 95. In the following illustration of a 3D Cluster Display, the 
first cluster of waveform points has already been marked (yellow points high-
lighted in red circle) and the cursor is marking a second cluster of points.

Choose whichever method provides the best separation. Sort Client averages 
the waveforms selected to build a mean (average) template.

To cancel adding a selection, press the Esc key. To correct an 
error or to revise a selection, delete the selection for a unit and 
reselect the waveforms. To do so, in the Units Display, click the 
unit to be revised, then click the Delete Unit button and make another selec-
tion.

The user can also choose to revise template selections. To 
do so, in the Units Display, click the unit to revise and click 
the New Template button. Sort Client displays the letter of the 
selected unit on the button. The illustration shows the New Template button 
label for Unit a.
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6 The following illustration shows a marked template set and the corresponding 
view of each unit template.

Based on the marked sets, Sort Client creates a mean-waveform template for 
each unit and displays each template (solid line) and three standard devia-
tions from the mean (dotted lines) in the Units Display. Sort Client calculates 
the standard deviations from the waveforms in the template set.

Each unit display has a template tolerance-setting slider below the display; for 
more information, see “Template Adjustment” on page 89. To be classified as 
a unit, incoming waveforms must match the unit template within its tolerance 
setting. The slider controls the tolerance setting, which is based on the sum-
of-squares distance (dw) between the waveform and the template.

The following illustration shows a candidate (unclassified) waveform, a tem-
plate, and the difference between them. The vertical lines in the red area 
between the waveform and the template represent the distance between cor-
responding waveform- and template-point amplitudes (wi and ti). For each 
candidate waveform, the MAP system:

• calculates the sum-of-squared distances from the waveform to each of 
the templates (Units a, b, c, and d)

Tolerance

Tolerance
Slider

Three 
standard 
deviations 
from mean

Mean 
waveform
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• finds the unit template (a, b, c, or d) with the minimum sum-of-squared 
distances

• assigns the waveform to this unit only if the minimum sum-of-squared dis-
tances are less than the tolerance setting for this template; otherwise, the 
waveform remains unsorted

The formula for the sum-of-squared distance (dw) follows

where (wi – ti)
2 represents the square of the distance between the ith wave-

form point wi and corresponding template point ti, and M is the sort width for 
the current channel (in data points). For more information on the sort width, 
see “Template Adjustment” on page 89.

To begin using the templates to sort waveforms, click the Resume button. 

7 Set all the tolerance adjustment sliders to 0 (zero). For more information on 
tolerance, see “Fit Tolerance Range” on page 117. Begin with the slider for 
Unit a and slowly increase the tolerance setting until the incoming waveforms 
in Unit a are correctly classified. Do not increase the tolerance setting to the 
point where waveforms from neighboring clusters should be included. The 
following matching illustrations of slider settings and 3D displays show three 
slider positions: 1) Too low, 2) Optimum, 3) Too high. 

dw wi ti– 2

i 0=

M

=
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Slider setting is too low to 
include most of the whole cluster

1) Too Low

A large portion of the cluster is 
excluded

2) Optimum

Slider setting is optimum and 
includes most of the cluster

Most of the cluster is included

3) Too High

Slider setting is too high. Portions of nearby clusters are 
included
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The following illustration includes a 3D Cluster Display view of the template 
matching results for the slider settings shown in the Units Display below it. 

For more information on setting fit tolerances, see “Unit waveforms” on 
page 104. See also “Fit Tolerance Range” on page 117. For information on 
adaptive template adjustment, see “Template Adjustment” on page 89.

Discrete 
Sorted 
Clusters for 
Each Unit

Noise near 
origin of the 
axes 
(principal 
components 
with low 
amplitude) is 
excluded and 
remains 
unsorted
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8 The user can also adjust the Units Display; for complete information see 
“Units Display” on page 103. To set the maximum frequency, click the vertical 
arrows at the top left of the Units Display. To set the raster range, click the 
horizontal arrows at the bottom left. In the following illustration, the frequency 
appears as Max Fr. 60.00 and the range appears as Raster 4.00s.

For a complete detailed description of these items and other characteristics, 
see “Units Display” on page 103.
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9 From the File menu, click Save Sorting Parameters File, or click the save 
button on the toolbar.

This is the last step in the procedure loop that applies to each channel. If all the 
needed channels have not been configured, select the next channel, return to 
“Apply Filter” on page 27, and repeat the procedures to this point.

2.3.2.7 Set the Window Width and Pre-threshold Time

Because only one waveform can be triggered within the width of the Waveform 
Window, an ideal window width and pre-threshold time combination is one that 
captures a complete waveform shape. Excessive pre-threshold time and an exces-
sively-wide window typically include “noise tails”, which can adversely affect 
the template matching calculations. Also, an excessively-wide window increases 
the chance that another spike waveform will begin before the end of the capture 
window and it will therefore be undetected. The following illustrations show a 
window with excess width and a correctly-sized window.

Excessive Width: 
Waveforms include 
a “noise tail” and 
subsequent spikes 
that begin before 
the end of the cap-
ture window can 
remain undetected

200 µsec

800 µsec
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To set the window width and prethreshold time

1 Under the Settings tab in 
the Multi-Display Window, 
click the Global tab. 

Under Waveform 
Parameters, click the 
table cell in the 
Waveform 
Length (µsec) row and 
use the arrows to increase 
or decrease the window 
width. 

Note: For information on adaptive template adjustment, see “Template 
Adjustment” on page 89.

Correct Width: 
Complete wave-
forms are captured 
when tails return 
toward baseline

200 µsec

600 µsec



2 Sort Client 

56    RASPUTIN Software

2 Under Waveform 
Parameters, click the table 
cell in the 
Prethreshold (µsec) row 
and use the arrows to 
increase or decrease the 
Prethreshold setting to 
accommodate the head of 
the waveform. Plexon 
recommends a preliminary 
pretheshold setting of 200 µsec.

The same waveform length parameter can be used for all channels, however, the 
width of the spike waveforms on different channels can be markedly different in 
duration. For example, waveforms can be 1.2 msec long on some channels and 
0.6 msec on other channels. If the waveforms are markedly different, proceed as 
follows.

To accommodate waveforms of different durations

1 Under the Global tab, set the Waveform Length (µsec) to capture the 
longest waveform.

2 Reduce the Sort Width on the channels with short-duration waveforms: In the 
Control Table, select a short-duration channel in the Channel row and then 

click the table cell in the Sort Width row. Use the arrow to decrease the Sort 
Width until the “noise tail” is excluded from the sorting calculations.
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Note: Although the noise tail remains visible in the Waveform Window, as 
the sort width is decreased, a blue line moves to left to indicate the 
cutoff point for the sort width. As shown in the following illustrations, 
the window width remains at 650 µsec, but the sort width (repre-
sented by the blue line) can be set to a lower value. When classifying 
waveforms, the MAP only uses those points within the Sort Width.

Sort Width Marker
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2.3.2.8 Set the Server Mode

By default, Sort Client detects thresholded spikes from each electrode (channel) 
independently. However, Sort Client can also collect unsorted stereotrode or tet-
rode data. These modes can be used to record spikes from cells that are in close 
proximity to each other. Sort Client provides three different recording modes:

— single (one electrode)

— stereotrode (two electrodes)

— tetrode (four electrodes)

To set single, stereotrode, or tetrode mode

1 On the Server menu, click Server 
Mode to open the Server Mode dialog 
box.

2  In the Electrode Mode area, select 

Single or Stereotrode or Tetrode.

3 Click OK.

Note: The mode-control buttons on the 
toolbar can also be used. For 
information on the toolbar but-
tons, see “Toolbar Icons” on 
page 105.

Sort Client sequentially assigns channels in groups of two for stereotrode mode 
or in groups of four for tetrode mode. The user can still select the channels in a 
stereotrode group or tetrode group and view them individually.

In stereotrode mode, the Waveform Window divides into two vertically-stacked 
displays. In tetrode mode, the Waveform Window divides into four vertically-
stacked displays. The stacked displays show the time-coincident activity on each 
channel of the stereotrode or tetrode group.
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The following illustration shows the four-channel stack of a tetrode-mode 
display.

 

Note: While data is being recorded to disk, the stereotrode-mode and tetrode-mode 
settings cannot be changed.

Note: Stereotrode and tetrode waveforms may not be sorted in real time with the 
MAP system; They must be captured, saved to disk, and sorted offline with 
Plexon Offline Sorter.

2.3.2.9 Save the .exp File

This is the last step in the “Create a New Sorting Parameters File” procedure list. 
To make the sorting parameters previously specified in each procedure available 
for future use, save the .exp file. Plexon recommends that the sorting parameters 
file be saved after setting the parameters for each channel.

To save the .exp file

•  From the File menu, click Save Sorting Parameters File, or click the save 
button on the toolbar.  

As shown in “Sort Client Procedures” on page 17, after completing all the steps 
to create a new sorting parameters file, proceed directly to the step “Sort and 
Record” on page 67. 

http://www.plexoninc.com/OFS.htm
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2.3.2.10 Load a Sorting Parameters (.exp) File

When Sort Client starts, it automatically loads default sorting parameters and 
labels them Plexon1.exp. If someone has previously used Sort Client, and saved 
.exp files, an existing .exp file can be loaded as follows.

To load an existing sorting parameters (.exp) file

1 From the File menu, click Open Sorting Parameters File.

2 In the Open dialog box, choose an .exp file. Double-click the file to enable the 
sorting parameters stored in the file.

3 Click Start to start data transfer.

4 Proceed to “Check Sort Client Settings” on page 60.

Note: The user can also set up Sort Client to automatically load a parameter 
file on startup; see “File” on page 108.

2.3.3 Check Sort Client Settings

This section includes the basic steps needed to check the sorting parameters prior 
to or during recording. There are two basic check steps: 

1 Set up the Sort Client Main Window.

2 Check the sorting parameters on each channel.

When Sort Client is set up and data transfer starts, arrange the items in the Sort 
Client Main Window as shown in the following illustration. This is a typical 
arrangement that allows quick checking of the sorting parameters. For more on 
how to arrange items, see “The Sort Client Main Window” on page 73.
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2.3.3.1 Check Sorting Parameters and Other Settings

Use the Multichannel Display to alert of possible problems with the sorting 
parameters. Anomalies that appear in the Multichannel Display can often point to 
problems with the sorting parameters for a particular channel. However, after 
data transfer is started, Plexon recommends to check the following sorting param-
eters and other settings:

• Gain settings: Are waveforms clipped or missing?

• Threshold: Is the threshold set close enough to zero to avoid missing spikes?

• Template tolerance: Are the waveform points in the cluster displays still 
grouped in contiguous clusters?

• Events: Do the events selected for show appear in the Activity Display?

• Field potentials: Do the enabled continuous channels appear in the Activity 
Display?

• If a sorting parameters (.exp) file were loaded from a previous or ongoing 
experiment, the following section explains how to determine if:

— All the units from the previous experiment are still present

— The units are still optimally sorted

— Any new units have appeared in the previously sorted or previously 
disabled channels
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An expanded view of the Multichannel Display from the previous illustration fol-
lows. Examine channels sig003, 004, 005, 006, 008, 009, and 015. Each of these 
channels represent parameters that can typically require adjustment. Expanded 
descriptions of the adjustments required for these channels follow.
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2.3.3.2 Low Gain Setting (sig003)

The gain setting on channel sig003 is set too low.

Plexon recommends a gain setting that results in the largest amplitude spikes 
occupying approximately 2/3 of the height of the Waveform Window. If the gain 
is set too low, spikes can remain undetected. For information on gain settings, see 
“Set the Gain” on page 30.
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2.3.3.3 Incorrect Template Tolerance Settings (sig004)

The template tolerance settings on channel sig004 are not correct.

The tolerance slider settings on sig004a, sig004c, and sig004d are set too low to 
include most of the clusters representing each of the units. A large number of 
spikes from these units have been left unsorted (gray). For example, see unit d in 
the cluster view (circled in red). For information on correct tolerance settings, see 
Step 7 on page 50. 
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2.3.3.4 Clipped Waveforms (sig005)

The gain on channel sig005 is set too high. As shown in the following illustration 
from the Multichannel Display example, the high-amplitude waveforms are 
“clipped” (circled areas). 

Plexon recommends a gain setting that 
results in the largest amplitude spikes 
occupying approximately 2/3 of the 
height of the Waveform Window. If 
the gain is set too high, large spikes 
are “clipped” and their waveform 
shapes are distorted and cannot be 
sorted. For information on gain set-
tings, see “Set the Gain” on page 30.

2.3.3.5 Unsorted Waveforms (sig006)

The waveforms on channel sig006 are unsorted. As shown in the following illus-
tration from the Multichannel Display example, the waveforms on channel 
sig006 are all colored gray (not sorted). 

Perhaps this channel was overlooked 
in the initial setup. To set up this chan-
nel, complete the steps in the individ-
ual-channel procedures loop that 
begins at “Channel Specific Proce-
dures” on page 27. 
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2.3.3.6 Missed Spike (sig008)

A unit on channel sig008 is not classified. As shown in the following illustration, 
a fourth unit is present, but it is not classified (circled areas).

Perhaps this spike was overlooked in the initial setup or it is a new spike. To add 
this unit, complete the steps in the individual-channel procedures loop that begins 
at Step 4 on page 46.
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2.3.3.7 No Spikes Present (sig009)

Channel sig009 appears to have only noise present on the channel. As shown in 
the following illustration from the Multichannel Display example, there are no 
spikes present on channel sig009.

To make sure there are in fact no 
spikes present on a channel, verify that 
the sorting parameters are correctly set 
for that channel. If an excessive 
amount of noise is detected, move the 
threshold away from zero.

2.3.3.8 Disabled Channel (sig015)

Channel sig015 is disabled. As shown in the following illustration from the Mul-
tichannel Display example, channel sig015 appears as an X.

To make sure there are in fact no 
spikes present on a disabled channel, 
enable the channel and verify that the 
sorting parameters are correctly set for 
that channel.

2.3.4 Sort and Record

There are three basic recording steps: 

1 Start recording.
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2 Add a file name and optional comments. Other items that may be specified 
are:

— Separate start recording and stop recording settings

— The type of data that the file can contain

3 If using manual control, stop recording when completing the recording ses-
sion.

2.3.4.1 Start Recording

When starting a recording session, Sort Client opens the Data File Options win-
dow to provide a convenient area to set recording options.

To start recording

• To start a recording session, from the Datafile menu, click Start 
Recording or click the start-recording button on the toolbar.

Sort Client opens the Data File Options window.
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2.3.4.2 Add File Name, Comments, and Other Settings

Before recording a file, specify a file name and add a comment statement.

To specify a file name and add a comment statement to a file

1 In the Data File Options window, click the Data File tab.

2 In the Data Directory field, Sort Client provides a default directory name. 
Accept the default name or type a new directory name. To select an existing 
directory name, click Browse and locate the directory.

3 In the Data File Name field, Sort Client provides a default file name. Accept 
the default file name or type a new file name.

4 In the Comment field, type a comment statement of up to 1000 alphanumeric 
characters.

Note: Although the Comment field accepts up to 1000 characters, only 100 
characters can be viewed in typical applications.
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2.3.4.2.1 Recording Options: Sort Client provides several recording options. The 
user can choose to start and stop recording manually or automatically, or a combi-
nation of both.

To set recording start and stop options

1 Click the Start and Stop tab.

2 Choose a start-and-stop option. To use the default mode Use User 
Commands to start recording, set a start option in the Options for User 
Command Start area. 

Note: For a complete description of all the start-and-stop controls, see the 
“Start and Stop” tab description on page 126.



Version 2.6  71

2.3.4.2.2 File Contents: Sort Client provides several options to specify the content 
of recorded files. The user may choose timestamps or combinations of times-
tamps and waveforms, both sorted and unsorted.

To select a file content option

1 Click the What to Store in the File tab.

2 Click a content option. Selecting a sample waveform recording allows setting 
of the sampling parameters in the How to Save Sample of Waveforms area. 

Note: For a complete description of all the file-contents options, see the 
“What to Store in the File” tab description on page 129.

2.3.4.3 Monitor Recording

After setting up the data file options, start recording data. If controlling the 
recording manually, the toolbar recording buttons or the recording commands 
from the DataFile menu may be used.
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To record data to file with manual controls

1 In the Data File Options window, click OK to start recording data to the 
specified file.

2 After recording starts, Sort Client displays the following information about the 
recorded file in the fields in the status bar at the bottom of the main window. 
For complete information on the status bar, see “Status Bar” on page 74.

The R in field 2, which is highlighted in red, indicates that recording is in 
progress. When waveforms are also recorded, field 3 shows “Wf” on a yellow 
background. Fields 4, 5, and 6, which are highlighted in green, indicate the file 
name, file size, and elapsed-time recording to file respectively.

3 To pause recording at any time, click the Pause button . When recording 
pauses, Sort Client shows the following information in the status bar.

In addition to the information displayed while recording, the file name area in 
field 4 now includes the word “PAUSED”. While recording is paused, the file 
elapsed-time indicator in field 6 stops counting. However, the total elapsed-
time indicator, which is in field 7, continues to count. Each time a recording is 
paused, the frame indicator in field 8 increments the frame count by one.

4 To stop recording, click the Stop button . Sort Client stops recording to 
the file, saves the file to the location specified, and removes the recording 
information from the status bar.

2     3                   4                             5                 6              

2     3                   4                             5                 6                 7                   8
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2.4 Sort Client Reference

This section contains reference information to help identify and use the items in 
the Sort Client interface.

2.4.1 The Sort Client Main Window

The Sort Client main window contains the following major areas.

2.4.1.1 Control Table

The Control Table contains both channel-specific and global spike sorting param-
eters such as the gain, filter settings, sorting mode, waveform drawing rates, etc. 

2.4.1.2 Waveform Window

The Waveform Window shows the thresholded waveform segments for the 
selected channel. 

2.4.1.3 Multi-Display Window

The Multi-Display Window can contain the following components:

• Settings Window

• Multichannel Display

• Cluster Display

• 3D Display

• Activity Display

Note: To provide a comprehensive view of the Multi-Display Window, the preceding 
illustration shows all the components arranged in a tiled layout. The default lay-

Multi-Display WindowWaveform WindowControl Table

Units Display

Status Bar
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out for the Multi-Display Window is a single maximized window that displays 
the active windows for the tabs selected. To restore the default layout, from the 
Window menu click Default Layout.

2.4.1.4 Units Display

The Units Display shows the templates (average waveforms) for each sorted unit 
and a raster display of both the sorted and unsorted spikes on the selected chan-
nel. 

2.4.1.5 Status Bar

The Status Bar includes nine fields:

1 Total Units indicates the total number of units classified for the current chan-
nel.

2 When recording is in progress, an R on a red background appears in this field.

3 When a recording includes waveforms, a Wf on a yellow background appears 
in this field.

4 This field contains the name of the file being recorded. If the recording is 
paused, the word PAUSED appears next to the file name.

5 This field indicates the size of the file in kilobytes (K) and updates dynami-
cally as recording progresses.

6 This field shows the time accumulated while recording to file. When record-
ing pauses, this field stops incrementing. The units are hours, minutes, and 
seconds.

7 This field shows the total elapsed time since recording started. When record-
ing stops, this field resets to zero. The units are hours, minutes, and seconds.

8 Frame indicates the number of frames in the file. Whenever recording is 
paused and resumed, Sort Client creates a new frame in the file.

9 Dropped shows two counts for dropped spikes. The first count is the spikes 
dropped by the MAP; the second count is the spikes dropped by the PC. 
Whenever dropped counts occur, the background flashes red.

Note: The MAP can drop spikes when too many spikes occur before the 
host PC can read the MAP. The host PC drops spikes when it is run-
ning too slow to read all the data from the memory mapped file 
(MMF). This usually occurs when other processes take CPU time 
from Sort Client; to improve performance, end non-essential pro-
cesses.

       1           2  3           4                    5          6           7             8                  9
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2.4.2 Typical Sort Client Interface Characteristics and Behaviors

The various elements in the Sort Client interface have a common set of features 
and behaviors.

The following characteristics and behaviors are typical of the lists and tables in 
Sort Client:

• Individual cells: some cells in tables have menus or scroll arrows that appear 
only when the mouse is clicked in an individual cell

• Table: the user can click in the top left corner to select the entire table, or the 
user can select a range of cells with the mouse, and right click to open a short-
cut menu with the following selections:

— Set all rows as the top row sets the values in all the selected columns 
(except Name) of every selected row to the same values as the top row 
in the table

— Set name prefix changes the naming assignment format in the Name 
column for each row in the table when the appropriate information is 
entered in the following dialog box: 

• Columns: the user can click any column header to select the entire column 
and then right click to open a shortcut menu with one or both of the previous 
selections.
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2.4.3 Control Table

The following illustration shows the Control Table. The Control Table always 
displays the information for the channel selected as the “current channel.” To 
select another channel as the current channel, click in the box in the second col-
umn next to Channel and select a channel from the drop-down menu. The other 
parameters in the Control Table can be changed in a similar way by clicking the 
appropriate box in the second column. For more information on the control-table, 
see “Typical Sort Client Interface Characteristics and Behaviors” on page 75.

 

The user can use the Control Table to set some parameters for the current channel 
only and some parameters for all channels simultaneously. The upper portion of 
the table includes the parameters for the current channel. The lower portion 
includes the parameters that apply to all channels. A blank row divides the por-
tions.

2.4.3.1 Current-channel Settings

The following settings in the Control Table apply only to the current channel 
(except Gain; see Gain scope that follows). The Channels tab in the Settings 
window shows the changes made using the Control Table. For more information, 
see “Channels” on page 83.

2.4.3.1.1 Channel: The Channel setting indicates the name of the current channel.

2.4.3.1.2 Enabled: The Enabled setting indicates the state of the current channel. 
Click the checkbox to enable or disable the channel.

Current-
Channel 
Parameters

Global
Parameters

Divider row



Version 2.6  77

2.4.3.1.3 Gain scope: The Gain Scope controls the effect of any changes made by 
using the Gain control. If Cur. chan. is selected, Sort Client applies the changes 
in gain to the current channel only. If Global is selected, Sort Client applies the 
changes in gain to all the spike channels simultaneously.

2.4.3.1.4 Gain: The Gain setting provides a menu of selectable gain (amplifica-
tion) values in increments of 1000. The range is 1000 to 32,000. For more infor-
mation, see “Gain” on page 84.

2.4.3.1.5 Filter: The Filter setting enables or disables the low-cut filter for remov-
ing 60 Hz noise and other low-frequency noise.

2.4.3.1.6 Thr.(%): The Threshold Percent field indicates the position of the thresh-
old slider in the Waveform Window as a percent of window height. 
The range is100% to +100%.

2.4.3.1.7 Zoom: The Zoom setting indicates the vertical scale of the Waveform 
Window. The range is 1 to 120. For more information, see “Zoom” on page 84.

2.4.3.1.8 Sorting: The Sorting setting indicates the sorting mode. The user can 
select Boxes mode, which provides time/voltage window discriminators, or the 
user can select Templates mode, which enables the manual selection of wave-
forms in the Waveform Window, or the Cluster Displays, to create templates. The 
Templates mode also supports the automatic creation of templates using the Auto 
Configuration procedures. For more information on Auto Configuration, see 
“Tools” on page 130.

2.4.3.1.9 Sort Width: The Sort Width setting indicates the duration of the Wave-
form Window for the current channel. The range is 50 to 1400 microseconds 
(µsec). The Template Sorting algorithm uses the Sort Width value. When Sort 
Width is set to a lower value, less of the waveform tail is used in template cre-
ation and sorting.

2.4.3.2 Global Settings

The following settings in the Control Table apply to all spike channels.

2.4.3.2.1 View w/f: The View Waveforms (w/f) setting provides the following 
menu of views for the Waveform Window:

• All: The All setting shows all waveforms that cross the threshold, both sorted 
and unsorted.

• Unsorted: The Unsorted setting shows only the unsorted waveforms.

• Sorted: The Sorted setting shows only the sorted waveforms.

• Sel.Unit: The Selected Unit setting shows only the unit that is selected in the 
Units Display (e.g. sig001b).

• Tmpl.Set: The Template Set setting shows only the collected set of wave-
forms that Sort Client uses to generate the templates.
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2.4.3.2.2 Cluster View: The Cluster View setting provides the following menu of 
views for the Cluster Display:

• All: The All setting shows all waveforms that cross the threshold.

• As w/f displ: The As Waveforms Displayed setting shows only those wave-
forms selected for viewing with the View w/f parameter.

2.4.3.2.3 Draw: The Draw setting provides a choice to display digitized Points in 
the Waveform Window or to display interpolated Lines through the sampled 
points.

2.4.3.2.4 Grid: The Grid setting toggles the grid in the Waveform Window On or 
Off.

2.4.3.2.5 Refr ISI (µs): The Refractory ISI setting indicates the minimum (refrac-
tory) interspike interval (ISI) in microseconds. Sort Client represents spikes with 
interspike intervals less than the Refr ISI setting with red activity level bars to the 
left of the templates in the Units Display. The percentage of spikes with inter-
spike intervals less than the Refr ISI setting appears in red in the upper left-hand 
corner of each sorted unit in the Units Display. The range is 100 to 10 000 micro-
seconds.

2.4.3.2.6 Erase (sec): The Erase setting is the time interval at which the wave-
forms are erased in the Waveform Window, Units Display, Multichannel Display, 
and Cluster Display. The range is 5 to 10 000 seconds.

2.4.3.2.7 Active wf/s: For the current channel, the Active Waveforms-per-second 
(wf/s) setting indicates the maximum number of waveforms drawn per second in 
the Waveform Window and the Units Display.

Note: One second of time is divided into ten 100-msec bins for drawing purposes.

2.4.3.2.8 M/Chan. wf/s: For all channels except the current channel, the Multichan-
nel Waveforms-per-second setting indicates the maximum number of waveforms 
drawn per second for each channel in the Multichannel Display.

2.4.3.2.9 Tmpl. Set-PCA:  The Template Set PCA button performs PCA calcula-
tions on the waveforms in the Collected Template Set and shows the results in the 
Cluster Display and the 3D Cluster Display.

2.4.3.2.10 Tmpl. Set-Sort: The Template Set Sort button performs template sorting 
on the Collected Template Set using the current template tolerance values, which 
are set using the sliding adjustment bars in the Units Display. Use this feature to 
check actual template sorting of the Collected Template Set using specific toler-
ance values before resuming data acquisition.
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2.4.3.2.11 Parzen Mult.:  The Parzen Multiplier controls automatic sorting. The 
larger the number, the fewer units will be created by the automatic sort-
ing routine. Generally values in the 0.6 – 1.0 range produce the best 
sorting results. For more information on the Auto Sort parameters, see 
“Auto Sort Algorithm” on page 132. After setting a new value, pressing 
the ‘AutoSort’ button on the next line will perform the automatic sort-
ing with the new value.

2.4.3.2.12 Tmpl. Set – AutoSort:  will perform an automatic sort on the current 
channel, which will destroy all existing units and create new ones. The current 
value of the Parzen Multiplier is used.

2.4.4 Waveform Window

The Waveform Window displays the waveforms for the current channel. The fol-
lowing illustration shows the Waveform Window display with superimposed 
sorted waveforms aligned at the threshold crossing times.

 The threshold level can be changed by 
dragging the slider to a new position. 
Any changes made with the slider are 
reflected directly in the Thr. (%) set-
ting in the Control Table.

2.4.5 Multi-Display Window

The Multi-Display window contains the following components:

• Settings Window

HINT
Changing the Parzen Multiplier
To change the Parzen Multiplier and quickly resort the current chan-
nel, hold down the Alt key while clicking the up or down arrows in 
the spin box for the Parzen Multiplier. The channel is resorted after 
each click.
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• Multichannel Display

• Cluster Display

• 3D Cluster Display

• Activity Display

The user can position the window components in cascaded or tiled arrangements. 
The user can also access each component of the display by selecting the tabs at 
the bottom of the Multi-Display Window. The following illustration shows a tiled 
arrangement of the Multi-Display Window.

To open the displays click the icons on the tool bar or select the items on the View 
menu. Descriptions of the components and their tool-bar icons follow. 

Note: For a description of the many mouse-key capabilities available in the Multi-Dis-
play Window, from the main menu click Help and select Quick Reference, or 
see “Quick Reference” on page 135.

2.4.5.1 Settings Window

The Settings window contains the following controls:

• Global sorting parameters such as the waveform length and template adjust-
ment rates
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• Channel-specific sorting parameters such as gain, filtering, channel name, 
etc.

• Event channels

• Continuous channels

• Spike counts and event counts

For more information, see “Settings Window” on page 82.

2.4.5.2 Multichannel Display

The Multichannel Display simultaneously shows the waveforms on all spike 
channels. The user can select individual channels for viewing in the Window and 
Units Displays by clicking on a channel box in the Multichannel Display.

For more information, see “Multichannel Display” on page 92.

2.4.5.3 Cluster Display

The Cluster Display shows the waveforms as points in feature space (principal 
component space). The user can zoom and rotate the Cluster Display to obtain 
maximum visual separation of the clusters. Then the user can select waveform 
clusters (units) to generate templates for spike sorting.

For more information, see “Cluster Display” on page 93.

2.4.5.4 3D Cluster Display

The 3D Cluster Display shows the waveforms as points in three-dimensional fea-
ture space (principal component space). The user can select waveform clusters 
(units) in the 3D Cluster Display by zooming and rotating the 3D view to display 
maximal separation of the clusters.

For more information, see “3D Cluster Display” on page 95.

2.4.5.5 Activity Display

The Activity Display shows the activity on each spike channel as tick marks on a 
timeline. The user can also view continuous channels. The user can increase or 
decrease the time span of the display.

For more information, see “Activity Display” on page 99.
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2.4.5.6 Trodal Peak/Valley Display 

The Trodal Peak/Valley Display is only relevant when the Data Mode is set to 
Stereotrode or Tetrode. In Tetrode mode, the Trodal Peak/Valley Display shows 
2D cluster plots of peak heights (or valley depths) between all 6 permutations of 
electrodes within the tetrode. For example, when the display is set to show peak 
heights, the 6 plots will be Peak of Electrode 1 vs Peak of Electrode 2, Peak of 
Electrode 1 vs. Peak of Electrode 3, …, Peak of Electrode 3 vs Peak of Electrode 
4. In stereotrode mode, the Trodal Peak/Valley Display will show the single per-
mutation of Peak or Valley of Electrode 1 vs Peak or Valley of Electrode 2.

For more information, see ‘Trodal Peak/Valley Display’ on page X-XX

2.4.6 Settings Window

To open the Settings Window, from the View menu, click Settings Win-
dow, or click the Settings Window button on the toolbar:

The Settings window includes tabs for the following tables:

• Channels

• Continuous Channels

• Events

• Counts

• Global

Descriptions follow for each of these tabs.



Version 2.6  83

2.4.6.1 Channels

The following illustration shows the Settings window with the Channels tab 
selected. The user can use the settings in the Channels table to make changes to a 
single channel, multiple channels, or all channels simultaneously.

 

The Channels list includes the following items:

2.4.6.1.1 DSP: The DSP column indicates the digital signal processor (DSP) chan-
nel number.

2.4.6.1.2 Enable: The Enable column indicates the state of each channel. To 
enable a channel, click the checkbox. To disable a channel, click to clear the 
checkbox.

2.4.6.1.3 SIG: The SIG column lists the signal (SIG) channel number. The DSP 
and SIG values are identical, unless there are unequal quantities of SIG and DSP 
channels and a SWH (switch) board in the MAP is being used.

2.4.6.1.4 Name: The Name column lists the name assigned to each channel. The 
Name field can be up to 30 alphanumeric characters.

2.4.6.1.5 Filter: The Filter column indicates the state of a low-cut filter in the SIG 
board, which can be used to remove 60 Hz noise. For all MAP systems produced 
since 2003, the filter is a 250 Hz, 2-pole, low-cut filter. Click the checkbox to tog-
gle the filter on or off.



2 Sort Client 

84    RASPUTIN Software

2.4.6.1.6 Gain:  The Gain column lists the gain setting for each channel. To change 
the gain, click a Gain field to open a menu. Changes in gain apply to the analog 
amplification of the signal before it enters the analog-to-digital converter on the 
SIG board in the MAP, whereas a change in Zoom (see later in this section) 
changes only the Waveform Window view of the signal. Both gain and zoom 
change the voltage range displayed in the top left corner of the Waveform Win-
dow; if Grid in the Control Table is set to On, the grid spacing also changes. The 
Gain setting range is 1000 to 32,000 in multiples of 1000.

2.4.6.1.7 Thresh: The Threshold column indicates the setting of the threshold 
level for each channel. The range is -100 to +100.

2.4.6.1.8 Zoom: The Zoom column indicates the vertical scale factor of the Wave-
form Window view for each channel. A change in zoom does not change the elec-
trical amplification of the signal, whereas a change in Gain (see earlier in this 
section) does amplify the signal. The Zoom range is 0.5 to 100. For information 
on setting the Zoom menu-arrow increments, see “Zoom control steps …” on 
page 118.

2.4.6.1.9 PCA Set: After a template set has been collected, the PCA Set column 
indicates the number of waveforms in the template set for the channel.

2.4.6.1.10 #Units: After sorting has been completed, the #Units column indicates 
the number of neural units identified on the channel.
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2.4.6.2 Continuous Channels

The following illustration shows the Settings window with the AnalogChans1 
tab selected and the shortcut menu open. If there should be more than one 
NI DAQ device installed, an analog channel tab appears for each device as shown 
in the following illustration.

 

Note: If only one NI DAQ device is installed and configured, the Settings window 
shows only the Analog Channels tab. The entries in the tables are the same 
for each channel tab. 

2.4.6.2.1 A/D Frequency:  The A/D Frequency setting is the per-channel sampling 
rate of the National Instruments (NI) data acquisition (DAQ) analog-to-digital 
(A/D) converter. The TIM board can have a sub-board installed that provides an 
80-kHz clock signal. If an optional sub-board is installed, a 9-pin sub-board con-
nector is located on the faceplate above the standard TIM-board 36-pin connec-
tor. Without a TIM sub-board, the NI DAQ devices receive a 40-kHz clock signal 
from the MAP. The 40-kHz clock signal can be divided by an integer value equal 
to or greater than two. This results in an input range for the A/D Frequency (sam-
pling rate) of 100 to 20 000. The default value is 1000.
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Note: For more than one NI DAQ device installed, each analog-channel tab repre-
sents a NI DAQ device. For an installed TIM sub-board, all NI DAQ devices can 
run at a rate up to the fast rate of 40 kHz.For a slower (e.g. 1 kHz) rate for any 
device, that rate must be applied to all other slow devices. Only two rates are 
simultaneously available: the fast rate (40 kHz or 20 kHz) and a desired slow 
rate (1 kHz or 4 kHz or 8 kHz or …). Any device can run at either the fast or the 
slow rate. For example, for a four-device setup:

2.4.6.2.2 Update Server: To change any settings in the Analog Channels table or 
tables, click the Update Server button to make the changes take effect in the 
NI DAQ device. 

Note: If there are multiple analog channel tabs, separately click Update Server on 
each tab to make the changes take effect.

2.4.6.2.3 Channel Number: The Channel Number column shows the fixed number 
assigned to each continuous channel.

2.4.6.2.4 Name: The Name column shows the default name assigned to the chan-
nel by Sort Client. Any channel may be renamed. The name can be up to 
30 alphanumeric characters.

2.4.6.2.5 NI Gain: The NI Gain column shows the analog gain setting on the NI-
DAQ device in the PC. The following gain settings can be set: 1, 2, 5, 10, 20, 50, 
and 100.

2.4.6.2.6 Enable: The Enable column indicates the state of each channel. Click the 
checkbox in the Enable column to enable a channel. All enabled channels appear 
as continuous traces in the Activity display. Enabled channels are also recorded 
as blocks of Type 5 (continuous data) in the PLX file. Enabling too many chan-
nels can affect performance; see “CPU-Intensive Functions” on page 101.

2.4.6.2.7 Preamp Gain: The Pre-amplifier Gain column indicates a fixed value set 
in the preamp hardware (a combination of the headstage gain multiplied by the 
PBX gain). The default value provided by Sort Client is 1000. For a preamp that 
has a different fixed gain, to ensure accurate results  enter that value in the analog 
channel table or tables. However, the values entered in the table do not control the 
preamp.

Acceptable
(only 2 rates)

Unacceptable
(3 rates)

Acceptable without
TIM mezzanine

Device 1: 1 kHz Device 1: 1 kHz Device 1: 8 kHz

Device 2: 1 kHz Device 2: 2 kHz Device 2: 8 kHz

Device 3: 40 kHz Device 3: 2 kHz Device 3: 20 kHz

Device 4: 40 kHz Device 4: 40 kHz Device 4: 20 kHz
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2.4.6.2.8 Assoc Spike Ch. The Associated Spike Channels column indicates the 
spike channels that have been associated with the continuous channels. This col-
umn appears if there are enabled channel associations and Associate All 
Spike+Continuous Channels has been selected from the shortcut menu. Sort 
Client saves the associations in the PLX file. To enable channel associations, see 
“Allow Association of Spike and Continuous Channels” on page 118.

2.4.6.3 Events

The following illustration shows the Settings window with the Events tab 
selected.

 

2.4.6.3.1 Channel: The Channel column indicates the channel number, which is 
fixed and assigned by Sort Client.

2.4.6.3.2 Name: The Name column indicates the default names that Sort Client 
assigns to each channel. Change these names by typing new names.
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2.4.6.3.3 Show: Click the checkbox in the Show column to make a channel appear 
in the Activity Display. For an example of the Activity Display for an event, see 
“Activity Display” on page 99.

Note: All Events Are Recorded: Sort Client records events regardless of whether 
they are shown in the Activity Display.

2.4.6.4 Counts

After recording starts, Sort Client maintains a count of timestamps and events on 
each channel. Sort Client automatically adds enabled channels (timestamps or 
events) and count values to the Counts table when recording starts. With the 
Counts tab selected, the following illustration shows the contents of the Settings 
window after a recording session. 
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2.4.6.5 Global

Global settings affect the way Sort Client captures and sorts waveforms. Wave-
form Parameters define the length of waveform segments. Template Adjustment 
affects how the adaptive template algorithm works to dynamically update the Sort 
Client templates. These parameters apply identically to all spike channels. The 
following illustration shows the Settings window with the Global tab selected.

 

2.4.6.5.1 Waveform Parameters: Two parameters control the length of the cap-
tured waveform segments and affect the display in the Waveform Window:

• Waveform length (µsec) sets the spike-capture width of the Waveform Win-
dow. The range is 50 to 1400 microseconds (µsec).

• Prethreshold (µsec) is the pre-threshold interval that precedes the spike 
threshold crossing point. The range is 0 (zero) to 600 microseconds (µsec). 
The pre-threshold value is included in the waveform length, that is, if the pre-
threshold value is changed, do not change the overall width of the capture 
window.

Note: For an illustration of these settings, see “Set the Window Width and Pre-thresh-
old Time” on page 54.

2.4.6.5.2 Template Adjustment: Sort Client templates can adapt to the incoming 
waveforms. Two parameters control the adaptive template adjustment. See the 
description of the adaptive template algorithm that follows to understand how the 
following parameters affect templates.

• Waveform Weight is the multiplier applied to incoming waveforms that Sort 
Client uses to create a temporary template. The range is 0 (zero) to 1. Zero (0) 
disables template adjustment. In the following algorithm, the waveform 
weight is represented by W.
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• Update Template Thr. is the threshold value that must be exceeded to update 
the template. The range is 0 (zero) to 2048. In the following algorithm, the 
update-template threshold is represented by T.

The template adjustment works only if the Waveform Weight is set to a value 
greater than (>) 0. Let N be the number of points in the waveform, W be the 
Waveform Weight and T be the update threshold. All the template and waveform 
values are in raw A/D converter units, i.e. they are integers from -2048 to +2047 
for a 12-bit conversion. Since the zero-to-peak voltage range is 3V, the magnitude 
of the input signal (in mV) in terms of AD units is

                                

If

  , where N is the number of points in the waveform,

then ti the template currently used for sorting. Then, when the template adjust-
ment is enabled, Sort Client creates (for each unit on each channel, for example: 
DS027b) a temporary template

  

and sets it equal to t:

                                              

Then, when Sort Client receives the waveform

 

3000 ADunits
2048 TotalGain
--------------------------------------------

 
 

ti i 1  N =

si i 1  N =

si ti i 1  N = =

wi i 1  N =
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it updates s using the following formula:

                   

for example, if W = 0.1

and compares the updated (temporary) template s with the original template t:

                                          

where M is the sort width for the current channel in data points:

 

where   

If 

,

then Sort Client makes s the new template for the current channel and unit:

 

Note: Sort Client uses only sorted waveforms to separately update the adaptive tem-
plates for each unit on each channel. Unsorted units have no effect on any 
adaptive template whatsoever.

Note: The value d represents the difference required to adjust the sorting template. If 
d exceeds the value entered for T in the Update Template Thr. field, Sort Cli-
ent replaces the current sorting template with the temporary template. For 
example, entering 20 represents a difference of (20/2048) = 1% in A/D units. 
The value W in the Waveform Weight field represents how fast Sort Client 

si si 1 W–  ti W i+ 1  N = =
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updates the temporary template (tracks incoming changes). Plexon recom-
mends an initial entry of 0.01.

2.4.6.6 Multichannel Display 

To open the Multichannel Display, from the View menu, click Multichan-
nel Display, or click the Multichannel Display button on the toolbar.

The illustration shows the 
Multi-Display Window with the 
Multichannel Display tab 
selected.

Note:   When clicking a channel in 
the Multichannel Display, Sort Cli-
ent places a pink box around it. 
Sort Client also directs the MAP to 
send a pulse to the EVT connector 
on the TIM board whenever any 
unit on that channel fires.

The accompanying illustration shows the 
menu that appears when right-clicking in 
the Multichannel Display.

2.4.6.6.1 Erase: After a channel is selected, 
Erase clears the display for that channel 
only.

2.4.6.6.2 Enabled: After a channel is 
selected, the waveforms on that channel 
appear in the Multichannel Display when 
Enabled is checked. Otherwise, the channel 
appears as an “X” in the Multichannel Dis-
play.

2.4.6.6.3 Number of Columns: This item 
opens a menu where the number of columns that appear in the Multichannel Dis-
play may be selected.

2.4.6.6.4 Number of Visible Rows: This item opens a menu where the number of 
rows that appear in the Multichannel Display may be selected.

2.4.6.6.5 Channels in Columns:  This item displays channels in order from top to 
bottom.

2.4.6.6.6 Channels in Rows:  This item displays channels in order from left to 
right. For example, the previous illustration shows the channels displayed in 
numerically-ordered rows from the top left corner.
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2.4.6.6.7 Draw All Waveforms:  This item displays all waveforms in the Multi-
channel Display.

2.4.6.6.8 Draw Sorted Waveforms:  This item displays only sorted waveforms in 
the Multichannel Display. 

2.4.7 Cluster Display

To open the Cluster Display, from the View menu, click Cluster Display, 
or click the Cluster Display button on the toolbar.

The following illustrations shows the Multi-Display Window with the Cluster 
Display tab selected.

 

The keyboard commands in the following table control the view shown in the 
Cluster display. To see a quick reference to the following commands, from the 
main menu click Help and select Quick Reference.   

Table 1: Cluster Display Mouse and Keyboard Commands

Key & Mouse Commands Effect on Cluster Display

Right-Click, Drag Zoom viewpoint in or out

SHIFT+Left-Click, Drag Move the “Look-At” point in the 
plane of the screen

SHIFT+Right-Click, Drag Zoom in or out on the Y axis

ALT+Right-Click Open a menu

n Next channel

p Previous channel
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The following illustration shows the menu that appears when the menu command 
(ALT+Right-Click) in the Cluster Display is used.

Note: Because the Cluster Display has only two axes, the Z-range menu is not avail-
able.

2.4.7.1 Erase

Erase clears the display.

2.4.7.2 X Range

 The X-range menu consists of the following items:

— Zoom Out moves the data points away from the user along the X axis.

— Zoom In moves the data points toward the user along the Y axis.

— Move Image Left moves the data points to the left.

— Move Image Right moves the data points to the right.

2.4.7.3 Y Range

The Y-range menu consists of the following items:

— Zoom Out moves the data points away from the user along the Y axis.

— Zoom In moves the data points toward the user along the Y axis.

— Move Image Up moves the data points up.

— Move Image Down moves the data points down.

2.4.7.4 Z Range

The Z Range menu is unavailable with the 2D Cluster Display.

2.4.7.5 Add Waveforms to the Selected Unit

This item changes the mouse pointer to the accompanying shape (blue) 
to enable selection of one or more waveforms to add to the selected unit. 

2.4.7.6 Remove Waveforms from the Selected Unit

This item changes the mouse pointer to the accompanying shape (red) to 
enable selection of one or more waveforms to remove from the selected 
unit.
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2.4.8 3D Cluster Display

To open the 3D Cluster Display, from the View menu, click 3D Cluster 
Display, or click the 3D Cluster Display button on the toolbar.

Sort Client provides the 3D Cluster display in addition to the Cluster Display 
(2D) that opens when the PCA button is clicked. The third (Z) axis on the 
3D Cluster display is the projection onto the 3rd principal component (PC3).

To select units in the 3D Cluster display, zoom, or rotate the 3D viewpoint to dis-
play maximal cluster separation and then draw contours in screen space around 
the clusters. Optimize unit selection by repeatedly rotating the display to the get 
the tightest concentration for each unit cluster and then drawing its contour. To 
achieve the tightest concentration for a unit by rotating the display until the view 
is looking along the axis of a virtual cylinder that encompasses the maximum 
number of points for that unit.
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The following illustration shows the Multi-Display Window with the 3D Cluster 
tab selected.

 

See the following table for a list of the 3D Cluster mouse and keyboard com-
mands. To see a complete list of the mouse and keyboard commands, click Help 
and select Quick Reference. The 3D Cluster display is similar to the 3D display 
in Plexon Offline Sorter data analysis software. 

Table 2: 3D Cluster Display Mouse and Keyboard Commands

Key & Mouse Commands Effect on 3D Clusters Display

Left-Click, Drag Rotate 3D viewpoint

Right-Click, Drag Zoom 3D viewpoint in or out

http://www.plexoninc.com/OFS.htm
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Note: For the 3D Cluster display, Plexon recommends a graphics card with hardware-
accelerated 3D graphics and OpenGL drivers. Earlier graphics cards can gen-
erate the 3D Cluster display extremely slowly, which makes the display unus-
able—this can also adversely affect data acquisition by using too much CPU 
time. If the display is slow, do not use the 3D Cluster display.

The following illustration shows the menu that appears when the menu command 
(ALT+Right-Click) in the 3D Cluster display is used.

2.4.8.1 Erase

This item clears the display.

SHIFT+Left-Click, Drag Move the Look-At point in the plane 
of the screen

SHIFT+Right-Click, Drag Move the Look-At point towards or 
away from the eye location

CTRL+Left-Click, Drag Start drawing contour for new unit 
(contour sorting only)

ALT+Left-Click Select nearest point when viewing a 
template set

ALT+Right-Click Opens a menu

a Toggles animated rotation mode

c Move Look-At point to center of 
mass of next cluster

e or Spacebar Erases display

n Next channel

p Previous channel

Table 2: 3D Cluster Display Mouse and Keyboard Commands (Continued)

Key & Mouse Commands Effect on 3D Clusters Display
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Note: The following range descriptions are based on an “unrotated” view where the 
X range represents the width of the screen, the Y range represents the height, 
and the Z range represents the depth.

2.4.8.2 X Range

 The X-range menu consists of the following items:

— Zoom Out moves the data points away from the user along the X axis.

— Zoom In moves the data points toward the user along the X axis.

— Move Image Left moves the center of the image to the left.

— Move Image Right moves the center of the image to the right.

2.4.8.3 Y Range

The Y-range menu consists of the following items:

— Zoom Out moves the data points away from the user along the Y axis.

— Zoom In moves the data points toward the user along the Y axis.

— Move Image Up moves the center of the image up.

— Move Image Down moves the center of the image down.

2.4.8.4 Z Range

The Z-range menu consists of the following items:

— Zoom Out moves the data points away from the user along the Z axis.

— Zoom In moves the data points toward the user along the Z axis.

— Move Image Away moves the center of the image away from the user 
along the Z axis.

— Move Image Closer moves the center of the image toward the user 
along the Z axis.
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2.4.8.5 Add Waveforms to the Selected Unit

This item changes the mouse pointer to the following shape (blue) to 
enable selection of one or more waveforms to add to the selected unit. 

2.4.8.6 Remove Waveforms from the Selected Unit

This item changes the mouse pointer to the following shape (red) to 
enable selection of one or more waveforms to remove from the selected 
unit.

2.4.9 Activity Display

To open the Activity Display window, from the View menu, click Activity 
Display, or click the Activity Display button on the toolbar. 

The following illustration shows the Multi-Display Window with the Activity 
Display tab selected.

 

This menu appears when right-clicking 
in the Activity Display.

2.4.9.1 Erase

This item clears the display.

2.4.9.2 Increase Time Span

Each time this item is clicked, Sort Cli-
ent increments the time span by 10 sec-
onds. The time span is shown in the top 
right corner of the display.

2.4.9.3 Decrease Time Span

Each time this item is clicked, Sort Cli-
ent decrements the time span by 10 sec-
onds. The time span is shown in the top right corner of the display.

2.4.9.4 Increase Amplitude Zoom for Analog Channels:

 If analog channels are selected for display, selecting this will increase the zoom 
factor for displaying them, making the waveforms appear larger. Pressing the 
‘Zoom In Y’ toolbar button performs the same function.
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2.4.9.5 Decrease Amplitude Zoom for Analog Channels:

 If analog channels are selected for display, selecting this will decrease the zoom 
factor for displaying them, making the waveforms appear smaller. Pressing the 
‘Zoom Out Y’ toolbar button performs the same function.

2.4.9.6 Reset: 

resets both the time span and the analog channel zoom factor to the default. Press-
ing the ‘Reset Zoom’ toolbar button performs the same function.

2.4.9.7 Show More Channels : 

shows more channels in the Activity Display (without scrolling) by showing each 
channel in a smaller amount of vertical space, thus crowding them together. 
Pressing the ‘o’ key performs the same function.

2.4.9.8 Show Fewer Channels : 

shows fewer channels in the Activity Display by showing each channel in a larger 
amount of vertical space, thus spreading them apart vertically. Pressing the ‘i’ 
key performs the same function.

2.4.9.9 Fit All Channels On Screen: 

adjusts the amount of vertical space allocated for the display of each channel so 
that all channels fit without scrolling. 

2.4.9.10 Always Fit All Channels On Screen: 

same as above, except each time the Activity Display is resized, or units are 
added/removed, the display will again be automatically adjusted so that all chan-
nels are displayed without scrolling.

2.4.9.11 Only Show the Current Channel: 

When this is selected, the Activity Display will only show the units from the cur-
rent selected spike channel, along with any analog channels that are associated 
with the spike channel. 

2.4.9.12 High Quality Display of Analog Channels: 

toggles the high-quality display of the analog channels. This display mode can be 
expensive when many analog channels are being displayed.

2.4.9.13 Highlight Current Channel: 

when selected, will draw a selection box around the time lines for the units 
belonging to the current spike channel. If analog channels are associated with the 
current spike channel, they are also highlighted.

2.4.9.14 Show Guide/Zero Line: 

when selected, draws a horizontal line for each line of ticks, and a line represent-
ing zero amplitude for the analog channels.
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2.4.9.15 Show Amplitude Scale for Analog Channels: 

when selected, a scale denoting the amplitude on the left side of each analog 
channel trace.

The illustration that follows is an example of the Activity Display for event chan-
nels. The event channels in this illustration are those selected in the “Show” col-
umn on page 26. Events appear as vertical bars or “ticks” on a time line.

To show Event channels in the Activity Display

• For each event channel that should appear in the Activity Display window, in 
the Settings window, click the checkbox in the Show column. Select each 
channel individually. The “Set all rows as the top row” feature is not available 
for Events.

To show Strobed events in the Activity Display

• In the Settings window, click the checkbox in the Show column next to Chan-

nel 257 (Strobed).

Note: It is not necessary to show events in the Activity Display to save them to disk. 
Sort Client saves all event data, even if the event channel does not show in the 
Activity Display.

2.4.9.16 CPU-Intensive Functions

Avoid running the Activity Display at its slowest speeds (longest time width) 
when displaying many continuous channels. This can have a significant effect on 
computer performance, which can be assessed by using the Windows Task Man-
ager. Ideally, keep the total CPU usage at 20% or less, although this is a conserva-
tive figure and many systems are able to run reliably at CPU usages of up to 30%.
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2.4.10 Trodal Peak/Valley Display

The purpose of the Trodal Peak/Valley Display is to allow the user to determine if 
units are present while in stereotrode or tetrode mode, by displaying the peak or 
valley height of each electrode within the trode plotted against the peak or valley 
height from each other electrode in the same trode. While the MAP system does 
not support online sorting while in a trodal mode, it is useful to see if units are 
present in order to determine whether or not to advance an electrode (for exam-
ple).

To open the Trodal Peak/Valley Display window, from the View menu, click 
Trodal Peak/Valley Display, or click the corresponding button on the toolbar. The 
Trodal Peak/Valley Display is only useful if when SortClient is set to acquire ste-
reotrode or tetrode data, and will just show a message if the system is in single-
electrode mode.

The Trodal Peak/Valley Display can be configured via the right-click menu to 
either show the Peak amplitude of the waveforms, or the Valley amplitude (a neg-
ative peak). It is important to set this appropriately for the data, otherwise the dis-
play will not allow the user to discern units optimally. That is, if the units differ 
mainly by having different peak heights, but the display is set to show valley, the 
display may not be very useful.
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For Tetrode data, the Trodal Peak/Valley Display will show all six permutations 
of peak height (or valley depth, if selected) between electrodes; El1 vs El2, El1 vs 
El3, El1 vs El4, El2 vs El3, El2 vs El4, and El3 vs El4. For StereoTrode data, it 
will show just the one permutation, El1 vs El2.

2.4.11 Units Display

Up to four unit windows may be displayed for the current channel. Adjust the tol-
erances used in Template Sorting by using the slider control bars below each 
sorted unit. The user can also adjust the frequency range for the instantaneous fir-
ing-rate bars and the time range of the raster display.

There are three major components of the Units Display:

2.4.11.1 Left Panel

The following illustration 
shows the two types of 
information that can appear 
in the Left Panel of the 
Units Display.

• The Left Panel is a 
small-scale view of 
either the Cluster Dis-
play shown in the Mul-
tichannel Display or the 
unsorted waveforms 
shown in the Waveform Window. To change the Left Panel display, see 
“Show in Left Panel” on page 117.

Raster 
time range 
control

Maximum Frequency  (Max Fr.) range control  for 
the instantaneous firing rate bar graph (first bar)

OR

Cluster Display Unsorted 
Waveforms
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• The Left Panel includes readouts for the Max Fr. (Maximum Frequency) in 
spikes per second and the Raster time range in seconds.

2.4.11.2 Unit waveforms

The following illustration shows the sub-window for a single unit in the Units 
Display.

• The unit-waveform display can display up to four units. Each display includes 
the channel number and an alphabetic suffix for each unit on that channel. For 
example, in the preceding illustration the unit is from channel sig001 and the 
unit is the second one marked for that channel, so the suffix is b. 

Note: When a unit-waveform display is clicked, Sort Client places a pink 
box around it. Sort Client also directs the MAP to send a pulse to the 
EVT connector on the TIM board whenever that unit fires.

• In the preceding illustration, the line that represents the mean waveform tem-
plate appears at the center of the collection of green waveforms.

• The slider at the bottom of each unit display controls the template “fit toler-
ance” for that unit. Fit tolerance is a unitless value that can be applied to the 
template to control how closely a waveform must match the template to be 
classified to the unit. In the illustration, the current value is set to 59. For 
more information on the fit tolerance, see “Fit Tolerance Range” under the 
View Options Display tab on page 117.

• The bar at the left edge of the window, which is green for this unit, rises and 
falls in response to the short-term firing rate of the spikes that meet the sort-
ing criteria for the unit. The scale represented by the bar is spikes per second, 
which can be adjusted with the Max Fr. range control.

• The red bar, which is red in all unit-waveform displays, represents the percent 
of spikes with an inter-spike interval (ISI) that is less than the minimum ISI 

Channel and Unit Suffix

+3 Standard Deviations 
From the Waveform 
Template Set, Calculated 
at Each Time Point

Mean Waveform 
Template

Tolerance Setting

Tolerance Slider

% of Waveforms
With ISI-Less-
Than-Refr. ISI

Setting

Instantaneous
Firing-Rate Bar

% of Spikes
With ISI-Less-
Than-Ref. ISI

Bar
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setting. For information on the ISI setting, see “Refr ISI (µs)” on page 78. All 
units have a refractory ISI. Because a unit cannot fire again within its refrac-
tory ISI, which is typically 1 millisecond, a large percentage indicates that 
more than one unit is being classified as Unit b. The indicator value also 
appears in red at the top of the display. In this illustration, the value is 0.6%. 
A high value, typically greater than 6%, means that there is a high probability 
that more than one unit is being erroneously classified as a single unit. How-
ever, a low value is not by itself a guarantee of correct classification.

Note: The MAP provides an output pulse each time Sort Client detects a selected 
unit. To select a unit, in the Units Display, click the unit to highlight it with a pur-
ple box. For example, the previous illustration shows unit sig001b highlighted 
with a purple box. Each time Sort Client detects that unit, the MAP provides—
at the EVT connector on the TIM board—a +5V square-wave pulse for a dura-
tion of 0.5 milliseconds.

2.4.11.3 Raster plot

The following illustration shows the raster plot for the sorted units of the Units 
Display.

• The raster plot provides a real-time representation of the firing times for all 
the sorted units on the current channel. The grey line with tick marks at the 
top of the raster plot represents unsorted spikes. The user can adjust the raster 
range with the arrows on the left side of the plot. The value of the range is dis-
played in the Left Panel portion of the Units Display. The raster range for the 
preceding illustration is 10.0 seconds. Each tick on the topmost grey bar rep-
resents a 10-second interval.

• Sort Client can display up to four raster plots of sorted units in color. Each 
tick on a unit bar represents a sorted waveform that meets the sorting accep-
tance criteria for the unit.

• The total number of sorted units on all channels is shown in the status bar 
below the raster plot. For example, the illustration shows Total Units: 63.

2.4.12 Toolbar Icons

Most features and commands are available on the Sort Client toolbar. 
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See the following list to identify each toolbar icon and its function.

   - New Sorting Parameters File (.exp - experiment configuration file)

   - Open Sorting Parameters File (.exp file)

   - Save Sorting Parameters File (.exp file)

   - Copy from the Settings Spreadsheet Tables

   - Print Settings Spreadsheet Table

   - Increase Amplifier Gain

   - Decrease Amplifier Gain

   - Open the Options dialog box

   - Show/Hide Peak Histogram Display in Waveform Window

   - Opens Settings Spreadsheet Tables

   - Opens Multichannel Display

   - Opens Cluster Display

   - Opens 3D Cluster Display

   - Opens Activity Display

  - Assisted Sort
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  - Trodal Peak/Valley Display

   - Display Pause

   - Start Recording

   - Pause Recording

   - Stop Recording

   - Range Control Buttons (in Cluster Displays and 
Activity Display)

 - Single Electrode Mode

 - Stereotrode Mode (two electrodes)

 - Tetrode Mode (four electrodes)

 - Auto-Configure Only the Current Channel

 - Auto-Configure All Channels

   - About SortClient (version info) 

2.4.13 Sort Client Menus

The following sections describe each Sort Client menu in detail. The user can 
also use the Toolbar buttons to implement many of the commands that appear on 
the following Sort Client menus.
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2.4.13.1 File

The accompanying illustration shows 
the Sort Client File menu. The File 
menu is divided into four areas: file 
commands, print commands, recording 
commands, and a file list.

2.4.13.1.1 File commands: File com-
mands apply only to Plexon Sorting 
Parameters (.exp) files. 

HINT
If there are many parameter files
If one or more parameter files are opened on a routine basis, instead 
of using the Open Sorting Parameters File command, Sort Client 
can automatically load parameter files by using customized desktop 
icons. When a customized icon is clicked, Sort Client starts in the 
normal manner, but opens directly with the specified parameter file 
instead of the default Plexon1.exp. Use the following procedure to 
set up customized Sort Client icons.
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To make Sort Client automatically load .exp files on startup

1 Click the Sort Client desktop icon. Right-click and select Copy. Click a clear 
area on the desktop for the desired location of the customized icon. Then 
right-click and select Paste Shortcut. A copy of the Sort Client icon appears 
with the name “SortClient (2)”.

2 Click the SortClient (2) icon. Right-click and select Rename. 
Type a new name for the icon. For example, the accompanying 
icon is renamed “Test-01”.

3 Click to select the renamed icon. Right-click and select 
Properties. Click the Shortcut tab. In the Target box, at the end 
of the file location string, type a space and the name of the .exp 
file that Sort Client should open on startup when this icon is clicked. For 
example, in the following illustration the file name typed in the Target box is 
Test-01.exp, which matches the renamed icon. Click OK. 

Note: This procedure may be repeated to create as many customized desk-
top icons as required. Each customized icon starts Sort Client and 
automatically loads the file specified.
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Clicking Close Sorting Parameters File disables all Sort Client sorting parame-
ters. Until another sorting parameters file is opened, the Sort Client main window 
appears as shown in the following illustration.

2.4.12.1.2 Print commands: The print commands are standard Windows print 
commands.

2.4.12.1.3 Recording commands: The recording-file parameter settings in the 
DataFile Options window effect the recording start and stop commands. For 
detailed information, see “Options” on page 124.

2.4.12.1.4 File list: The file list is a standard Windows list that includes up to the 
last four files opened in Sort Client.

2.4.12.1.5 Exit: Shuts down Sort Client.

2.4.12.2 Edit

The accompanying illustration shows the Sort Client Edit 
menu. The Edit menu includes a Copy command only. The 
Copy command is available only when the Settings tab is 
selected.
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2.4.12.3 View

The accompanying illustration shows the Sort Cli-
ent View menu. The View menu includes window 
settings and commands that open new windows.

2.4.12.3.1 Display Pause: Click this item to pause 
the display. When the display is paused, Sort Client 
stops updating all views, but continues to record all 
data to the file. When the display is paused, a yel-
low indicator flashes in the Sort Client status bar.

2.4.12.3.2 Window Settings: The Toolbar and Sta-
tus Bar may be shown or hidden. To hide these 
items, click to clear the checkmarks.

2.4.12.3.3 Display Commands: Any of the individual displays or windows may be 
opened from this menu or from the toolbar icons.
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2.4.12.3.4 Licensing: The licensing item opens the Plexon License Management 
window, which includes complete licensing information for all the Plexon prod-
ucts installed on this PC. The window includes the following three areas: infor-
mation, key testing, and code entry.

• The information area includes information on license keys and the license sta-
tus of all the Plexon products currently licensed on this PC. 

• The key testing area is a convenient tool to test license keys to ensure they 
function correctly.

• Use the Unlock Additional Programs and Features area to enter the unlock 
codes for optional programs and features. Instructions for entering codes and 
testing keys are included with Plexon installation programs.
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2.4.12.3.5 Options: This item opens the Options window that includes the follow-
ing tabs: General, WaveForm Limits, Display, Colors, and Auto-Procedures.

The following illustration shows the General tab of the Options window, where 
the Sort Client initial parameters are set.

• Restore opened windows and their positions: Click this item to open all 
iconized windows and restore them to their previously-opened positions 
when Sort Client is restarted.

• Channels initially default to __ Sorting: This item sets the default value for 
the Sorting field in the Control Table. Choose Boxes or Templates from the 
drop-down menu.

• Switch to template sorting if template set is collected: Click this item to 
automatically reset Sort Client to template sorting mode if a template set is 
collected.
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• Analog Channel Initial Gain: Type the default value for the continuous 
channel gain setting.

• Read data from the server every __ msec: This item sets the frequency of 
data polling by Sort Client. In most cases, the default setting of 10 millisec-
onds can be used. The range is 10 to 100000 milliseconds.

• Display warning if free disk is less than __ MB: Enter the warning thresh-
old for the minimum amount of free space that must remain on the disk drive 
on the PC. 

• Assisted Sort is an automated sorting tool that can be selected from the Tools 
menu. A value can be set in the Assisted Sort area to automatically remove 
outliers in PCA space that are more than a minimum number of standard 
deviations from the mean of the cluster. When Assisted Sort Current Chan-
nel is selected on the Tools menu, Sort Client opens a window with a selec-
tion of candidate sorts. For more information, see “Assisted Sort” on 
page 133.

• Max Number of Waveforms in the Template Set: Enter the limit on the 
number of waveforms that Sort Client collects to create a template set. 

• Initial Fit Tolerance for New Units: When new units are added to a channel, 
Sort Client uses this value. To set a constant value for all units, click Set it to 
a constant value of and type a number. To set a multiplier based on the stan-
dard deviation of the template-set waveforms for the unit, click Set it to __ 
times the deviation of initial waveforms and type a number.
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The following illustration is the WaveForm Limits tab of the Options window.

• How many waveforms to transfer from the box is the area where the maxi-
mum transfer rate is set for the waveforms to be transferred from the Multi-
channel Acquisition Processor (MAP) box to Sort Client. 

— To transfer all waveforms to Sort Client, click Waveform Limits Off.

Note: If the HLK2 (Host Link 2) is used to connect the MAP box to the PC, 
this setting can be used to transfer all waveforms to Sort Client.

— To limit the transfer of waveforms to Sort Client, click Waveform 
Limits On and enter the limit values as follows:

– Active Channel: For the current channel, enter a suitable value that 
meets the performance limitations of the the PC and host link. The 
default value is 50 waveforms per second. The range is 0 (zero) to 
100000.
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– Background Channel: For the other channels, enter a suitable 
value that meets the performance limitations of the PC and host 
link. The default value is 10 waveforms per second (waveforms/
sec). The range is 0 (zero) to 100000.

• How many waveforms to draw is the setting for how many waveforms Sort 
Client will draw in the WaveForm Window. There are separate settings for the 
active and background channels as follows:

— Active Channel: For the current channel, enter a suitable value that 
meets the performance limitations of the PC and graphics card. The 
default value is 50 waveforms per second. 

— Background Channel: For the other channels, enter a suitable value 
that meets the performance limitations of the PC and graphics card. The 
default value is 10 waveforms per second.
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The following illustration shows the Display tab of the Options window.

• Show in Left Panel: The items in the Left Panel of the Units Display may be 
changed here. For an illustration of these settings, see “Left Panel” on 
page 103:

— Unsorted Waveforms: Click to display the waveforms shown in the 
Waveform Window in unsorted (monochrome) mode.

— PCA Projections: Click to show the points from the Cluster Display.

• Fit Tolerance Range: Fit tolerance is a unitless value that can be applied to 
each template to control how close a waveform must conform to the template 
to be accepted as belonging to the unit. In this area the range of the template 
“fit tolerance” may be set as follows:

— From: Enter a value to define the lowest value of the fit-tolerance 
range. The default value is 0 (zero).
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— To: Enter a value to define the highest value of the fit-tolerance range. 
The default value is 100.

• Zoom control steps by 0.1 until __, then by 1.0: Enter a zoom transition 
point. Each click of the Zoom-menu scroll arrows steps the zoom factor by 
0.1 until the zoom factor reaches the level entered here. When the zoom fac-
tor reaches the level entered, the steps increment by 1.0. For more informa-
tion on Zoom, see “Channels” on page 83.

• Allow Association of Spike and Continuous Channels: Click to enable the 
association of spike channels and continuous channels. To associate spike and 
continuous channels, see “Continuous Channels” on page 85.

• 3D Cluster View: In this area the background and display characteristics of 
the 3D Cluster display in the Multi-Display Window can be controlled. Any 
combination of the following items may be chosen:

— Show Side Walls: Click to show the 3D plot with three side walls.

— Show Top & Bottom Planes: Click this item to show the 3D plot con-
tained within top and bottom planes. When this item is used in combi-
nation with Show Side Walls, the plot is contained within a 3D box. 

— Show Grids: Click this item to apply grid lines to the 3D view. Set the 
scale of the grid as follows:

– Number of Grid Divisions: Enter a value to set the scale of the 
grid divisions. This a unitless value that provides a comparison 
scale for the 3D view. The default value is 6. The range is 0 (zero) 
to 1000. Depending on the quality of the PC video display, grid 
divisions greater than 300 can appear as a solid background.

Note: To be visible, grid lines must have a background. To see the grid 
lines, select Show Side Walls or Show Top & Bottom Planes. 

— Show Lookat Icon: Click this item to show a 3-axis icon, which is use-
ful for orientation after zooming to a close-up view of the plot.

— Show Labels: Click this item to show labels on the grid lines and on 
the Lookat Icon.

— Constrain view rotation so that +Y axis is always upwards: Click 
this item to limit the rotation of the 3D view about the X and Z axes to 
180 degrees.

— Animate the 3D rotation after left mouse button release: Click this 
item to produce a continuous animated rotation of the 3D view when 
the left mouse button is released.

• Activity Display: controls the behavior of the Activity Display in the Multi-
Display Window.
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— High Quality Display of Analog Channels: when checked, the con-
tinuous channels are drawn in a way that avoids an aliasing effect, but it 
costs more CPU time to rendering in this way. For older PCs or when 
showing a large number of analog channels, it is best to uncheck this 
checkbox.

— Always Fit All Channels On Screen: enables a mode that will com-
press all channels vertically so that they always fit on screen without 
scrolling.

— Show Only Current Channel: when checked, the Activity Display 
will show only the units from the current spike channel, and also any 
analog channels that are associated with the current spike channel.

— Show Guide/Zero Line: draws a horizontal line for each horizontal 
row of ticks and a zero line for any analog channel traces.

— Show Amplitude Scale for Analog Channels: when checked, shows a 
amplitude scale on the left side of each analog channel trace.

— Highlight Current Channel: when checked, a selection box will be 
drawn around the units from the current spike channel. A selection box 
will also be drawn around any analog channels that are associated with 
the current spike channel.

• Enable Right-Click Zooming: when checked, holding down the right mouse 
button and dragging within the 2D or 3D Cluster Views will zoom the display 
in and out. Holding down the Alt key while pressing the right mouse button 
will produce the right-click menu. When this checkbox is unchecked, the 
above situation is reversed: pressing the right mouse button will produce the 
right-click menu, and holding down the Alt key while pressing the right 
mouse button will zoom the display in and out. Note that the mouse wheel 
will also zoom the 3D Cluster View in and out.
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The following illustration shows the Colors tab of the Options window:

• Display elements: In this area may be set the colors of the supporting items 
that make up the Sort Client display, such as backgrounds, text, and grid lines. 
The preceding illustration shows the default colors.

• Units: In this area may be set the colors of the data elements shown in the 
various unit displays. The preceding illustration shows the default colors.
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The following illustration shows the Auto-Procedures tab of the Options 
window:

Note: For more information on the Auto Procedures, see “Tools” on page 130.

• Collect data for __ seconds: Type the maximum time for the Auto Proce-
dures to collect data before computation begins.

• During Auto-Gain, -Threshold, and -PCA collection, override waveform 
limits: Clicking WaveForm Limits On in the WaveForm Limits tab of the 
Options window allows clicking this item to override those limits and enter 
revised values as follows:

Note: If using an HLK2 in the MAP system, waveform limits may be ignored. 
See “How many waveforms to transfer from the box” on page 115.
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— When collecting one channel: Selecting Auto Gain Current Chan-
nel or Auto Threshold Current Channel from the Tools menu allows 
the waveform limits to be overridden separately as follows:

– Active: For the current channel, type a suitable value that meets the 
performance limitations of the PC and host link. The default value 
is 100 waveforms per second (wf/sec). 

– Bkg: For the background channels, type a suitable value that meets 
the performance limitations of the PC and host link. The default 
value is 10 waveforms per second. 

— When collecting all channels: Selecting Auto Gain All Channels or 
Auto Threshold All Channels from the Tools menu allows both wave-
form limits to be overridden simultaneously as follows:

– Active and Bkg: Type a suitable value that meets the performance 
limitations of the PC and host link. The default value is 10 wave-
forms per second (wf/sec). The range is 0 (zero) to 100000.

• Auto-Gain: In this area may be set the parameters for the Auto Gain Algo-
rithm. For more information on the Auto Gain parameters, see “Auto Gain 
Algorithm” on page 131.

— Set gain so that peak is at __ of the total ADC range: Type the peak 
value for the gain as a portion of the analog-to-digital converter (ADC) 
range. The default value is 1. 

— Number of iterations: Type the number of iterations that the Auto 
Gain Algorithm must perform to enable it to converge on the appropri-
ate gain.

— Disable channels with extreme gains (e.g. 1000 or 32000): Click to 
automatically disable channels that have extremely low (1000) or 
extremely high (32,000) gains, which usually implies either noise or a 
dead channel.

• Auto-Threshold: In this area may be set the parameters for the Auto Thresh-
old Algorithm. For more information, see “Auto Threshold Algorithm” on 
page 131.

— Set the threshold at __ sigma: Type the number of standard deviations 
(sigma) away from the mean peak height to set the threshold. The 
default value is 2.5. 

— Threshold Sign: Set the sign of the threshold to one of three positions:

– The sign of the mean signal: Click to set the sign of the threshold 
at the same setting as the mean signal.

– Positive: Click to set a positive threshold.

– Negative: Click to set a negative threshold.
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• Auto-Sort: In this area may be set the parameters for the Auto Sort Algo-
rithm. For more information on the Auto Sort parameters, see “Auto Sort 
Algorithm” on page 132.

— Parzen radius multiplier: Type a value for the Parzen radius multi-
plier. Large values result in fewer less-compact clusters. The default 
value is 0.6. The range is 0 (zero) to 10000000.

— Use 3D (PC1,PC2,PC3) Feature Space: By default, the Auto Sort 
procedure runs in 3D space. To run a faster Auto Sort in 2D feature 
space, click to clear the checkbox for this item. 

2.4.12.4 Server

The accompanying illustration shows the Sort Client 
Server menu. 

Note:  During normal operation, Sort Client starts and 
stops data transfer automatically. Under normal 
conditions, do not attempt to manually start and 
stop data transfer.

2.4.12.4.1 Start Data Transfer: Select this item to start data transfer from the MAP 
Server.

2.4.12.4.2 Stop Data Transfer: Select this item to stop data transfer from the MAP 
Server.

2.4.12.4.3 Server Mode: This item opens the 
Server Mode window. Sort Client can collect 
unsorted stereotrode or tetrode data. For more 
information on Server Mode, see “Select a 
Sorting Method” on page 37. 

• Electrode Mode: Select one of three modes 
from this area:

— Single: Click to separately display 
the signals from each electrode.

— Steretrode: Click to display the sig-
nals from adjacent electrodes as time-
coincident pairs.

— Tetrode: Click to display the signals from four co-located electrodes as 
time-coincident quartets.

Note: Server modes can also be selected by using the toolbar. See “Toolbar Icons” 
on page 105.
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2.4.12.5 DataFile

The accompanying illustration shows the Sort Client 
DataFile menu. 

2.4.12.5.1  Recording Controls: The recording control 
items on this menu perform the same function as the Tool-
bar recording controls. The Start Recording and Stop 
Recording controls are effected by the parameters that 
are set in DataFile Options window. For information on 
the start and stop recording parameters, see page 126.

2.4.12.5.2 Edit Comment…:  This selection is only enabled while data is being 
recording. It brings up a dialog that allows editing or appending text to the Com-
ment that is stored with the recorded .plx file. 

2.4.12.5.3 Options: This item opens the DataFile Options window, which 
includes the following tabs: 

• Data File

• Start and Stop

• What to Store in the File

Sort Client records data in Plexon data (PLX) file format. Plexon has optimized 
PLX files for recording thresholded segments of waveforms. 
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The following illustration shows the Data File tab in the Data File Options 
window:

 

• Data Directory: This is the storage location for the data file. The default 
entry is C:\PlexonData. Type an alternative location or click Browse and 
choose a directory. 

• Data File Name: This is the data-file name. Type a name or click Browse and 
choose a name.

• Comment: This field can accept a comment of up to 1000 alphanumeric 
characters. Although this field accepts 1000 characters, typical applications 
can only view 100 characters.
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The following illustration shows the Start and Stop tab in the Data File Options 
window:

 

• Use User Commands (Start Recording and Stop Recording menu com-
mands): Click to manually control recording from the Sort Client Toolbar or 
from the DataFile menu.

• Use External Level to Start and Stop: Click to use an external stop and start 
signal, which can be received by the remote record start/stop (RSTART) input 
on the MAP DSP board. For more information on RSTART, see the “Setting 
Up MAP System Digital Input and Output” datasheet.

— Stop after __ frames (0 = forever): Type the number of frames to 
record before Sort Client stops automatically. If 0 (zero) is typed, Sort 
Client continues to record until it is manually stopped with a toolbar 
button or menu command. The default value is 0 (zero). 

• Use eXternal Sync 1 to Start and user command to Stop: Click to use a 
pulse on the External Sync 1 (XS1) connector on the TIM board to start 
recording and a user command from the toolbar or DataFile menu to stop 
recording.
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• Use eXternal Sync 2 to Start and user command to Stop: Click this item to 
use a pulse on the External Sync 2 (XS2) connector on the TIM board to start 
recording and a user command from the toolbar or DataFile menu to stop 
recording.

• Timed Recording: Click this item to set up periodic timed recording inter-
vals and a timed stop. Set the intervals as follows:

— Timed Recording Options: Click this button to open the following 
window and set the recording intervals.

– Every __ minutes record for __ seconds: In the first box, type the 
period of the recording interval. In the second box, type the dura-
tion of the recording interval. The range is 0 to 2147483647.

– Stop recording and close the file __ hours __ minutes...: Type the 
duration of the recording session. In the first box, type the hours 
after the start of recording. In the second box, type the minutes after 
the start of recording. 

• User command to Start and Event Counter to Stop: Click to use a toolbar 
or menu command to start recording and to stop recording when a cumulative 
number of external events occur on a designated channel. Set the stop record-
ing parameters as follows:

— Stop when external event __ exceeds the count __: In the first box, 
type the external event channel. The range is 1 to 16. In the second box, 
type the cumulative event count for that channel. 

• Time-based Stop and re-Start: Click to set up time-based multiple file 
recording. 
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— Stop and re-Start Options: Click this button to open the following 
window and set the time intervals.

– Stop recording and close the file __ hours __ minutes after...: 
Enter the duration of the interval to record to the file. In the first 
box, type the duration hours. In the second box, type the duration 
minutes.

• Options for User Command Start: This area includes two sub-areas that 
may be used to control recording and file naming, when recording is started 
by using toolbar buttons or menu commands:

— When Start Recording is pressed: This area includes two options that 
control how Sort Client responds when clicking the Start Recording 
button on the toolbar (or choosing Start Recording on the DataFile 
menu). Click one of the following options:

– Open Data File Dialog: Click this option to have Sort Client 
prompt with Data File Options window each time Start Record-
ing is selected. This option allows typing a file name and file loca-
tion for each file created.

– Begin recording immediately: Click this option to have Sort Cli-
ent automatically generate a new consecutively-numbered file 
name and immediately begin recording to that file. To set up file 
names, see the following paragraph. 

— File Name generation: This area includes two file naming parameters 
that can be preset. Sort Client sequentially names each file using a file 
name prefix, the current date, and a three-digit consecutive file number, 
as follows:

– Prefix: Type a file name prefix. The default value is dat. 
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– Date: Choose a format for the date (mmddyy, ddmmyy, etc.), or 
choose None to have the date excluded from the file name. An 
example of a typical file name follows:

dat090503001.plx

where “dat” is the prefix, “090503” is the date in mmddy format, and 
“001” is the three-digit sequential file number

Note: Use long file names with caution. Make sure the software and net-
work can use long file names. 

The following illustration shows the What to Store in the File tab in the Data 
File Options window.

 

To define what to store in the data file, choose one of the following options:

• Timestamps Only: Click to save only timestamps to the data file. This option 
creates the smallest files, but the files cannot be re-sorted offline.

• Timestamps and All the Waveforms: Click to save timestamps and all the 
waveforms, both sorted and unsorted. This option creates larger files that can 
be re-sorted offline.

• Timestamps and Unsorted Waveforms: Click to save timestamps and only 
the unsorted waveforms.
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• Timestamps and Sorted Waveforms: Click to save timestamps and only the 
sorted waveforms. 

• Timestamps and Sample of Waveforms: Click to save timestamps and only 
a sample of the waveforms. The sample is defined as follows:

— How to Save Sample of Waveforms: This area includes the period, 
duration, and rate that define the waveform sample. 

– Every __ minutes save the waveforms for __ seconds: In the first 
box, type the sample duration in minutes. The default value is 
10 minutes. In the second box, type the sample duration in seconds. 
The default value is 30 seconds. 

– using the following rate limit (waveforms/second per channel): 
This value defines the data storage rate for the waveform sample. 
Type a value that meets the performance limitations of the PC and 
host link. The default value is 20. 

– Save all the waveforms: Click to save all waveforms to the sample 
file.

– Save only sorted waveforms: Click to save only sorted waveforms 
to the sample file.

2.4.12.6 Tools

The accompanying illustration shows the 
Tools menu with the various Auto proce-
dures listed.

2.4.12.6.1  Auto Procedures:  All of these 
procedures may be run on the current chan-
nel only or on all channels simultaneously. 
These procedures can be run individually or 
together as a chain in the following 
sequence:

• Gain

• Threshold

• PCA

• Sort

2.4.12.6.2 Auto Configure: When chaining 
the Auto procedures together and run them 
on all channels simultaneously, they provide 
a powerful, one-step, automated experimen-
tal setup feature called Auto Configure. 
With the Auto Configure feature, all or only 
a subset of the Auto algorithms can be run in 
sequence. 
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The accompanying illustration shows the 
default view of the Auto Configuration 
window with all the auto-configuration 
procedures selected.

2.4.12.6.3  Auto Gain Algorithm: The 
Auto Gain algorithm is similar to the 
Auto Threshold algorithm. It collects 
data for a configurable number of sec-
onds and then it determines the peak 
amplitude of any signal that arrived dur-
ing the collection period. Then the Auto 
Gain algorithm calculates the gain 
needed to make that peak amplitude take 
up a configurable fraction (0.7 by 
default) of the total analog-to-digital converter (ADC) range.

When the Auto Gain algorithm makes a first-pass analysis on a channel, it uses 
the gain that is set for that channel to collect data. If the gain is too high or too 
low, the algorithm can fail to set an ideal gain in one pass. For example, if the 
gain was initially set far too high on a channel, all the waveforms would be 
clipped. The peak height would then be the full ADC range and the first pass of 
the Auto Gain algorithm would reduce the gain by the default value of 0.7. This 
reduced gain can still be too high, which results in clipped waveforms. To ensure 
adequate waveforms, run the Auto Gain algorithm through a sufficient number of 
iterations to enable it to converge on the appropriate gain for the channel.

The Auto Gain algorithm can also automatically disable channels that are found 
to require extremely low gains of 1000, which usually implies a great deal of 
noise on the channel, or extremely high gains of 32,000, which usually implies a 
dead channel. For more information on disabling channels, see “Disabling Chan-
nels” on page 21.

Also, a burst of noise on a channel, such as an electromyogram (EMG) burst, can 
adversely affect the calculated gains during the Auto Gain procedure.

2.4.12.6.4 Auto Threshold Algorithm: The Auto Threshold algorithm temporarily 
sets the threshold to 0 (zero) and collects data for a configurable number of sec-
onds, calculates the peak-to-peak distribution (noise ends where the Gaussian 
envelope ends), and then sets the threshold to be a configurable number of stan-
dard deviations away from the mean peak height. For an illustration of the man-
ual process, see Step 5 on page 36.

2.4.12.6.5 Auto PCA Algorithm: The Auto PCA algorithm runs in two phases. The 
first phase collects a set of waveforms to use in principal component analysis 
(PCA). This set of waveforms is referred to as a PCA set or a template set. The 
second phase runs a PCA on that template set. Auto PCA continues to collect the 
template set until a configurable number of waveforms have been collected or the 
collection is stopped by clicking Stop Templ. Coll. When the collection of the 
template set stops, PCA runs automatically.
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The Auto PCA procedure is the manual equivalent of starting and stopping the 
collection of a template set and then clicking PCA for each channel. However, 
Auto PCA enables this same procedure to be run on all channels simultaneously. 
When a template set is collected and PCA is run on it, the 2D and 3D Cluster Dis-
plays show the waveforms as points in PCA space, where they can be clustered to 
form templates.

2.4.12.6.6 Auto Sort Algorithm: The Auto Sort algorithm uses the same valley-
seeking sorting algorithm as Plexon Offline Sorter. The Auto Sort algorithm 
attempts to cluster the points of a channel's current template set in either 2D or 
3D PCA space. The Auto Sort algorithm can automatically select an appropriate 
number of clusters and assign cluster membership to each point in the current 
template set. After Auto Sort determines cluster membership, the template wave-
form for each unit is calculated from the clusters and used for subsequent online 
sorting.

From the View menu, in the Options window under the Auto Procedures tab, 
the Parzen radius multiplier can be set to control how aggressively the valley-
seeking sorting algorithm splits or combines nearby clusters. For complete infor-
mation, see the Auto Procedures tab description on page 121. Larger values of 
this multiplier generally result in a smaller number of larger, looser clusters; 
smaller values of this multiplier result in a larger number of tighter, smaller clus-
ters. By default, Auto Sort uses 3D (PC1, PC2, PC3) feature space, but it can also 
use 2D feature space.

The Auto Sort algorithm currently makes no attempt to discern noise clusters 
from unit-firing clusters, as a result, noise clusters can be assigned to a unit. With 
the Auto Configure feature, all or only a subset of the Auto algorithms can be run 
in sequence.

To run Auto Configure

1 From the Tools menu, click Auto 
Configure Current Channel 
or Auto Configure All 
Channels. Sort Client opens the 

Auto Configuration window.

Note: The first time Auto Config-
ure is used, the Auto 
Configuration window 
opens with all the check-
boxes selected. 

2 Click the sequential steps to run.

Note: The steps must be 
selected in sequence-for example, if only two steps are selected, 
Gain and Threshold can be selected but not Gain and Sort.

3 Click Go!

http://www.plexoninc.com/OFS.htm
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2.4.12.6.7 Assisted Sort: Assisted Sort is an automated sorting feature that is 
based on the K-Means algorithm. Assisted Sort provides a selection of several 
candidate sorts for the current channel. When Assisted Sort Current Channel 
on the Tools menu is selected, Sort Client runs the K-Means sorting algorithm on 
the waveforms in the current channel and opens the view shown in the following 
illustration, which shows the Assisted Sort tab in the Multi-Display Window. 

This view shows a number of candidate sorts for each unit as 2D plots and sorted 
waveforms. A candidate sort can be chosen that best represents a distinct unit. 
Sort Client can present up to five candidate sorts for each unit. As shown in the 
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following illustration, when a unit to add is chosen, right click to open a shortcut 
menu.

 

2.4.12.6.8 Add Selected Unit Only:  adds only the one currently highlighted unit.

2.4.12.6.9 Accept All Units In Row:  adds all the units in the selected row.

2.4.12.7 Units

The Units menu lists the commands 
that apply to sorting waveforms into 
units. The availability of items on the 
Units menu depends on the active 
view, the unit selected, or current 
state of the template. As shown in the 
accompanying illustration, several 
items are unavailable because this 
illustration represents the Units menu 
after the maximum number units are 
defined for the current channel.

2.4.12.7.1  Add Unit: This menu item performs the same function as the Add Unit 
button above the Control Table. After a template set has been collected, select this 
item to add a unit to the channel. When the maximum number of four units is 
added to a channel, Sort Client makes this item unavailable.

2.4.12.7.2 Delete Last Unit: This menu item deletes the last unit added on this 
channel. This menu item performs the same function as the Del Unit button 
above the Control Table. This item is unavailable until at least one unit is added 
to the channel.

2.4.12.7.3 Delete Selected Unit: This menu item deletes a selected unit. This item 
is unavailable until at least one unit is added to the channel.

2.4.12.7.4 Delete All Units: This menu item deletes all units.

2.4.12.7.5 Add Waveforms to the Selected Unit: This menu item enables the selec-
tion tool cursor in the Cluster Display and in the 3D Cluster views. For informa-
tion on how to use the selection tool, see “Cluster Display” on page 93. The 
selection tool in Cluster Display and 3D Cluster views can be used only to select 
individual waveforms to add to the selected unit. Sort Client recalculates the unit 
template using the new set of waveforms.
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2.4.12.7.6 Remove Waveforms from the Selected Unit: This menu item enables the 
removal tool cursor in the Cluster Display and in the 3D Cluster views. For infor-
mation on how to use the removal tool, see “Cluster Display” on page 93. The 
removal tool in the Cluster Display and the 3D Cluster views can be used only to 
select individual waveforms to add to the selected unit. Sort Client recalculates 
the unit template using the new set of waveforms.

2.4.12.8 Window

The accompanying illustration 
shows the Window menu, 
which includes three areas: top, 
default, and window list.

2.4.12.8.1  Top area: The top 
area includes standard 
Microsoft Windows com-
mands. 

2.4.12.8.2 Default Layout: This 
item returns the Sort Client 
Main Window to the default layout. 

2.4.12.8.3 List area: This area lists the Sort Client windows in the order they were 
opened.

2.4.12.9 Help

The accompanying illustration shows the Help menu.

2.4.12.9.1  Help Topics: This item opens the online PDF 
version of this manual.

2.4.12.9.2 Quick Reference: This item opens the Quick 
Reference list illustrated on the following page.

2.4.12.9.3 About SortClient: This item opens the About SortClient window, 
which contains the version number and build date.
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2.4.12.10 Sort Client Quick Reference List
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3.1 MAP Box Configuration

Plexon configures MAP Server software for each MAP system. For information 
on Server, see “MAP Server Overview” on page 141. However, if any changes 
are made to the MAP system, verify that the MAP Server settings match the MAP 
system configuration. The following items must match the MAP Server settings:

• Number of channels provided with the license key

• Number of SIG boards in the MAP box

• Number of DSP boards in the MAP box

• Number of digital input (DI) and output (DO) sub-boards on the DSP board

• Number and type of NI DAQ devices

• Device numbers assigned to NI DAQ devices in NI MAX

• Number of output connectors on the OUT board

• Link board: Host Link 2 (HLK2) or a Multisystem eXtension Interface (MXI)

3.1.1 License Key

The software license key limits the number of channels That can be used. 

To verify the number of licensed channels

1 Start Server. For instructions, see 
“Startup” on page 141.

2 From the View menu, click Licensing.

The Plexon License Management win-
dow opens.

3 In the Plexon License Management window next to Rasputin, observe 
and record the number of channels. The number of channels can be 16, 
32, 64, 96, or 128.
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3.1.2 Boards In the MAP

The following illustration shows a MAP box with a full complement of compo-
nents for 128 channels. In most cases, MAP systems include an equal number of 
SIG and DSP channels. Each SIG board processes 16 channels. Each DSP board 
can process either 16 or 32 channels, depending on the configuration. 

 

Verify the number of boards and channels on the MAP box

1 At the MAP box, count and record the number of SIG boards. Multiply the 
count by 16 to get the number of available SIG channels on the MAP box.

2 Remove each DSP board. For illustrations and board removal instructions, 
refer to the Plexon Guide Setting Up MAP System Digital Input and Output, 
01-01-C-3003. Count and record the number of processors at the rear portion 
of the card. A 16-channel DSP board has two processors; a 32-channel DSP 
board has four processors. Multiply the number of channels per board by the 
number of boards to get the number of DSP channels. In most cases, the 
number of DSP channels is equal to the number of SIG channels. For 
example, in the previous illustration there are four 32-channel DSP boards to 
match the 128-channel capacity of the MAP box. 

3 Replace all the DSP boards except the board in the rightmost DSP slot, which 
is the DSP board that can support up to four digital input (DI) daughter boards 
or digital output (DO) daughter boards, or both. If daughter boards are 
present, count and record the number of DI daughter boards; DI boards are 
numbered “DI03nn” and they are normally located at the top of the DSP 
board. Also count and record any DO daughter boards; DO boards are 
numbered “DI01nn” and they are normally located below any DI boards.

4 Replace the rightmost DSP board.

3.1.3 Channel Count of the NI DAQ Device

The National Instruments (NI) data acquisition device (DAQ) can support a num-
ber of A/D channels, which can be different from the channel count on the MAP 
box. Use the NI software to verify the NI DAQ channel count.

http://www.plexoninc.com/pdf/DigitalInput.pdf
http://www.plexoninc.com/pdf/DigitalInput.pdf
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To determine the device type using NI software

1 From the Start menu, locate the National Instruments folder and click 
Measurement and Automation.

2 In the Measurement & Automation Explorer window, expand the Devices 
and Interfaces folder. Record the device names.

3 Close the Measurement & Automation Explorer window.

A list of typical devices follows:

• PCI-6040E (250 kSamples/sec, 16 channel, 12-bit resolution)

• PCI-6070E (1.25 MSamples/sec, 16 channel, 12-bit resolution)

• PCI-6071E (1.25 MSamples/sec, 64 channel, 12-bit resolution)

3.1.3Connectors On the OUT Board

To configure the RASPUTIN Software software, the number of connectors on the 
OUT board need to be entered. At the MAP box, count and record the number of 
connectors on each OUT board. For more information on the OUT board connec-
tors, see “Using Ref2 with the OUT Board” on page 160.

3.1.4 Link Board Type

To configure the RASPUTIN Software, the type of host-link board must be 
selected. At the MAP box, check the label of the link board in the rightmost slot. 
Determine if the host-link board is a host link 2 (HLK2) or a Multisystem eXten-
sion Interface (MXI).
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3.1.5 Configuration Consistency

The following chart shows consistent combinations of components. Before con-
figuring MAP Server, verify the component counts and device types to make sure 
they match one of the following combinations.

3.1.5.1DSP Sub-Boards

The MAP box can support up to four digital signal processor (DSP) sub-boards 
on the first (rightmost) DSP board. The sub-boards can be either digital input (DI) 
or digital output (DO) boards. If the system includes DSP sub-boards, the DI sub-
boards must occupy the DSP sections in prescribed orders based their mode set-
tings. For more information on DSP sub-boards and strobed words, refer to the 
Plexon Guide Setting Up MAP System Digital Input and Output, 01-01-C-3003.

3.2  MAP Server Overview

Plexon MAP Server (Server) interacts directly with the MAP box and establishes 
two-way communication between the MAP box and the various client programs 
on the PC, such as the Sort Client, PeriEvent Client, etc. Server transfers com-
mands such as gain and filter changes or parameter settings from the various cli-
ents to the MAP box. Server distributes spike and continuous waveform data 
from the MAP box to the client programs. After Server is set up, very few 
changes are required under normal use.

3.3 Startup

Before Server can be run, the MAP system must be turned on. To run 
Server, double-click Server.exe in the directory where the RASPUTIN 
Software is installed, or double-click the Server desktop icon.

Licence Key SIGs DSPs NI DAQ

16 1 1 x 16 PCI-6040E
or

PCI-6070E

32 2 1 x 32 ch PCI-6071E

64 4 2 x 32 ch PCI-6071E

96 6 3 x 32 ch PCI-6071E

128 8 4 x 32 ch PCI-6071E

http://www.plexoninc.com/pdf/DigitalInput.pdf
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If an attempt is made to start Server with the MAP box (Harvey Box) turned off, 
the following warning appears. Shut down Server, turn the MAP box on, and then 
restart Server.
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3.4 MAP Server Main Display Window

The accompanying illustration shows the 
Plexon MAP Server main display window.

3.4.1 Settings

The area below the menu displays informa-
tion about the data transfer rates between the 
PC and the MAP box as follows:

3.4.1.1 kw/s

This setting means kilowords transferred per 
second (16-bit words)

3.4.1.2 ts/s

This setting means timestamps per second

3.4.1.3 wf/s

This setting means waveforms per second

3.4.1.4 MMF

The setting means Memory Mapped File—
shows activity in the buffer that distributes data from the MAP to the RASPUTIN 
Software clients

3.4.1.5 NI

This setting contains the bandwidth of the continuous signals digitized by the NI 
DAQ device in kilosamples per second

3.4.1.6 Cmds

This setting contains the number of commands waiting to be sent to the MAP box

3.4.1.7 Dropped waveforms

This setting contains the number of spikes (timestamps and waveforms) lost due 
to errors of data-transfer rate limitations; this value is 0 (zero) under normal con-
ditions.

Note: This field shows the number of waveforms that Server drops because of limita-
tions in the bandwidth of the host link. The older slower link is the MXI. The 
newer faster link is the HLK2. With the MXI, bandwidth limitations can occur 
when there are more than 64 channels and all the waveforms (not just the 
timestamps) are being recorded. This rarely occurs with the HLK2 due to its 
increased bandwidth. If this number is greater than zero, increase the size of 
the MMF. For more information, see “Size of the memory-mapped file 
(MB)” on page 150.
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3.4.1.8 HLK

This setting shows the data transfer rate between the PC and the MAP box

The lower area of the window contains an action button, a client counter, and a 
scroll box:

3.4.1.9 Clear

Click the Clear button to clear the information in the scroll box at the bottom of 
the dialog-box window

3.4.1.10 Clients connected

This setting provides a count of the number of clients (Sort Client, Ref2, GAC, 
etc.) that are connected to Server

The lower panel includes a window that displays status information that can 
safely be ignored during normal operation.

3.5 Menu Commands

The following sections include information about each menu command.

3.5.1 File > Exit

Use the Exit command to shut down Server.

To shut down Server

1 Exit Sort Client and all other RASPUTIN Software client 
programs.

2 From the File menu, click Exit.

3.5.2 View > Hardware Configuration

Use the Hardware Configuration command to change the MAP configuration.

To change the MAP configuration

• From the View menu, click Hardware 
Configuration.
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A Box Configuration window similar to the following one opens.

Note: The Box Configuration window shows the current hardware configu-
ration of the MAP box. The window shows the MAP slots and which 
type of circuit board occupies each slot. Activated boards are white; 
deactivated boards are gray.

3.5.2.1 Boards

Each type of board is represented by one of the following three-letter codes:

3.5.2.1.1 SIG: represents a 16-channel Signal (SIG) input board:

• SIG boards receive pre-amplified neural signals from a PBX or other preamp

• SIG boards provide programmable gain, filtering, and A/D conversion for 16 
electrode channels

• SIG-board slots must be populated sequentially from left to right—click on 
the left-most SIG slot or SIG board to activate or deactivate it

3.5.2.1.2 OUT: represents an Output (OUT) board, which directs up to 20 input 
signals (after SIG board gain and filtering, but before A/D conversion) to contin-
uous outputs on the faceplate of the board. 

Note: The MAP system currently supports only a single OUT board for use with the 
first 64 channels.
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Ref2 controls the assignment of the input channels to continuous output channels 
under program control. For more information, see “Ref2” on page 155. The fol-
lowing items represent the connectors on the faceplate of the OUT board:

• 16 - represents the 16 analog-output channels on the 34-pin connector —click 
to activate or deactivate the 34-pin connector

• bnc - represents the four analog-output BNC connectors—click to activate or 
deactivate the four BNC connectors

3.5.2.1.3 SWH: represents a Switch (SWH) board that enables a subset of the 
SIG channels to be connected to the Digital Signal Processor (DSP) channels 
under program control—click to activate or deactivate the SWH boards.

Note: If there are more SIG channels than DSP channels, the MAP includes 
an SWH board.

3.5.2.1.4 DSP: represents a Digital Signal Processor (DSP) board that captures 
waveforms and performs spike sorting operations:

• Each DSP board contains either two (16-channel board) or four (32-channel 
board) Motorola digital signal processors; each processor receives 8 channels 
of A/D data from a SIG board—click 16 or 32 to select the number of chan-
nels. For more information on DSP-board processors, see “Boards In the 
MAP” on page 139.

• Server represents the order of the DSP boards sequentially from left to 
right—click on the left most DSP slot or DSP board to activate or deactivate 
it. The actual boards in the MAP chassis are physically located sequentially 
from right to left.

3.5.2.1.5 Number of SIG channels: indicates the total number of Signal chan-
nels configured for the MAP box

3.5.2.1.6 Number of DSP channels: indicates the total number of DSP channels 
configured for the MAP box

Note: For most hardware configurations, the number of SIG channels is equal to the 
number of DSP channels. If there are more SIG channels than DSP channels, 
the MAP includes an SWH board.

3.5.2.1.7 Number of channels licensed: indicates the total number of MAP 
channels that are licensed on the Sentinel hardware key mounted on the PC con-
nected to this MAP box. For information on license keys, see “View > Licensing” 
on page 154.
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3.5.2.1 Example Hardware Configurations

The following illustration shows a Box Configuration window that represents a 
MAP system with a total of 32 licensed channels (32 channels each for SIG and 
DSP) with four BNC outputs and 16 non-BNC outputs.



3 MAP Server 

148  RASPUTIN Software

The illustration that follows is a Box Configuration window that shows a MAP 
box with a total of 64 channels (32 channels each for SIG and DSP) with four 
BNC outputs and 16 non-BNC outputs.

Note: As the illustration that follows also shows, the user has attempted to activate 
more than the licensed number of channels. If there is an attempt to enable 
more channels than the license allows, a box with Unlicensed Configuration! 
appears. The MAP in the illustration is only licensed for 32 channels, not 64.

3.5.3 View > Options

Use the Options command to open the Options window.

To change Server Options

• From the View menu, click Options.
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The Options window opens with the Box tab selected.

3.5.3.1 Options: Box

The Box tab contains options that control the operation of the MAP box and the 
link to the host computer.

The Host Link area contains the following host-link settings:

3.5.3.1.1 MXI: If the MAP box has a Multisystem eXtension Interface (MXI) 
board, click MXI.

3.5.3.1.2 HLK2: If the MAP box has a Host Link 2 (HLK2) board, click HLK2.

3.5.3.1.3 MXI base address (hex): This field contains the address of the mem-
ory segment used by the MXI card to communicate with the MAP box; most PCs 
(Dell Dimension and Optiplex, Gateway, etc.) use d0000 and Dell Workstations 
use e0000.
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3.5.3.1.4 HLK2 NI device number: This field contains the number of the 
National Instruments (NI) device that connects the PC to the HLK2 board. This 
number must be the same device number as the NI MAX utility reports for the NI 
6533 device installed in the PC (older systems can report this as DIO-32HS 
instead of 6533).

Note: Server supports up to four NI DAQ devices plus the NI 6533. The HLK2 device 
and each NI DAQ device must be assigned unique device numbers. For exam-
ple:

• the first 6071E is assigned as device number 1
• the second 6071E is assigned as device number 2
• the HLK2 is assigned as device number 3

 For more information, see “Options: NIDAQ” on page 152.

3.5.3.1.5 COM port: This field contains the serial communications (COM) port 
that connects the PC to the MAP box.

3.5.3.1.6 Digital Input Section: The default value for this setting is correct for 
most applications.

3.5.3.1.7 Set high bit of strobed event words from section > 1. For strobed 
words that originate from a DI sub-board located on a DSP2, DSP3, or DSP4, 
check this box to set the high bit to 1. When the high bit is set to 1, two strobed DI 
sub-boards are allowed, with one sub-board on DSP1 and one sub-board on 
DSP2, DSP3, or DSP4; the high bit of the strobed word indicates which strobed 
DI sub-board the event came from. For a more information, see “DSP Sub-
Boards” on page 141.

3.5.3.1.8 DSP program to load: This field contains the location and the name of 
the DSP program file (ends in a .p suffix).

3.5.3.1.9 Gain Multiplier: This field contains the gain multiplier, which consists 
of the headstage gain  the spike-preamp gain  SIG-board jumper gain setting. 
A typical gain configuration follows:

20 (headstage)  50 (spike preamp)  1 (SIG-board jumper) = 1000 (Gain Multiplier)

3.5.3.1.10 Size of the memory-mapped file (MB): This field contains the size 
of the circular memory buffer that Server makes available to the client programs; 
the default value is 16 MB.

3.5.3.1.11 Maximum of host link indicator: This field indicates the maximum 
relative value that the HLK bar represents in the Server main window. For more 
information on the HLK bar, see “HLK” on page 144.
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3.5.3.2 Options: Waveforms And Frequency 

The Waveforms And Frequency tab contains options that control the maximum 
waveform length and the sampling frequency.

 

The Waveforms area contains the following options:

3.5.3.2.1 Standard Waveforms (up to 56 data points): Use this setting to sort 
action potentials of less than 1.4 milliseconds in duration and select 40 KHz (25 
µsec) in the Sampling Frequency area. This setting can be used with the stan-
dard DSP code.

3.5.3.2.2 Long Waveforms (up to 120 data points): Use this setting for sorting 
action potentials greater than 1.4 milliseconds in duration. In the Sampling Fre-
quency area, select a lower sampling frequency of 20 or 25 KHz. This setting 
requires a special version of the DSP code. For more information on this code, 
contact support@plexoninc.com.
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The Sampling Frequency area contains the sampling frequency selections that 
correspond to the waveform selections in the Waveforms area. 

Note: If any changes are made to the waveform and frequency settings, Server must 
be restarted along with any client programs that have been started.

3.5.3.3 Options: NIDAQ 

The NIDAQ tab contains settings for the NI DAQ devices and wiring instructions 
for start pulse and clock signals.

3.5.3.3.1 Enable: If the system is using National Instruments Data Acquisition 
(NI DAQ) devices (cards) to record continuous signals simultaneously with the 
spike data from the MAP, Enable must be selected.This does not affect the NI 
6533 device connected to the HLK2 board.

3.5.3.3.2 Number of NIDAQ cards: Enter the number of NI DAQ cards 
(devices) installed in the PC. Up to 4 cards may be installed, which must all be 
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the same model. When Enable is clicked, the default value 1 appears. Do not 
include the NI 6533 device (card) connected to the HLK2.

Note: Prior to adding or configuring a NI DAQ card, run the NI MAX procedure “To 
determine the device type using NI software” on page 140 to get the cor-
rect device numbers.

3.5.3.3.3 A/D channels per card: Enter the number of A/D channels on the NI 
DAQ cards; 16 (default value) or 64, depending on the NI DAQ devices, for 
example:

• PCI-6040E (250 kSamples/sec, 16 channel, 12-bit resolution)

• PCI-6070E (1.25 MSamples/sec, 16 channel, 12-bit resolution)

• PCI-6071E (1.25 MSamples/sec, 64 channel, 12-bit resolution)

Note: All NI DAQ devices used for continuous data must be the same type. To deter-
mine the NI DAQ device type, see “Channel Count of the NI DAQ Device” on 
page 139.

3.5.3.3.4 NI device numbers for NIDAQ cards: Select a device number for 
each NI DAQ device. Observe the note below the selection boxes and do not 
select the NI device number assigned to the HLK2 interface. If necessary, change 
the NI device number assigned to the HLK2 on the Box tab may be changed; see 
“Options: Box” on page 149. 

The device numbers selected must match the device numbers listed in NI MAX, 
otherwise, a warning can appear, which means that Server must be restarted.

3.5.3.3.5 Show Available NIDAQ Cards: This button displays a dialog box that 
shows the existing NIDAQ devices and their corresponding device numbers. If 
the device numbers do not match what the NIMAX program shows, set the 
device numbers as described in the previous paragraph.

3.5.3.3.6 MAP/NIDAQ Synchronization: This area contains instructions for 
connecting the start pulse and clock signals from the MAP box to the NI DAQ 
device. The default setting for the MAP timing (TIM) board is 40 kHz. If the TIM 
board is equipped with a mezzanine board, set the clock frequency to 80 kHz. If 
the system includes a MAP System Extender chassis, click Use PXI clock inter-
face (cPCI external chassis).
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3.5.3.3.7 NIDAQ input mode: Click the analog input (AI) mode for the NI DAQ 
device. Plexon recommends the default NRSE (non-referenced single ended) set-
ting. To enable alternative settings, set the device properties in NI Measurement 
and Automation Explorer (NI MAX) and click Use NI MAX settings.

3.5.4 View > Licensing

Use the Licensing command to view license information, test licensing keys, and 
unlock additional programs and features.

To view licensing information

• From the View menu, click Licens-
ing.

The Plexon License Manage-
ment window opens.

As shown in the illustration, the Plexon 
License Management window includes 
information on the current RASPUTIN 
Software license key and the keys for 
other Plexon products. This window 
can also be used to test keys and to 
enter new codes received from Plexon 
to unlock supplementary features.

3.5.5 View>Copy Messages to Clip-
board: 

copies the contents of the Server messages window into the Windows clipboard, 
so that it can be pasted into an E-mail or another file. Plexon Customer Support 
may ask to perform this function and E-mail the results to Plexon, as the mes-
sages can be useful in helping Plexon diagnose system problems.
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3.5.6 Help > About Server

When Plexon is contacted about MAP Server, the information in the About Server 
window will be needed. Use the About Server command to view the version and 
release information for the installed copy of Server.

To view Server information

• From the Help menu, click About 
Server.

The About Server window opens.
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4.1 Overview

Ref2 v1.1 (06/06) (Ref2.exe) is a Windows XP program that can be used in con-
junction with RASPUTIN Software Server and Sort Client. With Ref2, reference 
channels can be set up in the Plexon PBX and channels may be connected to the 
MAP system OUT board. 

Referencing enables subtracting, or differencing, the signal on one channel from 
the signal on other channels. This can be a very effective way to remove noise or 
artifacts from otherwise acceptable signals. For more information on referencing, 
see “Grounding and Referencing Basics” on page 169. Ref2 can:

• Create up to seven references.

• Control the programmable referencing boards in up to four PBX preamps.

• Assign references to spike and field potential channels.

Ref2 can also select individual channels and direct the output to the connectors 
on the faceplate of the OUT board; for more information, see “Using Ref2 with 
the OUT Board” on page 160. Ref2 configurations can also be saved in a .re2 file 
for future use.

The following illustration shows a typical use of Ref2 with a programmable PBX 
preamp for referencing and an OUT board connected to an external recording 
device and oscilloscope. 

Ref2 includes the functionality of the earlier Front End Client (FEC) program and 
completely supersedes it. In addition, Ref2 supports multiple PBX preamps and 
referencing for field potential channels. Ref2 is not compatible with FEC; do not 
run both programs simultaneously.
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4.2 Using References in Ref2

Ref2 can assign references as follows:

• Spike (SP) channels can be references only for other spike channels.

• Field potential (FP) channels can be references only for other FP channels.

• References can be assigned only within the same programmable PBX 
preamp.

4.2.1 Assigning and Applying References

This example procedure shows how to use Ref2 to assign a channel as a refer-
ence, and then apply that reference to other channels to remove noise or artifacts 
from the signals. 

Example procedure for using references

This example assumes that there is an artifact on spike channel SP12. 
The same artifact also appears on unused spike channel SP10. To 
remove the artifact, assign spike channel SP10 as reference R1, then 
apply reference R1 to spike channel SP12.

1 Double click on the Ref2 desktop icon to start Ref2.

The Ref2 window opens. The seven colored reference buttons 
are beneath the toolbar. The OUT and BNC connections are on 
the left side. The center area consists of a grid of channel buttons. 
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2 Click spike channel SP10.

Ref2 adds the label SP to the mouse pointer to indicate a spike channel. 

3 Move the SP pointer to reference R1. Click R1. 

SP10 changes label and color to indicate its assignment as R1. R1 adds SP.
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4 To apply reference R1 to SP12, click R1-SP. 

The mouse pointer label changes to REF1. 

5 Move REF1 to SP12. Click SP12. 

SP12 changes color to indicate reference R1-SP is applied.

Note: It is possible to continue to move and click REF1 to assign R1-SP to 
other channels. To clear the pointer label, right-click in the dark-blue 
background area or press the ESC key. 
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4.2 Using Ref2 with the OUT Board

The OUT board includes an LED, a 34-pin connector, and 
four BNC connectors. The LED flashes when connections 
are made with Ref2. It is possible to connect signals to the 
connectors on the OUT board as follows:

• Connect any spike (SP) channel to any pair of channel 
pins on the 34-pin connector. The connector channel 
numbers appear under OUT.

• Connect any SP channel to any BNC connector. The 
BNC connector numbers appear under BNC. 

• Field potential (FP) channels cannot be connected to the 
OUT board because they are not processed through the 
MAP box.

4.2.1 Connecting Channels to the OUT Board Connectors

This example procedure shows how to use Ref2 to connect 
spike channels to the connectors on the OUT board.

Example procedure using Ref2 with the OUT board

This example assumes that the signals from spike 
channel SP10 through channel 1 on the OUT connector 
are being sent to an external device, and that an oscillo-
scope connected to BNC 1 is being used to view the 
SP10 signal.

1 Double click on the Ref2 desktop icon to start Ref2.

The Ref2 window opens. The seven colored reference buttons are 
beneath the toolbar. The OUT channels and BNC connectors are 
on the left side. The center area consists of a grid of channel but-
tons. 

LED

34-pin 
connector

BNC 
connectors
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2 Click SP10.

The mouse pointer label changes to SP. 

3 Move the SP pointer to channel 1 on the OUT list. Click OUT 1. Click SP10. 
Move the SP pointer to connector 1 on the BNC list. Click BNC 1. 

The SP10 channel button shows its connections as B1-O1. OUT channel 1 
and BNC 1 show connection S10.

Note: If the Ref2 window is expanded, B1-O1 in the preceding example 
expands to BNC1-OUT1. 

4.3 Disconnecting and Resetting References

References can be connected one at a time, or all at once. References can be dis-
connected or reset in three ways: 

• Disconnect a reference from a single channel.

• Disconnect a reference from all channels and clear the reference.

• Disconnect and clear all references at once.
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Disconnecting a reference from a single channel

1 Move the pointer over the referenced channel and right click.

The disconnect menu opens.

2 On the disconnect menu, click Disconnect REF. 

The channel loses the reference color and returns to gray.

Clearing a reference button

1 Move the pointer over a reference and right click.

The following Ref2 dialog box appears.

2 To clear the reference assignment and all its applications, click Yes.

All channels with that reference applied return to gray. The reference button 
clears and becomes available for use with another reference channel. 
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Clearing all references at once

• Clear all reference channels and disconnect all reference assign-
ments from all channels at the same time, click the Disconnect all 
REFs button on the toolbar.

Ref2 disconnects all reference applications and clears all channels from the 
reference buttons. All buttons in the channel grid return to gray. Connections 
to OUT channels and BNC connectors remain.

Note: The Disconnect all button performs the same action as the Discon-
nect all REFs button, but it also disconnects OUT channels and BNC 
connections. The New (reset all) button also resets all references 
and connections. For more information on these buttons, see “Tool-
bar” on page 167.

4.4 Replacing References

One reference may be replaced with another reference. When this is done Ref2 
automatically updates all the referenced channels in the grid with the replacement 
reference. 

Replacing one reference with another

This example shows how to replace reference R4 with reference R1.

1 Click R1. 

The mouse pointer label indicates REF 1.

2 Move the mouse pointer to R4. Click R4.

A Ref2 dialog box opens to confirm the selection.

Make sure the selection is correct, then click Yes.
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The channels with the purple R4 reference change to blue R1. The channel 
assigned as reference R4 (SP13) is clear.

4.5.1 Invalid Referencing

It is possible to make some invalid 
reference assignments that result in 
Ref2 warnings.  The illustration 
shows a typical warning dialog box.

4.5 Setting Ref2 Options

For most MAP systems, Plexon configures Ref2 to correctly match the number of 
PBX preamps and the number of programmable spike and field potential boards 
in each PBX. However, if the PBX hardware changes, the programmable preamp 
(PBX) settings in Ref2 must also change. 

Changing PBX preamp settings

1 On the toobar, click the Options/PBX config button.
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The Ref2 Options window opens and shows the current settings.

2 In the Number of PBXs box, select the number of PBX preamplifiers 
connected to the MAP system. The maximum Ref2 supports is four PBXs. 

3 In each PBXn area, set the Spike channels box and the FP channels box to 
match the programmable boards in each PBX.

4 Click OK to close the Ref2 Options window. 

5 Click Yes to close the Ref2 advisory window. Restart Ref2.

4.6 Sort Client Interactions with Ref2

When a different SP channel in Ref2 is selected, Sort Client simultaneously 
switches to that channel in its main window; likewise, when a different channel is 
selected in the Sort Client Multichannel Display, Ref2 displays that channel as 
the selected channel. Ref2 also automatically assigns BNC1 to that same channel.
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4.7 Operating Ref2 with Multiple PBXs

This section contains two examples of Ref2 configured for multiple PBXs. The 
following illustration shows Ref2 with a MAP that contains one OUT board and 
two PBXs each with 16-channel SP and FP boards. 

The illustration that follows shows a MAP system configured to maximum 
capacity with two OUT boards and four PBXs. Each PBX contains two SP and 
two FP boards, for a total of 128 spike channels and 128 field potential channels. 
The maximum capacity of a MAP system is 128 spike channels. OUT board 1 
only works with PBXs 1 and 2; OUT board 2 only works with PBXs 3 and 4.

4.8 Ref2 General Information

This section contains reference information for Ref2. It also includes some basic 
information on grounding and referencing for electrodes.
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4.8.1 Toolbar

As shown in the following illustration, the Ref2 toolbar consists or four sections: 

• File operations

• Connections

• Display appearance

• Configuration options

4.8.1.1 File Operations

4.8.1.1.1> New (reset all): Click to create a new .re2 file. This button 
resets all references and all connections, and resets the PBX preamps.

4.8.1.1.2> Open: Click to load a configuration file with the extension 
.re2. For more information, see “Saving and Loading a Configuration” on 
page 168.

4.8.1.1.3> Save configuration: Click to save all references and all con-
nections to a configuration file. 

4.8.1.2 Connections

4.8.1.2.1> Re-send commands: Normally, Ref2 issues commands to the 
MAP box and PBXs immediately as the commands are assigned, e.g. an 
SP connection to an OUT. However, to resend all the current settings to 

the MAP box and PBXs, click Re-send commands. Depending on the number of 
channels on the MAP, and the settings in the MAP Server options, it can take sev-
eral seconds for Ref2 to send all the commands.  

4.8.1.2.2> Disconnect all REFs: This command disconnects all refer-
ences from SP and FP channels and clears all channels from all reference 
buttons. This button resets all referencing functions in the PBX.

4.8.1.2.3> Disconnect all OUTs: This command is similar to Disconnect 
all REFs, but it disconnects all OUTs from SP channels.

4.8.1.2.4> Disconnect all BNCs: This command is similar to Disconnect 
all REFs, but it disconnects all BNCs from SP channels.

4.8.1.2.5> Disconnect all:  Click to clear all reference buttons and dis-
connect all OUTs, BNCs, and REFs.

4.8.1.3 Display Appearance

4.8.1.3.1> Larger fonts: Click to increase the font size in the boxes.
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4.8.1.3.2> Smaller fonts: Click to decrease the font size in the boxes.

4.8.1.4 Configuration Options

4.8.1.4.1> Options: Click to open the Ref2 Options window. For infor-
mation on setting Ref2 options, see “Setting Ref2 Options” on page 164.

4.8.1.4.2> Help: Click to open the About Ref2 window, which indicates 
the current version of the Ref2 and its release date.

4.8.2 Saving and Loading a Configuration

Current Ref2 settings may be saved and restored the configuration the next time 
Ref2 runs. Ref2 saves the following information in a .re2 file:

• the PBX configurations (number of preamps and the number of SP and FP 
channels per preamp)

• reference information (reference assignments and applications)

• OUT and BNC connections
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Saving a Ref2 configuration

1 On the File menu, click Save.

The Ref2 Save As window opens. 

Note: As the preceding illustration shows, Ref2 provides an icon for .re2 
files to help locate them more easily. 

2 Type a file name in the File Name box. Click Save.

Loading a Ref2 configuration

1 Start Ref2.

2 On the File menu, click Open.

3 In the Open window, click the desired configuration file, then click Open to 
load the configuration settings.

Ref2 opens with the window size and configuration settings from the .re2 file.

4.8.3 Grounding and Referencing Basics

This section includes some basic information on signal types, grounds, and refer-
encing.

4.8.3.1 Signal Properties and Sources

Neural signals and noise can be roughly classified as follows: 

• Low-frequency signals, such as local field potentials (LFP), where the signal 
spectrum is typically below 200 Hz

• Mid-band signals, typically spike waveforms, where the signal spectrum is 
typically 300 Hz – 5000 Hz

• Low-frequency noise, such as 50/60 Hz AC hum, animal motion artifacts, 
etc., where the noise spectrum is typically below 100 Hz
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• High-frequency noise, such as thermal noise, induced electrical noise, etc., 
where the noise spectrum varies with the source

4.8.3.2 Ground

An effective ground reduces noise by providing a reliable foundation for low-
voltage signals.  

4.8.3.2.1> Headstages and Preamps. As the following subset of the MAP Sys-
tem Circuit Diagram shows, Plexon systems provide a common ground through-
out the signal path from the headstage (HST), through the preamp (PBX), and 
into the MAP box AC power supply. This illustration shows an example circuit 
for an 8-channel HST and a PBX that includes 16-channel spike boards with 
optional cross-point switches (PRA/16 sp-r) for use with Ref2. PRA/16sp-r 
boards are only available on PBXs with 1-pole filtering.

4.8.3.2.2> Headstage Ground and Referencing Links: The headstage (HST) 
section of the preceding schematic shows a link from the referencing pin [(9)R] 
to the ground pin [(10)G]. Plexon headstages can be configured to support a ded-
icated referencing electrode by disconnecting this ground link on the headstage 
circuit board. Headstages from Plexon may be ordered with the ground link con-
nected, which are configured as grounded (GR), or with the ground link discon-
nected to provide a true referencing (TR) configuration. For more information on 
referencing, see “Plexon Referencing Options” on page 172.

All 8-channel headstages have links between the referencing and ground links. 
Sixteen- and 32-channel very-large scale integration (VLSI) headstages do not 
have links between the referencing and ground pins. Instead, these headstages 
have true referencing connections that pass through to the preamp. For more 
information, refer to the appropriate headstage pinout information and schematics 
at http://www.plexoninc.com/Headstages.htm.

http://www.plexoninc.com/Headstages.htm
http://www.plexoninc.com/pdf/MAPSystemCircuitDiagram.pdf
http://www.plexoninc.com/pdf/MAPSystemCircuitDiagram.pdf
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A good ground connection from the ground pin (G) on the headstage to the brain 
is very important. Use one of the following methods to make a good ground con-
nection to the animal:

• skull screws touching the brain

• a wire on top of the brain in underneath the dura

• a wire or guide tube actually in the brain

In general, all signal sources should be grounded. For a floating source such as a 
battery-powered amplifier, contact Plexon for assistance.

4.8.3.3 Referencing

With referencing, artifacts that can appear on several channels may be reduced or 
eliminated. Referencing is the subtraction or differencing of the signal on one 
channel from the signal on other channels. Referencing can be a useful way to 
remove artifacts from the signal on some channels. Artifacts are undesirable or 
unavoidable elements of a signal that usually result from animal activities extra-
neous to the experiment at hand. Typical animal behaviors that cause artifacts are 
chewing, scratching, or sudden head movements.

An example of artifact removal appears in the three illustrations that follow. The 
first illustration shows the signal from a spike channel, which includes a large 

HINT
Grounding the apparatus
Animal Ground: One of the most important things to remember is to 
have the animal, or it's stereotaxis, grounded at one point—at the PBX 
preamp. That is, the ground wire pin of the headstage (pin 10 on an 8-
ch HST) can be used to ground the animal via a wire in the brain or 
skull screw, but then also using a clip lead from the stereotaxis to the 
ground jack on the front of the PBX. Plexon supplies a green ground 
wire for this purpose with each PBX. Unless unavoidable, do not con-
nect other grounds to the animal or frame.

Some stereotaxis advancer mechanisms have insulating parts between 
the major metal mechanical parts, so short clip leads can be used to 
connect the pieces together. Make any ground leads as short as possi-
ble. Use alligator clips and cut wires to length so that the leads are 
very short. Use a multimeter to check the continuity to ground.

Support Structures: Make sure that the stereotaxis frame is either 
insulated from any underlying metal table and that the table is 
grounded, or use a non-conducting table. A metal table may be 
grounded to the third-prong (safety-ground) of a wall-socket. A metal 
table is a big 50/60 Hz sink and it must be grounded to the wall at one 
point.
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artifact that resulted from chewing—the red circle highlights a spike waveform 
superimposed on the artifact. The second illustration shows the signal from a suit-
able referencing channel, which includes the same artifact but does not include 
any spikes. The third illustration shows the spike channel after the signal on the 
referencing channel is subtracted from it, which removes the artifact—the red 
circle highlights the truespike waveform shape. 

Channel 1: Spikes with a chewing artifact

Channel 2: Artifact only with no spikes (not connected to a neural signal source)

Channel 1 - Channel 2: reference applied to remove the artifact

The following guidelines apply to choosing and applying a referencing channel:

• The signal on the referencing channel cannot include significant spike 
activity.

• The referencing channel must include the same artifact that appears on the 
target channels.

• The artifact must be the same shape and phase on the referencing channel and 
the target channels.

• The artifact must be common to all target channels.

4.8.3.4 Plexon Referencing Options

The Plexon MAP system provides the following referencing options:

1 Hardware referencing with dedicated reference electrodes

2 Software-controlled referencing connections that can be selectively changed 
with Ref2 software

4.8.3.4.1> Hardware Referencing: To use hardware referencing, prepare a dedi-
cated low-impedance electrode by removing the insulation at the tip to expose a 
larger area of the electrode surface. This effectively reduces the ability of the ref-
erence electrode to pick up signals from individual neurons without effecting its 
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ability to pick up the same noise and artifacts as the other electrodes attached to 
the headstage.

To use a dedicated referencing electrode, Plexon headstages can be modified by 
severing the link between the referencing pin and the ground pin, as described in 
“Headstage Ground and Referencing Links” on page 170. A dedicated reference 
electrode also requires settings in the preamp as shown on page 174. The illustra-
tion that follows shows an example of an 8-channel headstage with a dedicated 
referencing electrode and separate ground connection that uses a skull screw. The 
electrode connections occur in the headstage but the referencing (or subtraction) 
occurs in the PBX preamp, where the signal from reference electrode is tied to the 
negative input of the differential operational amplifiers (op-amp) in the PBX. The 
cross point switch in this illustration is required to use Ref2; see “Software-Con-
trolled Referencing” on page 175. 

Example of a Dedicated Reference Electrode
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To use a dedicated referencing electrode, the jumpers on the PBX circuit boards 
must be correctly set. There are two types of PRA signal boards in Plexon PBXs: 

• PRA2/16, with 2-pole low-cut and 4-pole high-cut filtering, and no program-
mable referencing (PRA-F type printed circuit board)

• PRA/16-r, with 1-pole low-cut and 1-pole high-cut filtering, with cross-point 
switches for programmable referencing (PRA-E type printed circuit board). 

The illustration that follows shows the PRA2/16 board. To use a dedicated refer-
ence electrode on an 8-channel headstage with the PRA2/16 board, in addition to 
severing the ground-to-reference link, place jumpers on pins J3 for Channels 1-8 
and on pins J7 for Channels 9-16. This is the default jumper setting and Plexon 
ships all PRA2/16 boards with these jumpers in place. 

PRA2/16 Board Jumper Settings for Dedicated Reference Electrodes

Note: Ref 2 in the preceding illustration refers to a second reference electrode—it 
does not relate to the Ref2 software described in this chapter.
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Ref 1 is the reference connection for headstage channels 1 through 8. Ref 2 is the 
reference connection for channels 9 through 16. In the preceding illustration, the 
Ref 1 setting applies to both the 8-channel and 16-channel headstages. That is, 
the reference connection for channels 1-8, which is pin 9 on an 8-channel head-
stage, applies to all channels from 1 to 16. With 32-channel headstages, both the 
Ref 1 and Ref 2 settings can be used. Plexon configures the headstage-to-PBX 
cables to provide the correct connections for all headstage and PBX combina-
tions.

The following illustration shows the PRA/16-r board. To use a dedicated refer-
ence electrode with the PRA/16-r (PRA-E) board, in addition to severing the 
headstage link, a jumper must be in place across the R pins. Plexon ships all 
PRA/16-r boards with this jumper in place as the default setting. 

PRA/16-r Board Jumper Setting for Dedicated Reference Electrode

4.8.3.4.2> Software-Controlled Referencing: The Ref2 software controls the 
cross-point switches shown in the preceding illustration. Ref2 requires PRA/16-r 
(PRA-E) boards with cross-point switches. Ref2 can allow setting the cross-point 
switches to select any electrode as a reference and subtract its signal from any 
other electrode, or combination of electrodes.

Cross-Point Switch

Cross-Point Switch
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Note: If the reference connections on PBX circuit boards need to be changed to use 
other references, contact Plexon customer support for assistance. 
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5.1 Overview

PLX Utilities (PlexUtil) is a program for organizing .plx and .ddt data files. For 
complete information on these file formats, see “Understanding PLX and DDT 
Data Files” on page 195. PlexUtil can:

• scan .plx files for errors and inconsistencies and repair the files

• create subsets of files that include:

— all channels

— the selection of spike, event, and continuous channels

— the selection of start and end times

— the choice of file name

• split files with the choice of the following options:

— include all channels

— include the selection of spike, event, and continuous channels

— split the file into multiple files by:

– channels

– time

– space

– frames

— the choice of file name

• convert the continuous channels of a .plx file to a .ddt file, and the .ddt file to 
a .plx file, which only contains continuous channels. The convert function 
provides the following choice of options:

— all continuous channels

— selected continuous channels

— include all data

— specify start and end times

— the choice of file name

• re-order .plx files using either system temp or output directories

• merge two or more compatible files as follows:

— data blocks by timestamps

— consecutively with a time gap between files

— the choice of file name
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With all functions that accept a time input, the time in fractions of a second may 
be specified. The time entered in seconds is converted to timestamps. For exam-
ple, if the data in a file is clocked at 40 kHz, the actual time resolution is 
25 microseconds.

With all functions that accept a disk space (file size) input, the space in fractions 
of a megabyte may be specified. The resulting files are never larger than the size 
specified, which includes all headers and data. PlexUtil attempts to create the 
largest valid file, which is equal to or less than the size specified.

Any operation may be cancelled at any time. When an operation is cancelled, 
PlexUtil:

• cancels the activity

• deletes all output files

• deletes all temporary files

• provides a message describing the action

5.2 Opening, Scanning, and Repairing Files

PlexUtil includes a file browser to locate .plx files on the computer or on a net-
work. When PlexUtil starts, it opens with a file browser pane that includes the 
same view as in Windows Explorer. The PlexUtil toolbar buttons remain unavail-
able until a file is clicked.

To start PlexUtil and open a file

1 To start PlexUtil, double-click the PlexUtil icon on the desktop.

PlexUtil opens with the start screen.

2 In the PlexUtil File Browser pane, navigate to a .plx file and click on the file to 
open it.
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PlexUtil scans and opens the .plx file with a summary in the Info pane.

The Info pane displays three columns of information derived from three 
sources, which are highlighted as follows:

• Green: data from the file system; file size and creation time

• Yellow: data directly from file headers

• Red: information from actual data blocks, which is updated after scanning 
because PlexUtil automatically selects all channels with non-zero counts 
before scanning, then it updates the counts to reflect actual data.

Note: For complete information on the items that PlexUtil checks while 
doing a scan, see “What Scan Does” on page 197.

3 After the file opens, PlexUtil provides a summary of the items found during the 
scan in the top right corner of the Info pane. To see a full report, click Review. 

The PLX Scan - Review Results window opens.

Note: The review window contains a Repair button. For more information 
on repairing files, see “What Repair Does” on page 199.
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To proceed without repairing the file, click Cancel to close the review window.

4 To look at the contents of the file, click the tabs at the bottom of the right pane. 
The Spikes, Events, and Continuous tabs list the information in the same 
format as Sort Client. Scan updates the Counts and Data Size columns for 
more correct estimation of subsets or splits. The Browser tab shows the data 
blocks in numerical order with the following colors for each data type: Spikes 
= white, Events = yellow, and Continuous = green. 

5 To close the file, click on any folder in the File Browser pane.

5.3 Creating a Subset of a File

PlexUtil can create a new subset file of a .plx file. When the subset file is created, 
the original .plx file remains intact. It is possible to select which channels to 
include in the subset file, which part of the file to include in the subset based on 
start and end times, and the name and location of the new subset file. Numerous 
subset files can be created with different content and distinct names.

To create a subset of a file

1 Start PlexUtil. In the File Browser pane, click the file to create a subset of. 

2 When the file opens, review the contents and make any repairs. For more 
information, see “What Repair Does” on page 199.

3 If the subset of the file should only include certain channels, select those 
channels now; on the Spikes, Events, and Continuous tabs, select each 
channel to include in the subset of the file.

4 On the toolbar, click the Subset button.

The PLX Subset 1 of 4 - Select Channels window opens.
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5 To include all spike, event, and continuous channels, click All channels. To 
include only those channels selected in Step 3, click Selected channels. 
Click Next.

The PLX Subset 2 of 4 - Select Time window opens.

6 If only a portion of the file is to be based on time, enter the start and end 
times. To update the Acquired On time in the header of the subset file and to 
reset all timestamps accordingly, click Adjust Start Time. Click Next. 

The PLX Subset 3 of 4 - Select Output File window opens.
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Note: PlexUtil automatically adds _sub to the subset file name.

7 In the PLX Subset 3 of 4 - Select Output File window, type or select a 
location and a name for the subset file. To continue, click Next.

The PLX Subset 4 of 4 - Review Actions window opens.

8 Review the Input Information and Output Information areas to make sure 
PlexUtil creates the needed split files, then click Finish to create the file and 
close the subset window.

5.4 Splitting Files

PlexUtil can split a .plx file into multiple new files. When a split operation is 
completed, PlexUtil preserves the original .plx file and creates multiple new .plx 
files that include the characteristics specified. It is possible to specify which 
channels to include in the split files. Files may be split by:

• channels

• time slices in seconds

• file size increments in megabytes

• frame segments that are bounded by start and stop events

To split files by channels

1 In the File Browser pane, select the file to split.

2 When the file opens, review the contents and make any repairs. For more 
information, see “What Scan Does” on page 197 and “What Repair Does” on 
page 199.
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3 If the split files should only include certain channels, select those channels 
now; on the Spikes, Events, and Continuous tabs, select each channel to 
include in the split files.

4 On the toolbar, click the Split button.

The PLX Split 1 of 4 - Select Channels window opens.

5 To include all spike, event, and continuous channels, click All channels. To 
include only those channels selected in Step 3, click Selected channels. 
Click Next.

The PLX Split 2 of 4 - Select Slices window opens.
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6 In the PLX Split 2 of 4 - Select Slices window, chose one of the following 
options:

• By Channels: Click to create a separate file for each spike channel. To 
create a separate file for all the non-spike channels, click Save Events 
and Continuous Channels in separate file. Otherwise, click to clear the 
check box to ignore the event and continuous channels. Each split-by-
channels file is in the format myfile_spl_cNNN.plx.

Note: If channels are selected with 0 in the Units, Unsorted, or Count col-
umns, PlexUtil initially sets up file names for these channels. These 
file names can appear briefly in the File Browser pane. When Plex-
Util determines that there is no data for these channels, PlexUtil auto-
matically deletes the file names. 

• By Time: Click to create separate files based on time slices. Type the 
duration of each file in seconds. If the box blank is left blank, PlexUtil does 
not split the file. If a duration is entered that is greater than the initial file 
duration, PlexUtil does not split the file. Each split-by-time file is in the for-
mat myfile_spl_tNNN.plx.

• By Space: Click to create separate files based on file size. Type the size 
of the files in megabytes. If the box blank is left blank, PlexUtil does not 
split the file. If a size is entered that is greater than the initial file size, 
PlexUtil does not split the file. Each split-by-space file is in the format 
myfile_spl_sNNN.plx.

• By Frames: Click to create separate files based on start and stop events. 
Each split-by-frames file is in the format myfile_spl_fNNN.plx.

Click Next.

The PLX Split 3 of 4 - Select Output File window opens.
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7 In the PLX Split 3 of 4 - Select Output File window, type or select a location 
and name for the split files. Click Next.

The PLX Split 4 of 4 - Review Actions window opens.

8 Review the Input Information and Output Information areas to make sure 
PlexUtil creates the split files needed. Click Finish to create the file and close 
the split file window.

5.5 Converting Files

PlexUtil can convert a .plx file into a .ddt file, or conversely, a .ddt file to a .plx 
file. When a file conversion is completed, PlexUtil preserves the original .plx or 
.ddt file and creates a new .ddt or .plx file that includes the characteristics speci-
fied. It is possible to specify which channels to include in the converted files and 
to specify a time interval to convert. 

HINT
Repair data blocks before conversion
If the PlexUtil file scan 
reveals bad blocks when a 
file is opened, repair the data 
blocks before converting the 
file, otherwise the following 
error message can appear. 
For more information, see 
“What Repair Does” on 
page 199. 
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To convert a file

1 In the File Browser pane, select the file to convert, either a .plx file or a .ddt 
file.

Note: For simplicity, this procedure shows a .plx to .ddt file conversion. A .ddt 
to .plx conversion can also be done, which means the .plx file only 
contains continuous channels.

2 When the file opens, review the contents and make any repairs. For more 
information, see “What Repair Does” on page 199.

3 If the converted file should only include certain channels, select those channels 
now; on the Continuous tab, select each channel that should be included in 
the converted file.

4 On the toolbar, click the Convert button.

The PLX Convert 1 of 5 - Select Conversion window opens.

Make sure that the file to be converted is correct, either .plx to .ddt or .ddt to 
.plx, then click Next.
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The PLX Convert 2 of 5 - Select Channels window opens.

5 To convert all continuous channels, click All continuous channels. To 
convert only the channels selected, click Selected continuous channels. 

Note: If the continuous channel data is inconsistent, the following messages 
can appear. 
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To avoid these problems, in the Continuous tab, make sure that the 
channels selected indicate:

• Enabled = yes
• Frequency = <the same for all selected channels>
• Preamp Gain = <the same for all selected channels>
• Count = <the same for all selected channels>

Note: Some .plx files can have disordered continuous data blocks that 
result in errors during conversion. This often happens with files that 
were converted to .plx from other formats. In these cases, it can be 
beneficial to re-order the .plx file before converting it to .ddt. For more 
information, see “Re-Ordering Files” on page 191.

Click Next.

The PLX Convert 3 of 5 - Select Time window opens.

6 To include all the data for the channels selected, click Process all available 
data. To include only the data for a specific time interval, click Restrict by 
time interval and type the time in seconds in the From and To boxes. Click 
Next.
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The PLX Convert 4 of 5 - Select Output File window opens.

7 In the PLX Convert 4 of 5 - Select Output File window, type or select a 
location and name for the subset file. Click Next.

The PLX Convert 5 of 5 - Review Actions window opens.

8 Review the input and output information. If it’s correct, click Finish to create 
the file and close the convert window.
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Note: Some .plx files have gaps in them. This is a normal situation that 
occurs when an experiment is suspended for awhile. However, .ddt 
files cannot have gaps in them. This is why the conversion from .plx 
to .ddt can produce several .ddt files. The only place to keep times-
tamps in .ddt file is in the header, which is accurate up to one second. 
This means that a .plx to .ddt to .plx conversion can produce different 
timestamps.

5.6 Re-Ordering Files

The PlexUtil re-order function can arrange all the data blocks in a file in their 
timestamp order, from the earliest to the latest. When the file is arranged in times-
tamp order, PlexUtil can easily determine duplicate data blocks.  

To re-order a file

1 In the File Browser pane, select the file to re-order.

2 When the file opens, review the contents and make any repairs. For more 
information, see “What Repair Does” on page 199.

3 On the toolbar, click the Re-order button.

The PLX Re-order 1 of 2 - Select Output File window opens.

4 Type a path and name for the re-ordered file. PlexUtil can generate large 
temporary files during the re-order process. If there exists adequate room on 
the computer hard drive, click Use system temp directory. If the output 
directory is located on another disk drive or a server with adequate capacity, 
click Use output directory. Re-order speed is also a consideration; the local 
system temp directory is typically much faster than any remote drive. Click 
Next.
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The PLX Re-order 2 of 2 - Review Actions window opens.

5 Make sure the information is correct. Click Finish to re-order the file and close 
the re-order window. 

5.7 Merging Files

The PlexUtil merge function can merge .plx or .ddt files. A single merged .plx 
file may be created from multiple .plx files, or a single merged .ddt file from mul-
tiple .ddt files.

To merge files

1 In the File Browser pane, select one or more files to merge.

2 PlexUtil switches to the Info tab and displays a list of the files selected.
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Color codes identify the suitability of each file for the merge operation accord-
ing to the following list:

• Green = files that can be merged

• Other colors = files that cannot be merged with the green files

• Red = files that are incompatible or corrupt and they cannot be merged 
with any file

Note: To merge the files in consecutive order from top to bottom as indi-
cated in Step 4, select a file and use the Move Up and Move Down 
buttons to correctly position the file in the list. It is possible to merge 
only files of the same type; it is not possible to mix .ddt and .plx files.

3 Click the Merge button.

For selected incompatible files, the following message appears. 
Make sure all the files selected appear green in the file list.

For selected compatible files, the PLX Merge 1 of 3 - Select Merge Type 
window appears.
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4 Select the merge type:

• Merge data blocks by timestamps: Click to merge the data blocks of all 
the files in the order of their timestamps.

• Merge files consecutively in specified order (top to bottom): Click to 
concatenate files in the order established in Step 2. Enter the separation 
time for the files in the Insert _ seconds between files box.

• Merge files consecutively in chronological order using header’s 
date: Click to concatenate the files in chronological order. Enter the sepa-
ration time for the files in the Insert _ seconds between files box.

Click Next.

The PLX Merge 2 of 3 - Select Output File window opens.

5 Type the directory and file name. PlexUtil automatically adds _mrg to the file 
name. Click Next.
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The PLX Merger 3 of 3 - Review Actions window opens.

6 Make sure the information is correct and that there exists sufficient disk space 
to accommodate the new merge file. Click Finish to start the merge.

5.8 Understanding PLX and DDT Data Files

This overview section describes each data file type in detail. It also lists the pur-
pose of each PlexUtil function.

5.8.1 PLX Data Files

PLX files are Plexon data files containing action-potential (spike) timestamps 
and waveforms, event timestamps, and continuous variable data. PLX files are 
optimized for recording segments of waveforms where thresholds have been 
applied. However, low-digitizing-rate continuous channels can be saved in a .plx 
file. Some .plx utilities can be used to merge .plx files and extract portions of .plx 
data files to .ddt files.

The following illustration shows a portion of a .plx file containing the spike train 
sig001b and its accompanying waveform segments sig001b_wf together with the 
continuous variable AD01, as seen by NeuroExplorer.
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A number of different Plexon software programs can generate output in the form 
of a .plx file including Sort Client, Plexon Offline Sorter, and Plexon Recorder. 
Offline Sorter can sort spike waveforms in .plx files and they can be analyzed 
together with the continuous variables by using NeuroExplorer.

Large PLX files: When recording either digitized waveform segments, or spike 
timestamps and waveforms using the MAP box and Sort Client, .plx data files 
can sometimes grow in excess of 50 MB.

The time needed to load large .plx files into Offline Sorter can be significant. To 
reduce this time, a .plx file can be split into separate channel files (file.plx001, 
file.plx002, etc.), plus a header file (file.plx0). Then the header file can be opened 
in Offline Sorter and the individual channel files automatically open when indi-
vidual channels are selected. All the header files and channel files must be 
located in the same directory. Alternatively, the size of the .plx file size can be 
reduced by saving a subset of the channels or by saving a subset of the .plx file.

When separate files are made for each channel and a subset of channels is saved, 
PlexUtil passes the event timestamps, continuous variables, and corresponding 
spike waveforms to the destination .plx or .plx0 file.

5.8.2 DDT Data Files

The .ddt data file type is optimized for continuous (streaming) recording where 
every channel is continuously recorded without gaps and the recording includes 
any “dead time” between spikes. If many channels are recorded, .ddt files can be 
very large. The .ddt file type is appropriate for: 

• Continuous signals such as local field potentials (LFP).

http://www.plexoninc.com/OFS.htm
http://www.plexoninc.com/Recorder.htm
http://www.plexoninc.com/NEX.htm
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• Spikes when the data thresholds are changed off line.

• Custom processing methods that require continuous data.

5.9 What Scan Does

When a .plx file is opened or scanned, PlexUtil performs the following checks:

• Checks that the last timestamp corresponds to the actual data.

• Checks that PLX counters match the actual statistics.

• If the size of any data block is bigger than the size of the available data, Plex-
Util marks the data block as corrupted.

• If any data block is of unknown data type, PlexUtil marks it as corrupted.

• PlexUtil processes each type of recognized data block as follows:

— Spikes

– If the number of waveforms is negative or more than 1, PlexUtil 
marks it as corrupted.

– If a unit is negative or a block contains more than 26 units, PlexUtil 
marks it as corrupted.

– If the number of words in a waveform is negative or more than  
480, PlexUtil marks it as corrupted.

– If a channel does not correspond to any spike channel declaration in 
the header, PlexUtil marks it as orphaned.

– If a good block has a timestamp that is less than a timestamp of a 
previous block from the same channel, PlexUtil marks it as out-of-
order.

– If a good block has a timestamp that is equal to a timestamp of a 
previous block from the same channel, PlexUtil marks it as a dupli-
cate.

— Events

– If a channel is greater or equal to 261, PlexUtil marks it as cor-
rupted.

– If the number of words in a waveform is negative or more than  
480, PlexUtil marks it as corrupted.

– If a channel doesn’t correspond to any event channel declaration in 
the header, PlexUtil marks it as orphaned.

– If a good block has a timestamp that is less than a timestamp of a 
previous block from the same channel, PlexUtil marks it as out-of-
order.
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– If a good block has a timestamp that is equal to a timestamp of a 
previous block from the same channel, PlexUtil marks it as a dupli-
cate.

— Continuous

– If the number of waveforms is negative or more than 1, PlexUtil 
marks it as corrupted.

– If the number of words in a waveform is negative or more than  
1024, PlexUtil marks it as corrupted.

– If a channel doesn’t correspond to any continuous channel declara-
tion in the header, PlexUtil marks it as orphaned.

– If a good block has a timestamp that is less than a timestamp of a 
previous block from the same channel, PlexUtil marks it as out-of-
order.

– If a good block has a timestamp that is equal to a timestamp of a 
previous block from the same channel, PlexUtil marks it as a dupli-
cate.

– If a good block overlaps the data from a previous block for any 
period of time, PlexUtil marks it as overlapped.

– If there is a time gap between a good data block and a previous 
block, PlexUtil marks it as a gap.

After scanning, PlexUtil reports problems under the following headings in the 
PLX Scan - Review Results window:

• Data block errors: The total number of corrupted blocks.

• Fixable inconsistencies: Inconsistent last timestamps and inconsistent 
counters. For example, a last timestamp with a lower value than a preceding 
timestamp.

• Data block warnings: The total number of orphaned blocks.

• Miscellaneous notes:

— For spike channels:

– The total number of out-of-order blocks for each channel.

– The total number of duplicate blocks for each channel.

— For event channels:

– Total number of out-of-order blocks for each channel.

– Total number of duplicate blocks for each channel.

— For continuous channels:

– The total number of out-of-order blocks for each channel.
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– The total number of duplicate blocks for each channel.

– The total number of gaps in continuous data for each channel.

– The total number of overlaps for each channel.

5.10 What Repair Does

If PlexUtil finds any problems after scanning a file, the Review button appears in 
the top right corner. When Review is clicked, the PLX Scan - Review Results 
window opens with a list of all the problems PlexUtil found.

PlexUtil can repair some of these problems. If PlexUtil finds errors, warnings, or 
fixable inconsistencies, the Repair button appears in the PLX Scan - Review 
Results window. PlexUtil can repair all fixable inconsistencies. When Repair is 
clicked, PlexUtil creates a new copy of the file that includes the following 
repairs:

• All counters and the last timestamp are replaced with the actual values.

• All corrupted blocks are skipped and not copied to the new file.

• Repair also corrects headers and recalculates statistics.

• The file-name format for the repaired is myfile_rep.plx.
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The PlexUtil Scan and Repair functions do not repair out-of-order blocks. The 
Re-order function must be used to repair out-of-order blocks. For more informa-
tion, see “Re-Ordering Files” on page 191.

5.11 PlexUtil Output File-Name Suffixes

Each PlexUtil function creates files with unique file-name suffixes. Here is a list 
of file-name suffixes and the PlexUtil function that produces that format:

• _rep.plx = a Repaired (rep) file

• _sub.plx = a Subset (sub) of file

• _spl_cNNN.plx = a file Split (spl) by channels (c) with the numeric (N) 
sequence of each split file starting at 001

• _spl_tNNN.plx = a file Split (spl) by time (t) with the numeric (N) sequence 
of each split file starting at 001

• _spl_sNNN.plx = a file Split (spl) by file-size space (s) with the numeric (N) 
sequence of each split file starting at 001

• _spl_fNNN.plx = a file Split (spl) by frames (f) with the numeric (N) 
sequence of each split file starting at 001

• _plx_tNNN.ddt = a .plx file Converted to .ddt format with a sequential num-
ber (N) of time (t) chunks starting at 001

• _ddt_tNNN.plx = a .ddt file Converted to .plx format with a sequential num-
ber (N) of time (t) chunks starting at 001

• _rord.plx = a re-ordered (rord) file produced by the Re-order function

• _mrg.plx = a file merged (mrg) file produced by the Merge function
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6.1 Overview

Plexon Networking (PlexNet) is a unique data-transfer program that establishes 
network connections between computers (PCs) to broadcast MAP (Harvey Box) 
data in real time over a TCP/IP Ethernet network. The following illustration 
shows the general arrangement of the network.

PlexNet can do any or all of the following tasks:

1 View and analyze spike event, spike waveform, external event, field potential, 
and other analog data on multiple PCs in real time.
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2 Run data clients (GAC, PEC, GridMon, Nex, MATLAB, or other analysis 
programs) on remote PCs on the local area network (LAN).

3 Run remote clients on remote PCs.

6.2 Setup

The RASPUTIN Software installation program automatically installs PlexNet on 
the local MAP-host PC. See the installation appendix for complete information 
on installing all RASPUTIN Software components.

To use PlexNet, network connections must be set up between the local PC and 
each remote PC. To do so, PlexNet must be installed on each remote PC. If a 
RASPUTIN Software suite is installed on a remote PC, the following procedure 
is not required.

To install PlexNet on a remote PC not equipped with RASPUTIN Soft-
ware

1 At the local PC, locate PlexNet.exe. In a typical installation, the PlexNet files 
are in the following directory:

C:\Program Files\Plexon Inc\RASPUTIN Software

2 Copy the following files to a directory on each remote PC:

•  PlexNet.exe 

•  PlexNetRemote.exe 

•  PlexClient.dll 

3 Firewalls interfere with the network connections used by PlexNet. Disable 
interfering firewalls or configure the firewalls to allow each connection to a 
computer that uses PlexNet. Because this can make the network vulnerable 
through an unprotected connection, before making any changes contact the 
network administrator to determine the appropriate action for the installation.

6.3 Establishing PC-to-PC Connections

To establish PC-to-PC connections, MAP Server, Sort Client, and PlexNet must 
be running on the local PC connected to the MAP box before remote PCs may be 
connected with PlexNet. When PlexNet is started on the local PC, PlexNet auto-
matically provides the IP address of the local PC. Record this address for use at 
the remote PCs.
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To run PlexNet on the local PC connected to the MAP box (Harvey Box)

1 At the local MAP-host PC, start Sort Client.

2 On the desktop, double click the PlexNet icon.        

3 In the PlexNet window, click PlexNet is running on the PC connected 
to the Harvey Box. Click OK.

4 In the PlexNetLocal window, record the IP address and the port number of 
the local PC. For example, in the following illustration the IP address is 
192.168.37.75 and the port number is 6000.
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Note: Port 6000 is the PlexNet default value. In most cases use this value. If 
a value other than 6000 is required, click Options to open the 

Options window. Type another value in the Port field. Click OK.

HINT
If there is more than one NIC in the local PC
If there is more than one network interface card (NIC) in the local 
MAP-host PC, the PlexNetLocal window can display an alternate IP 
address instead of the IP address of the NIC connected to the local 
area network (LAN). If this occurs, try these alternatives:

• Instead of the IP address, type the PC name in Step 4 on 
page 206

• At the local PC, determine the correct IP address by using the 
Windows ipconfig command

• At the remote PC, determine the correct IP address by using 
the Windows ping command with name of the local PC

For assistance with these commands, consult the network administra-
tor.
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To run PlexNet on a remote computer

1 To start PlexNet, double click the desktop icon or double click plexnet.exe in 
its installed directory under “To install PlexNet on a remote PC not equipped 
with RASPUTIN Software” on page 203.

2 In the PlexNet window, click PlexNet is running on the remote PC. 

Click OK.

3 In the PlexNetRemote window, click Options to open the Options 
window.

4 In the Information about the PC that is connected to the Harvey 
Box area in the Options window, type the IP address recorded in Step 4 on 
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page 204 in the PC name or PC address field. Type the port number 

recorded in Step 4 on page 204 in the Port used by PlexNetLocal box.

 

In the Data transfer options area, choose the type of data to transfer and 
the channel range as follows:

• In the Data Types to Transfer area, click each type of data to transfer. 
Choose one, two, or all three types.

Note: Timestamps use very little network bandwidth. However, analog data 
and spike waveforms, especially for a large number of channels, 
require significantly more bandwidth.

• In the Spike Channel Range to Transfer area, type the channel-
range values for the data transfer in the From Channel box and To 
Channel box.

Click OK.

5 Click Connect to start data transfer. The PlexNetRemote window displays 
the following information: the packets transmitted per second and the inter-
packet interval (IPI), which appear below the Connect button. For a complete 
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explanation of the other items, see “MAP Server Main Display Window” on 
page 143.

Use the Disconnect and Connect buttons at any time without restarting 
PlexNet. However, to avoid data loss, do not disconnect while the remote 
analysis programs are running.

6 With PlexNet connected and transferring data, it is possible to run data clients 
such as GAC, PEC, GridMon, Nex, Matlab, or other analysis programs on the 
remote PC to analyze the transferred data. These data clients run as if a copy 
of MAP Server is also running on the remote PC. However, because the 
PlexNet connection is unidirectional toward the remote PC, Sort Client, Ref2, 
and other programs that send commands to the MAP box cannot be used as 
remote clients.
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7.1 Overview

This chapter describes Graphical Activity Client (GAC) v1.3.6 (01/11/05). GAC 
(gac.exe) is a Windows XP or NT application, which can be used in conjunction 
with Sort Client and MAP Server, to visually monitor neural activity on multiple 
unit channels, as well as the continuous waveforms digitized using the data acqui-
sition (DAQ) device. 

Sort Client must be used first, to sort the units, and then GAC may be started to 
monitor the activity on those channels. GAC does not record activity to a file or 
control Sort Client. GAC only presents one or more real-time scrolling views of 
the activity as it is happening. 

Each view occupies one window within the GAC workspace, and each view can 
run at a different time scale, have a different view type—see“Views” on 
page 213—and each view can be paused and unpaused independently. GAC view 
windows can be automatically tiled within the workspace and one or all the views 
can be printed without pausing the view. Essentially, GAC is a full-featured ver-
sion of the Activity Display in Sort Client.

7.2 Requirements and Installation

GAC runs on Windows XP or NT 4.0 or above with the same hardware require-
ments as Sort Client. 

If GAC was not automatically installed with RASPUTIN, GAC may be installed 
by simply creating a directory such as \gac and copying the contents of the GAC 
download to this directory. The following files must be present to run GAC:

• gac.exe

• PlexClient.dll

• plexutil.dll

Typically, PlexClient.dll has already been installed by Sort Client.

To minimize GAC latency and to update the screen smoothly, MAP Server must 
run with a fast polling rate. If necessary, GAC can operate correctly with a poll-
ing interval as long as 50 milliseconds. 

To change the polling interval

1 Before starting GAC, start MAP Server.

2 From the View menu, click Options.

3 Set the Polling interval (milliseconds) to 10.

4 Click OK. 

5 For the new polling interval to take effect, close and restart MAP Server.
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A shortcut on the desktop can be created for GAC. This is an illustration 
of the GAC desktop icon. 

7.3  Startup

To run GAC, Sort Client must be already running with an experiment file loaded. 
Double-click the desktop shortcut or double-click gac.exe in its installed direc-
tory. GAC remains blank until some activity occurs on at least one unit channel. 
The following illustration is a typical default initial view of GAC.

 

GAC displays the raw activity (spike events) on as many active channels as it can 
comfortably fit in the window. The view scrolls from right to left as new events 
appear at the right edge of the view. The arrow keys or the PAGE UP and PAGE 
DOWN keys may be used to scroll vertically through all the channels. GAC is 
like a virtual strip-chart recorder with invisible “pens” at the right edge marking 
new events as they occur.

7.4 Interface Characteristics

The GAC user interface consists of two parts: the toolbar and one or more view 
windows.

7.4.1 Views

When GAC starts, a default single-view window fills the workspace area below 
the toolbar. Spike events appear as simple tick marks. When there is only one 
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view, all tools in the toolbar apply to this view. When there is more than one view, 
the tools apply to the active view. A view can be added by clicking on a create 
view buttons. See “View Control Tools” on page 224. To close a view, click the 
close box (X) in the upper right corner. When a view is closed, GAC re-tiles the 
remaining views to fill the available space.

Many operations, such as changing the time scale, apply to the active view. To 
select a view, click on it, or use CTRL-TAB to cycle through the views. Views are 
independent. For example, changing the time scale or pausing the scrolling of one 
view does not affect the other views. The graphics in all views are updated in 
real-time, even if the view is not active.

7.4.2 Scrolling

GAC uses scrolling to update views efficiently. However, scrolling has some 
unintended behavior. For example, if another application window partly obscures 
one or more GAC views, GAC cannot draw its view correctly by scrolling. Move 
the other window away from GAC. Pressing the SPACEBAR key once can com-
pletely update all GAC views at any time. If several views are open or there are 
many channels, or both, GAC can take a fraction of a second to do a total redraw, 
although no data is lost. Do not hold down the SPACEBAR key to force GAC to 
redraw continuously.

7.4.3 Toolbar

To accommodate scrolling behavior, Plexon designed GAC for use with the tool-
bar and the keyboard, instead of pull-down menus. Long pull-down menus drop 
down into the GAC views and interfere with scrolling.

Avoid resizing and moving the individual view windows so that they overlap, 
because this can cause incorrect scrolling. It is possible to move and resize the 
windows by dragging on their borders. If the view windows overlap, clicking on 
one of the window tiling tools will restore the views to a neatly arranged layout. 
For more information, see “Miscellaneous Tools” on page 226. At least one view 
must be open; GAC prevents the last view from being deleted.

GAC is a real-time window into the activity as it is happening. It is not possible to 
scroll forwards and backwards in time, record, or replay the data. To do this, 
record the data in Sort Client and use NeuroExplorer or other programs to view 
the data off-line.

7.4.4 Menu

The GAC menu items are File, Edit, View, and Help. All GAC menus use stan-
dard interface characteristics with the exception of the Options item on the View 
menu. Options is a dynamic menu item that changes to match the active view. 
For more information on views, see “Views” on page 213.

http://www.plexoninc.com/NEX.htm
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It is possible to view and change the parameters of the active view by selecting 
the view and then clicking the Options dialog button on the toolbar. The Options 
window has three tabs: 

• The first tab changes with the selected view. 

• The second tab is Printing options. 

• The third tab is General options. The Printing and General tabs are the same 
for all views. 

For more information on the Printing and General tabs, see “Common Options” 
on page 230.

7.5 Views

GAC provides the following six distinct views, each of which appears in a sepa-
rate window in the GAC interface. See the following table for a list of matching 
view-window names, Options tab names, toolbar buttons, and button names.

To change the options for a view

1 Select the view to make it the active window.

2 From the View menu, click Options.

The Options window opens. See each view for an illustration of the window.

View window 
name

Options tab 
name

Toolbar 
button

Toolbar button 
name

raw events view Spike Ticks Add ticks graph

activity graph view Activity Add activity line 
graph

slow rate view Rate Bars Add rate graph

integrated activity 
graph view

Integrated Add burst graph

NIDAQ wave view NIDAQ Add NIDAQ graph

MMEP activity 
grid view

MMEP Add MMEP color 
activity graph
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3 Change the options in the tab that matches the view (see the preceding 
table). 

4 Close the Options window.

Each view window shows the current real-time activity in a different graphical or 
statistical manner, or both. There can be more than one view of a particular type. 
For example, activity can be shown at different time scales or with a different 
subset of channels in each window. When a view is active, any of the view adjust-
ment tools or the values in the Options window affect that view only. For exam-
ple, one view may be clicked and the toolbar used to increase the length of its 
time axis, then a different view may be clicked and the same tool used to decrease 
the length of the time axis for that view.

As each view scrolls, a vertical blue bar with a time label  will periodically 
appear. The spacing for this time grid may be set in the Options window. Also, if 
any of the keyboard event keys (ALT+1 through ALT+9) are pressed in Sort Cli-
ent, GAG draws a corresponding vertical bar in all view windows, which 
includes a time label and a bracketed digit adjacent to it, for example [7]. This 
may be used to index significant times or events in the data. Sort Client recog-
nizes keyboard events and records them in the data file, so a Sort Client window 
must be open and active when the keys are pressed to signal a keyboard event.

7.5.1 Raw Events View

When GAC starts, the raw events view window appears by default. GAC dis-
plays each channel with sorted units in Sort Client as one row, with the channel 
name on the left side. GAC shows spike events as simple tick marks, which are 
similar to the tick marks in the Sort Client Activity Display. As the display 
scrolls, blue vertical bars with time labels appear every N seconds, where N can 
be set in the Options window. 
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The following illustration shows the Options window for the raw events view. 
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7.5.2 Activity Graph View

The activity graph view window shows one graph line per channel. The height 
of the line indicates the firing rate in spikes/sec.

 

The vertical scale may 
be set by using the view 
adjustment tools or the 
Options window. The 
value for the bin size is 
the same as one pixel—
for example, if the time 
axis is 300 pixels wide 
on the screen, and the 
time axis corresponds to 
30s, each pixel repre-
sents a 100 millisecond 
bin.
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This illustration shows an 
example of bins.

7.5.3 Slow Rate View

The slow rate view window 
displays a bar graph showing 
the binned firing rate over a 
long period of time (minutes 
to hours). Whereas the other 
GAC view types create their 
graphs from the raw spike 
data, the long-term-rate view 
stores bin counts, so that very-
long periods can be monitored 
without excessive memory 
consumption. If the bin size is 
changed in the Options win-
dow, GAC deletes the exist-
ing bin counts and restarts 
from zero. Therefore, select the desired bin size before beginning long-term mon-
itoring. The following illustration shows the slow rate view window at a time set-
ting of 480 seconds.

In addition to the usual parameters, from the Options window may be set an over-
flow threshold for the bar graph. GAC displays a red bar when data exceeds that 
threshold. 
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The following illustration shows the Rate Bars tab in the Options window. 

7.5.4 Integrated Activity Graph View

The Integrated activity graph view displays two activity graphs and a set of 
burst rectangles for each channel. The green graph shows the slow-integrated 
activity for a channel. The white graph shows fast-integrated activity for a chan-
nel. The integration time constant may be set in the Options window. 
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The orange boxes in the following illustration represent detected bursts using a 
two-threshold method. 

 

The thresholds may be set by dragging the horizontal threshold lines up or down 
with the mouse, or the thresholds may be set in the Options window. The title bar 
on the Integrated activity graph view shows the current numeric values of the 
thresholds. 
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The following illustration shows the Options window with the Integrated tab.
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7.5.5 NIDAQ Wave View

The NIDAQ wave view displays up to 16 channels of continuous digitized wave-
forms from the NIDAQ device. The NIDAQ device must be installed in the PC 
and enabled in Sort Client. These channels are the “slow channels” in Sort Client, 
where the NIDAQ sampling rate can be set. A typical sampling rate for these 
channels is 1 kHz or less.
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The NI DAQ device digitizes all channels at the same rate. GAC displays the first 
N channels, where N is currently less than or equal to 16. Fewer than 16 channels 
in a NIDAQ wave view may be displayed by setting the value of max (V) in the 
Options window to a smaller number, as the following illustration shows.

In NIDAQ wave view, the baseline for each channel represents an analog input 
voltage of 0V, and the default scale represents a voltage range of -5V to +5V, 
which occupies the full height of each channel. The toolbar buttons can adjust the 
appearance and time scale of a NIDAQ wave view. For example, the Scale up 
and Scale down buttons can adjust the voltage scaling.

If the NIDAQ channels are scaled up using the Scale up button, a horizontal grid 
appears on each channel with vertical scaling labels. This grid indicates the volt-
age scaling and allows rough visual measurements of waveform voltages to be 
made. Use More scale ticks and Less scale ticks to increase or decrease the fine-
ness of the grid. Set the spacing of the labels at the left end of the grid with the 
NIDAQ scale increment (V) field in the Options window. If no labels are visible, 
make the channels taller, or decrease the number of ticks, or both.

The NIDAQ wave view can be memory and processor-intensive. Although any 
NIDAQ sampling rate may be set in Sort Client up to the limits of the NI DAQ 
device, GAC currently supports sampling rates of no more than 1 kHz in order to 
reduce the CPU load. If the application requires somewhat higher sampling rates, 
please contact Plexon support. However, the NIDAQ wave view does not cur-
rently support MAP-grade sampling rates (e.g. 40 kHz).
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7.5.6 MMEP Activity Grid View

For a 64-DSP channel system, the MMEP activity grid view displays a four-row 
by sixteen-column grid of colored squares that can be arranged to match the pat-
tern of the electrodes on a multi-microelectrode plate (MMEP). The color of each 
square represents the activity on the corresponding SIG channel, where blue rep-
resents no activity and red represents maximum activity.

 

As the following illustration shows, from the toolbar or from the Options win-
dow, it is possible to set the maximum activity scaling and the bin width that 
GAC uses to calculate the activity.
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7.6 Toolbar

The complete GAC tool bar contains the following buttons:

7.6.1 Printing Tools

GAC provides four printing tools. The buttons are all grouped 
together on the toolbar.

 Print view prints the active view. Shortcut: press the p key—not 
CTRL-P, just p.

 Print all prints all views, one view per page.

 Auto-print prints the active view every N seconds, where N is the setting 
in the Options window. Click Auto-print to toggle auto-print mode on or 
off. If a different view is activated after starting auto-printing, the original 

view that was active when Auto-print was clicked automatically prints.

 Page setup sets margins and paper orientation (landscape or portrait). 
The default orientation is landscape.

7.6.2 View Control Tools

GAC provides four view-control tools. The buttons are grouped 
together on the toolbar.

 Go un-pauses the active view. GAC does not display any activity in this 
view since the preceding pause.

 Pause pauses the scrolling of the active view. Any activity in the view is 
frozen until Go is clicked. GAC draws a red vertical bar across all chan-
nels in the active view, with a time label, to indicate that a pause occurred.

 Go all un-pauses all paused views.

 Pause all pauses the scrolling of all views. GAC draws a red vertical bar 
across all channels of all views, with time labels, to indicate that a pause 
has occurred. Go can then un-pause views one at a time, or Go all can 

simultaneously un-pause all paused views.

7.6.3 View Creation Tools

GAC provides six view-creation tools. The buttons are 
grouped together on the toolbar.

 Add ticks graph opens a new raw events view window that displays 
raw spike events as tick marks.

 Add activity line graph opens a new activity graph view window that 
displays activity rates as a line graph.
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 Add rate graph opens a new slow rate view window that displays activ-
ity rates over long periods of time as a bar graph.

 Add burst graph opens a new integrated activity graph window that 
displays integrated activity using specified time constants and bursts 
detected using a two-threshold method. It is possible to display any com-

bination of fast and slow integration graphs or bursts, or both. For more informa-
tion, see “Burst Detection In the Integrated Activity Graph View” on page 236.

 Add NIDAQ graph opens a new NIDAQ wave view that displays up to 
16 channels of continuous waveforms from the NI DAQ device.

 Add MMEP color activity graph opens new MMEP activity grid view 
windows that display activity at each electrode of an MMEP as a color from blue, 
which represents no activity, to red, which represents maximum activity. The 
squares in the grid equal the number of DSP channels available in the MAP box.

7.6.4 View Adjustment Tools

GAC provides 11 view-adjustment 
tools. The buttons are grouped 
together on the toolbar.

Note: These tools have slightly different interpretations when used with the MMEP 
activity grid view, as opposed to the various line views. See the note follow-
ing each tool description.

 Scale up increases the height of graphs in the active view, without chang-
ing the number of channels per screen.

Note: In the MMEP activity view, Scale up scales the colors towards red 
and away from blue.

 Scale down decreases the height of graphs in the active view, without 
changing the number of channels per screen.

Note: In the MMEP activity view, Scale down scales the colors towards 
blue and away from red.

 Make channels taller displays fewer channels per screen in the active 
view, each one taller.

Note: In the MMEP activity view, Makes channels taller makes the col-
ored squares larger, with less empty space between them.

 Make channels shorter displays more channels per screen in the active 
view, each one shorter.

Note: In the MMEP activity view, Make channels shorter makes the col-
ored squares smaller, with more empty space between them.
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 Longer time scale extends the time scale of the active view. Graphs 
appear more compressed and scroll more slowly.

Note: In the MMEP activity view, Longer time scale increases the width of 
the bin used to calculate the colors. Colors vary more slowly and 
smoothly, at the expense of missing rapid fluctuations in activity.

 Shorter Time Scale reduces the time scale of the active view. Graphs 
appear more stretched out and scroll more rapidly.

Note: In the MMEP activity view, Shorter Time Scale decreases the width 
of the bin used to calculate the colors. Colors vary more rapidly. The 
minimum bin width is 32 milliseconds.

 Less scale ticks increases the spacing of tick marks on the y-axis scale at 
the left side of channel graphs, that is, the increment between scale ticks is 
larger. This button only effects the NIDAQ wave view window.

 More scale ticks decreases the spacing of tick marks on the y-axis scale 
at the left side of channel graphs, that is, the increment between scale 
ticks is smaller. This button only effects the NIDAQ wave view window.

 Reset views time to 0 immediately resets the time scale on all views to 
0:00. This only affects the labeling of the time axis.

 Toggle event display turns the display of event markers on or off.

 Toggle burst display turns the display of burst markers on or off. This 
button only effects the integrated activity graph view window.

Many display parameters may also be numerically set with the Options window. 
It is possible to view and change the parameters for the active view by selecting 
the view and then clicking the Options dialog button on the toolbar. It is also 
possible to modify the parameters for the active view, while the other views 
remain unchanged. The changes made with the toolbar buttons are also reflected 
in the Options window. For more information, see “Common Options” on 
page 230. 

7.6.5 Miscellaneous Tools

GAC provides nine miscellaneous tools, 
which are grouped together on the toolbar.

 Update unit channels automatically inserts any new unit channels to all 
views except NIDAQ, and deletes any unit channels that are no longer 
present in Sort Client. GAC briefly pauses and then un-pauses all chan-

nels as it updates the list of channels.

 Select chans displays a window to add or delete one or more unit chan-
nels from the set displayed in the active view. GAC automatically pauses 
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all views the window is opened, and un-pauses them when the window is closed.

 Options dialog displays a window that to set various parameters for the 
active view, or to change the active view from one type of view to another 
type of view.

 Tile in rows: If there are two or more views, Tile in rows causes them to 
be tiled one above another.

 Tile in columns: If there are two or more views, Tile in columns causes 
them to be tiled left to right.

 Tile in grid: If there are two or more views, Tile in grid causes them to 
be tiled in a rectangular grid.

 Always on top keeps the window for the GAC application on top of all 
other applications. Click a second time to return GAC to normal.

 Page up scrolls the active view up one page, the same as the PAGE UP 
key. 

 Page down scrolls the active view down one page, the same as the PAGE 
DOWN key. 

Note: The PAGE UP, PAGE DOWN, HOME, END, UP ARROW, and DOWN 
ARROW keys on the keyboard may be used to scroll vertically 
through all the channels. For performance reasons, GAC does not 
use the standard Windows scroll bars.

7.6.6 Saving and Loading GAC Configurations

GAC provides two configuration management tools. The buttons are 
grouped together on the toolbar.

 Load configuration loads a GAC configuration file. A GAC configura-
tion file saves the position and size of the GAC main window and of all 
the other view windows. It also saves the parameters for each view, such 

as time scale, channel height, thresholds, time constants, etc. The GAC file also 
includes the Printing and General options. See “Common Options” on 
page 230. It does not save the channel lists for each view. Instead, GAC loads the 
list of sorted channels that are in effect in Sort Client when the configuration 
loads. When GAC loads a configuration, GAC removes any views on the screen 
and creates and activates the set of views saved in the file. Configurations may be 
loaded and saved at any time.

 Save configuration saves a GAC configuration file, which is described 
under “Load configuration” earlier in this section. Configuration files 
have the extension .gac and they are plain text files. 

Note: A .gac file is not a recording file that saves timestamps or other MAP data; it is 
a collection of parameters that controls how GAC displays data from the MAP 
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box. It is possible to record the actual MAP data using the Sort Client's .plx 
files.
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7.7 Adding and Deleting Unit Channels From a View

By default, when a view in GAC is added, the view displays all the channels that 
have sorted units from Sort Client. If there are more channels than the view win-
dow can hold, it is possible to scroll through them, to make the channels shorter 
so more of them can fit in the view, or both. However, to view just a subset of the 
available unit channels, select the view and click Select chans on the toolbar to 
open the channel Dialog window.

 

GAC lists all units that are currently sorted in Sort Client in the list box. Use the 
scroll bar to view all the channels. Highlighted channels display in the active 
view. By default, GAC selects all of the sorted unit channels. Click a channel 
name to deselect it. Click a deselected channel name to select it. It is not neces-
sary to hold down CTRL or any other key to select or deselect channels. 

The Dialog window contains the following buttons:

• Select All selects every unit channel.

• Deselect All deselects every unit channel. To select just a few channels, just 
click on Deselect All and then click on the desired individual channels.
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• Invert Selection deselects all selected channels and selects all deselected 
channels.

• OK accepts the currently selected unit channels to display in the active view.

The unit channel selections may always be changed later, for example, if units are 
added or deleted in Sort Client. One can do this either by clicking Select Chans 
and editing the list of channels using the Dialog window, or by clicking Update 
unit channels, which adds all newly-sorted units and deletes all units that are no 
longer present in Sort Client. Update unit channels is the quickest way to ensure 
that all the currently sorted units are visible. If the sorted units have not changed, 
Update unit chans has no effect.

Note: A NIDAQ view shows the first N channels (N <= 16) of continuous waveform 
channels. By default, GAC displays all 16 channels, but it is possible to choose 
fewer channels in the NIDAQ wave view Options window.

7.8 Common Options

Options is a dynamic menu item that changes to match the active view. This sec-
tion describes the options that are common to all views. It is possible to view and 
change the parameters for the active view by selecting the view and then clicking 
the Options dialog button on the toolbar. The Options window has three tabs: 

• The first (topmost) tab changes with the selected view.

• The second tab is Printing options.

• The third tab is General options. The Printing and General tabs are the same 
for all views.
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7.8.1 General Options

The General tab may be used to view and edit several general options such as 
memory usage, views, and miscellaneous interactive behavior. 
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7.8.1.1 Time Display Area

The Time display area contains the following controls to format the time labels 
in the GAC views:

• start GAC at 0:00: This is the default time format. The first time label is 
0:00 (0 hours, 0 minutes), regardless of how long the MAP box has been run-
ning before GAC is started. In other words, this format is “time since GAC 
started.” 

• start GAC at 0:00, reset at start of recording: This is the same format as 
above, except the time is reset to 0:00 whenever Sort Client starts recording a 
.plx file. Each time a new recording is started, GAC resets the time again to 
0:00; GAC displays times to the left of 0:00 in all views as negative times. 
This format is essentially “time since Sort Client started its most recent 
recording.”

• display time since MAP reset: This format displays the time since the MAP 
box internal timestamp clock has been reset to zero. This reset occurs when 
the MAP is first powered up, and whenever Start is clicked in Sort Client 
after loading an experiment file.

When the time display mode is changed and OK is clicked to close the window, 
GAC displays the time labels in all views in the chosen format.

Note: IMPORTANT! Internally, the MAP box, Sort Client, and GAC use an integer 
counter to mark time. This counter rolls over (wraps around through zero) 
approximately every 29 hours. GAC does not currently compensate for this roll-
over. The only situation where this would be a problem is when the MAP box 
has been running without a reset (that is, when a new experiment file is loaded) 
for less than 29 hours, but passes the 29 hour mark while GAC is running. As a 
workaround, the current GAC setup may be saved to a .gac file, close GAC, 
restart GAC, and load the saved configuration. The wraparound causes no 
problem with the saved configuration.

7.8.1.2 New View Defaults

The New view defaults area contains the controls that determine the length of the 
time axis for each view as it is created:

• use same time range as last view: When this control is selected and a new 
view is added, the new view inherits the same length of time axis as the view 
that is currently active. For example, if there is one view whose time axis is 
60 seconds long, each subsequently added view also inherits a time axis that 
is 60 seconds long.

• use default time range: By default, a view displays 30 seconds of activity. 
This default may be changed to a longer or a shorter time. GAC saves this 
default time, like all the other values and options in the Options window, to 
.gac configuration file which may be loaded at a later time.
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7.8.1.3 Startup Defaults

The controls in the Startup defaults (must restart to take effect) area control 
the amount of memory allocated by GAC for its internal buffers. These values 
should not be changed without good reason, because, if inappropriate values are 
selected, GAC could be rendered unusable. GAC saves the following values in 
the Windows Registry, not in the configuration file, and they do not take effect 
until GAC is closed and restarted:

• max timestamps per unit chan: GAC allocates one timestamp buffer per 
active unit channel (e.g. DSP14c). The amount of activity this buffer stores is 
directly proportional to the average firing frequency of the unit on this chan-
nel. For example, the default is 30 500, which corresponds to 30 seconds of 
activity at a constant 1 kHz, 5 minutes at an average rate of 100 Hz, 10 min-
utes at an average of 50 Hz, etc. The extra 500 timestamps (30 500 vs 30 000) 
results from extra internal buffering done by GAC. Below the control, GAC 
displays the amount of RAM needed for the specified number of timestamps, 
multiplied by the number of active unit channels. The memory used value is 
updated as the number of timestamps changes.

• max rate bins per unit chan: GAC allocates a long-term rate buffer for each 
active unit channel. Each entry in the buffer holds the count for one “rate 
bin.” By default, a rate bin counts the activity for an interval of 10 seconds. 
Thus, if the rate buffer is 360 bins long, the long-term rate “sees” display-rate 
information for the preceding 360 X 10 seconds = 3600 seconds = 1 hour. 
Unlike the other view types, GAC does not generate the slow rate view 
directly from the raw timestamp data. Instead, GAC bins and stores the times-
tamp data in the rate bin buffer, from which it derives the bar graph. This is 
due to the huge amount of RAM that would be required to store the raw 
timestamps for hours of activity. Below the control, GAC displays the amount 
of RAM needed for the specified number of rate bins, multiplied by the num-
ber of active unit channels. GAC updates the memory used value as the num-
ber of bins changes.

• max NIDAQ time (secs): GAC allocates a sample buffer for each enabled 
NIDAQ channel. Depending on the NIDAQ sampling rate, which is usually 
1 kHz or less for our purposes, digitized continuous data can quickly take up 
very large amounts of RAM. If a low sampling rate is selected, it may be pos-
sible to increase the maximum buffered NIDAQ time above the default. 
Although the samples from the supported NIDAQ device are 12 bits wide, 
they are stored as 16-bit words, so each NIDAQ channel requires RAM equal 
to the total time multiplied by the sampling rate multiplied by 2 bytes per 
sample. Below the control, GAC displays the total amount of RAM used by 
all the NIDAQ channels. GAC updates the memory used value as the maxi-
mum time changes.

At the bottom of the Startup defaults area, GAC displays a value for the overall 
total memory used, which includes timestamps, rate bins, and NIDAQ samples. 
This value is very close to the total memory GAC uses.
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7.8.1.4 Miscellaneous

The bottom area contains the following miscellaneous items:

• display rate (frames/sec):  Updating the screen frequently enough to give 
the illusion of continuous motion provides the smooth scrolling of views in 
GAC. This is similar to television (30 frames per second) or movies (24 
frames per second). Below a certain update rate, around 10-15 frames per sec-
ond, the scrolling starts to become jerky. However, higher update rates sub-
stantially increase the load on the computer and video card. If the computer is 
very slow, or if it is loaded down with other running applications (e.g. com-
pute-intensive recalculations in NeuroExplorer or MATLAB) to where perfor-
mance is an issue, the GAC display rate may need to be reduced.

• pause views when this dialog is up: By default, when the Options window is 
opened, GAC pauses all views and then un-pauses them when clicking OK or 
Cancel, because views cannot be scrolled efficiently with a dialog window 
open. However, this has the side-effect of not displaying the data for the inter-
val when the dialog window is open, even after the dialog box is closed. If the 
temporarily incorrect scrolling while the dialog window is open is preferred, 
click to clear the pause views when this dialog is up option.

• auto-tile views: By default, GAC automatically tiles the view windows as 
either rows (the default), columns, or in a rectangular grid. Regardless of the 
arrangement, GAC maintains the tiled layout when moving or resizing the 
main window, and GAC updates the layout as new views are added or views 
are closed. GAC thus ensures that all views are always visible, are of equal 
sizes, and do not overlap. However, it is possible to move and resize the indi-
vidual view windows to a custom arrangement. For example, there may be 
one large view with two smaller views adjacent to it. If this is done with auto-
tile enabled, as soon as the main window is resized, all the views snap back to 
their automatically laid out positions. To prevent this automatic tiling, click to 
clear the auto-tile views check box. With auto-tiling disabled, it is still possi-
ble to obtain neat tiling by clicking on one of the tiling buttons, but the views 
remain in their relative positions no matter what happens to the main window. 
Also, when auto-tiling is disabled, new views pop up on top of existing views. 
In many cases this causes the scrolling views underneath the new view to dis-
play incorrectly, and the views must be manually adjusted so that they do not 
overlap, or click a tiling button to tile them. 

http://www.plexoninc.com/NEX.htm
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7.8.2 Printing options

The Printing Options tab can control the appearance of views when printing 
them. These following options apply to all views:

 

• auto-print interval: This option sets the time interval for automatic printing. 
All views use the same auto-print interval.
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• ... width: The width options determine the line widths used to print various 
elements of the graphs, such as the vertical time-grid lines, the fast and slow 
graphs in the integrated view, the NIDAQ waveforms, etc. The default value 
is 0.004 inches, which is equivalent to a resolution of 250 dots per inch (dpi). 
This value ensures that the lines do not become too thin, even on high-resolu-
tion printers (1200 dpi). To make the corresponding graph element bolder, 
increase the line width value.

• check boxes: The user may omit some graph elements (axes, grids, borders) 
from the printed output by clicking to clear the corresponding checkbox.

7.9 Type Specific Options

The top tab in the Options window displays the options for the type of view 
selected when the window was opened. Most graphs have options for time scale 
length, time grid interval, channel height, and maximum graph value. Some 
graphs have additional options, which depend on the view type. Some parameters 
are available in the Options window that are not accessible through the toolbar, 
e.g. the time grid increment and the time constants and burst thresholds. Others, 
such as graph maximum value, can be adjusted with the toolbar buttons, or by 
specifying a value in the Options window.

Note: While the Options window is open, GAC pauses all views, and GAC automati-
cally unpauses when the window is closed. This behavior may be disabled in 
the General options tab.

7.10 Burst Detection In the Integrated Activity Graph View

Type the s key to toggle the display of the slow integration graph. Type the f key 
to toggle the display of the fast integration graph. Type the b key to toggle display 
of the detected bursts. It is possible to view any combination of slow or fast 
graphs, or bursts, or all three. For viewing the fast graph only, the user can scale 
up the graphs to improve the view over the slow graph. When inspecting and 
adjusting bursts, the user can increase the size of the channels considerably to 
allow easier manipulation.

The user can directly adjust the upper or lower thresholds by dragging them. The 
top of the orange burst rectangle represents the slow threshold. The horizontal 
orange line within the rectangle represents the fast threshold. Dragging either one 
of these lines adjusts the threshold in real time, and the number and sizes of bursts 
change correspondingly. GAC only looks at the Y coordinate while dragging; it is 
not necessary to begin or remain on a visible threshold bar (orange), although it 
can be more intuitive to do so.

GAC displays the value of the new threshold in real time in the window title bar. 
If the fast (lower) threshold is not visible, it is probably close to the zero baseline. 
Try pointing the mouse at or just above the baseline and dragging upward. If no 
bursts are visible, it is always possible to bring up the Options window and spec-
ify either threshold numerically. GAC applies the fast and slow thresholds to all 
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channels in the same integrated/burst view; however, different views can have 
different thresholds.

The two thresholds that are currently used to define bursts use a simple algorithm 
as follows. A burst is defined as a time interval in which the slow integration 
curve remains entirely above the slow threshold and the fast integration curve 
remains entirely above the fast threshold.

Note: GAC prints whichever combination of fast and slow graphs and burst rectan-
gles that are seen on screen.

7.11 Caveats

There must be an experiment file loaded and started in Sort Client before GAC is 
started. If a different experiment file is loaded in Sort Client after starting GAC, 
the next experiment file resets the clock in the MAP box while GAC is in the 
middle of acquiring data from it. It is possible to work around this by closing 
GAC before loading the new experiment file in Sort Client and restarting GAC 
after the file has been loaded and started. If the layout and parameters of the cur-
rent views need to be preserved, save a configuration (.gac) file before closing 
GAC and reload that configuration after restarting GAC.

If there is not any unit activity occurring when GAC starts up, nothing appears in 
the initial view until some activity occurs; one spike is sufficient activity. When 
GAC sees some initial activity, it does not matter whether there are pauses in the 
activity on any or all channels.

GAC does not recognize the 29-hour wraparound of MAP timestamps. If GAC is 
running and the MAP box has also been running continuously without a reset or 
without loading a new experiment file for 29 hours, GAC must be shut down and 
restarted after the wraparound has occurred. Contact Plexon for assistance if run-
ning experiments longer than one day in continuous duration.

On some systems, GAC cannot display every timestamp after approximately 
45 minutes to 1 hour of continuous operation. If this occurs, close and restart 
GAC.

The GAC NIDAQ view is intended to view slowly varying waveforms that are 
digitized at a low sampling rate, typically 1kHz or less. If the waveform being 



viewed has a short period relative to the width of the time axis, there can be some 
aliasing in the displayed waveform. If the default 30-second time scale is used, 
with waveforms whose lowest frequency component is less than 5 Hz, aliasing is 
not a problem. If aliasing is visible, shorten the time scale until the aliasing is elim-
inated.
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8.1 PeriEvent Client Overview

This chapter provides information on PeriEvent Client (PEC) v1.2.6 (01/11/05). 
PEC (pec.exe) is a Windows application used in conjunction with Sort Client to 
visually display perievent histograms in real-time. When an event occurs, PEC 
automatically updates its displays immediately on the specified event channel, as 
opposed to every N seconds in the peristimulus time (PST) histograms in Neu-
roExplorer. PEC also displays perievent rasters for a specified number of previ-
ous trials beneath the PST histogram. Think of PEC as an “event triggered” 
display.

Sort Client must be used first to discriminate the desired units, and then PEC can 
be started to monitor the peri-event activity on those channels. There must be an 
external event source, because PEC only displays peri-event activity.

8.2 Requirements and Installation

PEC runs on Windows XP or NT 4.0 or later with the same hardware require-
ments as Sort Client. If PEC has not automatically installed, one may install PEC 
by creating a directory such as \pec and copying the contents of the PEC files to 
this directory. One can also put it in the directory where the other Plexon applica-
tions are located, such as \rasputin.

A shortcut on the desktop for PEC can be created. This is an illustration 
of the PEC desktop icon.

8.3 Startup

Make sure that Sort Client is already running with an experiment file loaded. To 
run PEC, double-click the desktop icon or the pec.exe file in the directory where 
it is installed. 

http://www.plexoninc.com/NEX.htm
http://www.plexoninc.com/NEX.htm
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On startup, PEC displays the Select Unit Channels window, where selection can 
be made for the unit channels on which to observe peri-event activity.

All units that are currently sorted in Sort Client appear in the list box; scroll to see 
all the channels. By default PEC, selects all of the unit channels. Click on a chan-
nel name to select a channel. Click on a selected channel to deselect the channel. 
It is not necessary to hold down CTRL or any other key to select or deselect. The 
four buttons perform the following functions:

Select All: Click to select every unit channel.

Deselect All: Click to deselect every unit channel. To select just a few channels, 
just click Deselect All and then click the desired individual channels.

Invert Selection: Click to deselect all selected channels and simultaneously 
select all deselected channels.

OK: Click to accept the currently selected unit channels as the active view.

The unit channel selections may always be changed later, for example, if units are 
added or deleted in Sort Client. For more information, see “Add/delete new chan-
nels:” on page 242.
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To set up a simple display using PEC, click Deselect All, then click on a few unit 
channels to display. Click OK to view these channels in the main display. After a 
few external events and some unit activity have occurred, the PEC window typi-
cally looks like the following illustration:

Each graph represents one of the sorted unit channels selected, with the channel 
name in the lower right corner. The PST histogram for the channel is displayed at 
the top, with the peri-event rasters below it. The red vertical line represents the 
time when the event occurred. Pre-event activity is to the left (blue bars) and 
post-event activity is to the right (green bars). PEC displays the most recent peri-
event raster at the top, and as new events occur, the rasters scroll down one row.

8.4 Toolbar

To control PEC functions, click on the toolbar buttons or change the values in the 
Options window. The following illustration shows a section of the PEC toolbar.

 

Note: The buttons that appear to the left of the preceding ones are not functional for 
this release of PeriEvent Client.

 Zero bin counts: Click to reset all PST histogram bin counts to zero. 
Peri-event rasters are unaffected.

 Go: Click to un-pause the PEC display. PEC updates its displays each 
time an external event occurs.
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 Pause: Click to pause the PEC display. PEC ignores any subsequent 
external events and unit activity until Go is clicked. When PEC is paused, 
one can toggle between multi-channel view and single-channel view. For 

more information, see the following button descriptions.

 Multi-channel view: Click to display all the selected unit channel 
graphs in a grid of rows and columns. In the multi-channel view, one can 
change to a zoomed view of a single channel by double-clicking on that 

channel. Click on the multi-channel button to return to the multi-channel view.

 Single-channel view: Click to display a single-unit channel graph, 
which enlarges to fill the PEC window. This button is active only when 
the view is changed from a single-channel view to a multi-channel view. 

Click on the single-channel button to return to the zoomed view of the channel.

 View PSTH and rasters: The default channel graph shows both a PST 
histogram and the channel rasters. If only the PSTH or only the rasters are 
visible, click this button to display both the PSTH and the rasters.

 View rasters only: Click to display only the peri-event rasters, which 
fits more rows of rasters in the window.

 View PSTH only: Click to display only the PST histograms, which dis-
plays the bar graph at a larger size.

 Scale PSTH bars up: If activity is low, click this button to scale up the 
bars, that is, to decrease the graph maximum value.

 Scale PSTH bars down: If activity is high, click this button to scale 
down the bars and increase the maximum value for the graph. When a bar 
overflows the maximum value for the graph, it is possible to control 

whether the bars are automatically rescaled, or the bin counts are reset to zero, by 
using the Options window. For more information, see “Options Window” on 
page 243.

 Show more columns: By default, PEC shows an approximately equal 
number of rows and columns of channel graphs. Click this button to add 
one additional column of graphs only to the multi-channel view.

 Show fewer columns: By default, PEC shows an approximately equal 
number of rows and columns of channel graphs. Click this button to 
remove one additional column of graphs only to the multi-channel view. 

 Show more rows: By default, PEC shows an approximately equal num-
ber of rows and columns of channel graphs. Click this button to add one 
additional row of graphs only to the multi-channel view. 
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 Show fewer rows: By default, PEC shows an approximately equal num-
ber of rows and columns of channel graphs. Click this button to remove 
one additional row of graphs only to the multi-channel view. 

 Add/delete new channels: Click to add channel graphs for all newly-
sorted units and delete channel graphs for all units that are no longer 
present in Sort Client. Add/Delete New Channels is the quickest way to 

insure that all the currently sorted units are visible. If there is no change in sorted 
units, Add/Delete New Channels does nothing. 

 Select unit channels: Click to display the Select Unit Channels win-
dow to manually select which sorted unit channels to monitor. This is the 
same window that appears when PEC is started; for more information, see 

“Startup” on page 238. When OK is clicked in the Select Unit Channels win-
dow, PEC updates the display to show the channel graphs only for the selected 
units.

 Options dialog: Click to display the Options window, where the user 
can set the pre-event and post-event times, bin width, event channel, etc. 
It is also possible to use the toolbar buttons, or the items may be numeri-

cally set in the Options window. Any changes made with the toolbar appear in 
the Options window. For more information, see “Options Window” on page 243.

By default, PEC displays a multichannel view with all the selected sorted-unit 
channels displayed in a grid of channel graphs. To view any channel in detail, 
double-click the channel graph to have PEC redraw the channel graph so that it 
fills the PEC display.
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In the multichannel view, PEC draws the PSTH graph with scale and bin time 
labels. PEC labels each peri-event raster with the time in minutes, seconds, and 
hundredths of a second. The peri-event rasters scroll down one row each time an 
external event occurs, just as in the multi-channel view.

Click on the Multi-channel view button to return to the multi-channel view. In 
the multi-channel view, it is possible to switch back to the single-channel view of 
a channel by clicking on the Single-channel view button, or to view any other 
single channel by double-clicking directly on the channel graph.

8.5 Options Window

In the Options window, the values for the parameters for the PSTH and peri-
event rasters may be set. The following illustration shows the Options window.

8.5.1 Main

The following settings control what appears in the PEC main window:

individual TTL pulses: Click to select individual pulses as the event marker and 
then select the channel number in the primary reference event chan box. This 



8 PeriEvent Client 

244 RASPUTIN Software

number is the event channel for PSTH histograms and peri-event rasters. All unit 
channels are referenced against this event channel. The vertical red line in each 
channel display shows the time when the reference event occurs.

strobed data word: Click to select a strobed word as the event marker and then 
select its value in the data word value box. 

strobed bit position: Click to select a strobed bit as the event marker and then 
set its position in the bit position box. If this bit is the only even bit, click only 
this bit. 

pre-event time: Select the time interval to display preceding each external event.

post-event time: Select the time interval to display following each external 
event.

bin width: Select the width of each bin (graph bar) in the PST histogram.

max trials: Select the maximum number of trials (peri-event rasters) to display 
for each channel. The user can further limit the number of peri-event rasters visi-
ble for each channel by specifying the sizes for each raster and the spacing 
between rasters. For more information, see “Layout” on page 245.

update time: Select the time interval to dynamically update the graphs. For more 
information, see “Dynamic Updating of Graphs and Events” on page 246.

display all times in milliseconds: Click to show pre- and post-event times, bin 
times, etc., in units of milliseconds. In milliseconds, the smallest bin width that 
can be selected is one millisecond, which corresponds to one MAP clock tick at a 
40 kHz sampling rate.

display all times in microseconds: Click to show pre- and post-event times, bin 
times, etc., in units of microseconds. In microseconds, the smallest bin width that 
can be selected is 25 microseconds, which corresponds to one MAP clock tick at 
a 40 kHz sampling rate.

8.5.2 PSTH scale/reset

Use the following items to set the vertical scale of the PSTH bar graphs:

auto-reset bin counts on start of recording: Click to automatically clear all 
channel bin counts each time recording begins in Sort Client.

auto-reset bin counts on overflow: Click to automatically clear all channel bin 
counts whenever any bar for any channel exceeds the current maximum.

auto-rescale PSTH on overflow: Click to automatically double the PSTH bar 
maximum whenever any bar for any channel exceeds the current maximum. This 
insures that the bar graphs always fit, no matter how large the bin counts get.
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manual PSTH scaling: Click to use a fixed graph maximum set in the PSTH 
maximum field (see next item). If any bars overflow this maximum value, they 
appear in red. To manually clear the bin counts, click the Zero bin counts button.

PSTH maximum: Select the maximum bin count for the bars in the PST histo-
gram. This value only takes effect when manual PSTH scaling is selected.

total spikes per bin: Click to have each bar in the PSTH indicate the total num-
ber of spikes in that bin. The bins grow as there are more trials and spikes, unless 
one of the auto-scale or auto-reset options is selected.

spikes per bin averaged over trials: Click to have each bar in the PSTH indi-
cate the total number of spikes in that bin, which is divided by the total number of 
trials. The bar height indicates the average number of spikes in the bin, over all 
trials.

spikes per sec averaged over trials: Click to have each bar in the PSTH indicate 
the total number of spikes in that bin, divided by the total number of trials and the 
bin width. The bar height indicates the average firing rate (frequency) in that bin, 
over all trials.

8.5.3 Layout

auto-size raster rows to fit: Click this item to automatically shrink the height 
and spacing of peri-event rasters as necessary to fit the specified number of trials 
into the graph. 

Note: This layout feature is not implemented in this release.

fixed raster row spacing: Click to use the values specified in the following 
boxes for spacing between rows and raster height.

* spacing between rows: Select the number of pixels to place between two suc-
cessive rows of peri-event rasters.

* raster height: Select the height in pixels of each peri-event raster. A value of 1 
shows rasters as rows of dots; larger values show rasters as ticks of increasing 
height.

show raster centerline (single chan view): Click to have PEC draw a horizontal 
line through each row of raster-spike tick marks. Otherwise, PEC draws only the 
rasters. PEC does not draw the horizontal line in the multichannel view because 
there is not enough room for the line and the line clutters the display.

bins per label: Select the spacing of the labels along the x-axis (time scale) of 
the PSTH bar graph in single-channel view. For example, if 4 bins per label for a 
bin width of 25 milliseconds is specified, post-event bin labels appear at 0, 100, 
200, 300, … milliseconds, as well as pre-event labels at -100, -200, … millisec-
onds. This option does not apply to the multichannel view, because the channel 
displays are too small to draw bin labels.
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* font size (points): Select the font size in points for the text of the label channel 
names, event times, bins, etc.

Note: The user can set the parameters marked with an asterisk * separately for the 
multichannel view and the single-channel view. If the Options window is 
opened while in multichannel view, the parameters for that view are visible and 
can be changed. The same is true for the single-channel view. For example, it 
is possible to set a font size of 6 points for the multichannel view and a larger 
10-point font size for the detailed single-channel view.

8.6 Dynamic Updating of Graphs and Events

PEC updates all its graphs each time that an external event occurs. Events occur 
on the channel specified in the Options window, which by default is event chan-
nel 2 connected to the XS2 BNC connector. However, after the event occurs, PEC 
must also display the post-event activity. The user can control how quickly and 
smoothly PEC draws in the post-event activity by specifying the update-time 
value in the Options window. For example, the default value of 200 milliseconds 
(5 Hz) means that every 200 milliseconds after an event occurs, PEC draws in 
200 milliseconds of post-event activity, until the specified post-event time has 
elapsed. It also means that there is up to a 200-millisecond lag between the event 
occurring and the first post-event activity being drawn.

For most uses, the 200-millisecond update time is a reasonable balance between 
immediate, real-time display of the post-event activity, and the additional pro-
cessing time required to frequently update the display. On a fast PC, this time 
could be reduced to as low as 50 milliseconds (20 Hz) to provide the smoothest 
possible display. If the fastest updates and minimum latency are required , make 
sure the MAP Server polling time is set as low as possible (10 milliseconds). For 
more information, see “View > Options” on page 148.

If the external event occurs frequently (faster than 1 Hz), make sure that the 
update time is fast enough that the display can keep up. If the update rate is too 
slow, PEC prompts with a warning that it should be reduced. A general rule of 
thumb is that the update time should be no more than half the interval between 
external events. For example, if events are occurring at a maximum rate of 2 Hz 
(500 milliseconds), set the update time to less than 250 milliseconds. An update 
time of one-fourth the minimum event interval provides optimal display updat-
ing. Thus, if the update time is set to 50 milliseconds, PEC displays events occur-
ring at a rate of at least 5 Hz. If it is necessary to display events that occur at a rate 
greater than 5 Hz, contact Plexon.

8.7 Saving and Loading PEC Configurations

PEC does not use a configuration file. When PEC starts, it recalls the settings that 
were last in use, including window size and position, and all the settings in the 
Options window. When PEC closes, it automatically saves all the settings. The 
first time PEC runs, it uses default values for all settings.
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9.1 GridMon Overview

This chapter provides information on Grid Monitor (GridMon) v1.14 
(01/11/05). GridMon (GridMon.exe) is a Windows XP application that can be 
used in conjunction with the MAP Server and Sort Client to visually display 
activity in real-time, by using a colored animated grid. GridMon may be used to 
visualize the activity on a regularly-spaced array of electrodes, such as a multi-
microelectrode plate (MMEP).

First, start Sort Client and sort the desired units, then start GridMon to monitor 
the activity on those channels. The GridMon options can be used to select the 
electrode layout and to adjust the appearance of the animated color-grid display.

The electrode configurations supported by GridMon are: 

• MMEP1 (64 electrodes in 4 rows and 16 columns) 

• MMEP4 (64 electrodes, 8 rows x 8 columns)

• MEA56 (64 electrodes, 8 x 8)

• Generic (2 x 8, 4 x 8, 8 x 8, and 8 x 16)

9.2 Requirements and Installation

GridMon is designed to run on Windows XP or later with the same hardware 
requirements as Sort Client. If GridMon has not installed automatically, it can be 
installed by copying the executable file GridMon.exe into the directory where the 
other Plexon applications are located, such as \rasputin.

Plexon strongly recommends that the Windows display be set to at least 16-bit 
color mode (65536 colors). It is possible to run GridMon in 8-bit mode (256 col-
ors), but the appearance of the animated color display is very poor compared to 
16-bit and higher modes. Internally, GridMon maintains 24-bit color precision.

9.3 Startup

Run Sort Client with an experiment file loaded. To run GridMon, double-click 
GridMon.exe in its installed directory. A desktop shortcut for GridMon may also 
be created.
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As the following illustration shows, at startup the GridMon display appears and 
defaults to the MMEP1 (4 X 16) electrode layout.

GridMon continuously displays activity on the first 64 electrodes. If the Pause 
button is clicked, the display stops until the Go button is clicked. For more infor-
mation, see “Go, Pause: These buttons pause and unpause the GridMon display.” 
on page 252. As the following illustration shows, when paused, GridMon shows 
an overlay grid indicating the layout of the electrodes (SIG channels).

Before using the functions available for adjusting the appearance of the GridMon 
display, review the theory of operation described in the following section.
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9.4 Theory of Operation

GridMon periodically counts the spikes that occur on each electrode (SIG) chan-
nel and displays the activity level (count per unit time) as a color. Red is the most 
active and blue is totally inactive. Strictly speaking, the firing rates (activity) are 
only known at the electrode sites (the centers of the grid squares in the previous 
illustration), but GridMon interpolates between the electrode sites to create a 
smoothly flowing display that is useful in visualizing dynamic patterns of activ-
ity. The activity on all units on each SIG channel (e.g. SIG 23a, SIG 23b, SIG23c, 
SIG23d) is summed into a single activity value for that electrode site.

With the GridMon temporal smoothing feature turned off, each frame that Grid-
Mon displays represents the activity within the preceding frame time without ref-
erence to preceding frames. For example, if the frame rate is set to the default 
value of 10 frames per second (fps), every 0.1 seconds GridMon displays a pic-
ture of the activity in the preceding 0.1 seconds. In effect, the display is the equiv-
alent of watching a 10 fps animated movie of the activity at the electrode sites.

If only a few widely separated electrodes have significant activity, each active 
electrode site appears as discrete colored circles that change shade from red (or 
green, if there is less activity) in the center to blue at the edges. However, when 
adjacent electrodes have activity, the interpolation across the grid becomes more 
apparent. For example, in the preceding illustration, in the left-most column S8 is 
relatively inactive, S14 is very active, with decreasing activity through S19 and 
S25. There are two methods of interpolation: bicubic and bilinear. The preceding 
illustration shows bicubic interpolation.

Bicubic Interpolation: The default method is to use a grid of bicubic polynomial 
interpolants, with an activity level being interpolated at each grid intersection 
(electrode site). This interpolant assumes that the partial derivatives of activity 
with respect to the directions of the grid rows and columns is zero at the electrode 
sites, so that the individual bicubic interpolants stitch together with first-order 
continuity. If the activity were represented as heights instead of colors, so that the 
electrode sites are hills of varying heights, this would be equivalent to saying that 
the top of each hill is level, and that the ground smoothly slopes away from one 
hilltop to the adjacent ones. Although the bicubic interpolant provides a smooth 
slope, sometimes a more abrupt slope can be preferable.
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Bilinear Interpolation: Bilinear is the alternative interpolation method, which 
yields a chunkier display because it only performs a linear interpolation in each 
direction between the electrode sites. See the example in the following illustra-
tion.

The red centers that indicate high activity tend to be more tightly separated and 
unnaturally diamond-shaped, due to the linear interpolation. Other unusual visual 
artifacts can occasionally be seen for two reasons. First, a grid of bilinear interpo-
lants in general has unavoidable discontinuities along the grid lines. Second, a 
bilinear interpolant cannot truly interpolate four arbitrary activity levels at its cor-
ners. Continuing the analogy of hilltops, if each of four hilltops is at a different 
height, there is in general no plane that touches all four hilltops, because a plane 
is defined by only three points in space. In the case where the four activity levels 
at the corners are unequal, GridMon performs a pseudo interpolation that is orien-
tation-dependent. In most cases, this works acceptably well, given that a general 
display of activity dynamics is the goal.

Note: We cannot know what the true activity is in between the actual electrode sites. 
The only true display would consist of a single colored dot at each electrode 
site. GridMon displays a mathematical interpolation of the known activity levels, 
no more and no less. Be careful not to read too much into the GridMon interpo-
lated display.

9.5 Toolbar

GridMon provides access to most functions from these buttons on the toolbar.

All parameters may be adjusted while the GridMon display is running. It is not 
necessary to pause the display to adjust it.
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Go, Pause: These buttons pause and unpause the GridMon display.

 Bicubic interpolation: This button starts bicubic interpolation, which 
provides a smoother display that runs more slowly.

 Bilinear interpolation: This button starts bilinear interpolation, which 
provides a chunkier display that runs faster.

 No interpolation: This button sets the display to the non-interpolated 
mode, which is a grid of colored squares.

 More blue, More red: These buttons adjust the color scaling of the 
GridMon display. Use the More blue button when activity is high to 

cool down the colors. Use the More red button when activity is low and the dis-
play is showing mainly blue and green. The number of spikes per second that cor-
responds to red (maximum activity) appears in the title bar.

 More banded, less banded: By default, GridMon displays the inter-
polated color grid as smoothly as possible up to the limit of the dis-

play settings (preferably 16-bit color or better) on the PC. However, one may 
experiment with lower resolutions, which provide an interesting contour map or 
isobar appearance where the colors are more banded looking. The More banded 
button reduces the color resolution. The Less banded button increases the color 
resolution. More banded can require several clicks before the banding becomes 
obvious, depending on the graphics card and other factors.

 More time smoothing, less time smoothing: By default, GridMon 
shows a color display of the activity counts for the current frame, 

independent of previous frame activity. If the frame rate is high, this can produce 
a very fast-changing display that can be difficult to follow. The More time 
smoothing button causes GridMon to use a moving average (using a simple tri-
angular filter) of the preceding N frame counts, which causes a smoothing over 
time, at the expense of blurring the details in time. If the activity at a single elec-
trode briefly goes very high, one can click More time smoothing to make it fade 
in and out on the GridMon display, rather than blinking in and out. 

 Frame rate faster, frame rate slower: These buttons adjust the rate 
at which the display updates in frames per second (fps). The minimum 

rate is 1 fps and the maximum rate is 30 fps. If GridMon is run at the largest win-
dow size and at rates above 10 to 15 fps, GridMon can use significant amounts of 
processing power, particularly if the PC has a slow graphics card. Use fast frame 
rates with caution. At frame rates approaching 30 fps, the buttons on the Grid-
Mon toolbar can become very slow to respond or completely unresponsive. A 
frame rate of 10 to 15 fps is usually adequate to get smooth animation.

 Select window size: In order to optimize the display performance, Grid-
Mon only supports three specific window sizes for each grid layout: small, 

medium, and large. The large window size can use considerable processing 
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power at higher frame rates. A window size may be chosen by selecting it from 
the View menu, or by clicking on the Select window size button to cycle through 
the three sizes. It is not possible to stretch the window to an arbitrary size; 
although the outer window frame may be stretched, the actual display remains at 
one of the three optimized sizes.

9.6 Selecting the Electrode Grid Layout

The appropriate electrode layout (e.g. MMEP1, MMEP4) may be chosen by 
selecting it from the View menu. As with the other parameters, this may be done 
at any time, whether GridMon is paused or not.

9.7 General Tips for Adjusting the Display

The parameters interact with each other somewhat. For example, if the time 
smoothing is increased it tends to shift the display towards blue, because the con-
tribution of a given amount of activity is spread out across several frames. Adjust 
the parameters as desired. Also, if the frame rate is very low or the amount of 
time smoothing is high, or both, there will be an unrealistic slowly-varying dis-
play that hides rapid changes in activity.

What is the difference between slowing down the frame rate and increasing the 
amount of time smoothing? At any given frame rate, the frame interval (e.g. 
0.1 sec at 10 fps) serves in effect as a bin width—GridMon lumps all spikes 
within each frame interval together into a single count for each electrode. This is 
integration in time with a box filter. However, the time smoothing function uses a 
triangular hat filter to further smooth these frame counts over the course of sev-
eral frames. The user should experiment with varying both the frame rate and the 
time smoothing function to get a feel for the interaction between them. Optimal 
settings depend on the dynamics of the cells being monitored and the desired per-
sonal viewing preferences.

Note: It is possible that viewing rapidly varying color displays could cause seizures in 
persons with neurological problems such as epilepsy. Plexon can assume no 
responsibility for such problems, and appropriate caution should be exercised. 

9.8 Saving and Loading GridMon Configurations

GridMon does not use a configuration file. When GridMon starts, it recalls the 
settings that were last in use, including window size and position. When Grid-
Mon closes, it automatically saves all the settings. The first time GridMon runs, it 
uses default values for all settings.
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10.1 Overview

Plexon provides two client development kits, one for C and C++ and one for 
MATLAB®, to help develop custom applications.These kits can be used to 
develop custom applications and to transfer Plexon data into commercial off-the-
shelf software programs. The kits include tutorials to show how to create applica-
tions and, in some cases, the kits also include coded building blocks that can be 
incorporated into development projects. Each kit includes a SoftServer applica-
tion that emulates the MAP system and an application programming interface 
(API) client for National Instruments (NI) devices to help develop and test on-
line clients.

Each client development kit consists of a series of files bundled together in a sin-
gle WinZip®* file. WinZip 8.0 or later is necessary to open the zipped files. Win-
Zip is available from WinZip Computing Inc., P.O. Box 540, Mansfield, 
Connecticut 06268 USA. An evaluation copy of WinZip may be downloaded 
from www.winzip.com.

10.2 C and C++ Client Development Kits for the MAP System

The C and C++ kits include two versions of the sample client programs and appli-
cations, which illustrate how to read spike timestamps and how to retrieve 
NI DAQ digitized waveform data from the MAP system:

• SimpleRead demonstrates the basics of writing and building a client program 
for the MAP system.

• TimeStampRead demonstrates how to display individual spike timestamps.

• VTRead reads Plexon Video Tracker files and extracts timestamps and x/y 
position data.

• NIDAQRead demonstrates how to retrieve and display digitized data from a 
NI DAQ card.

• EventWait combines the functionality of TimeStampRead and 
NIDAQRead and uses Win32 synchronization events to enable minimum-
latency operation.

• PlexDO is an API client that controls one or more National Instruments (NI) 
“E” series cards to perform basic digital output functions, such as setting indi-
vidual bits high or low, outputting pulses, and generating clock signals.

• SoftServer is a special version of the MAP server software that emulates the 
operation of the MAP box. SoftServer is an invaluable tool when the Plexon 
client development kits are used to create custom client applications.

Each sample client includes both a Win32 console-mode (text only, non-GUI) 
version and a Microsoft Foundation Classes (MFC) version. Try the samples in 
the preceding order because they progress from simple to complex. The source 
for each sample is in a .cpp file with the same name as the sample program. For 
the console-mode version, Plexon primarily used basic C computer programing 
language with a minimum of Windows-specific code.

www.winzip.com
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10.2.1 Unzipping and Building the Sample Programs

Plexon provides the sample clients as one .zip file, which contains both the C 
samples and the MFC samples, plus documentation files in MS Word. When  
RASPUTIN is installed, the files are typically located in the following directory:

C:\Program Files\Plexon Inc\Documents\ClientDevelopment

When the files are unzipped, WinZip creates the following directory structure.

The bin folder contains the executable files for the applications.
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The C folder contains the Microsoft Visual C++ workspace file and the program 
file directories:
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The doc folder contains more information on each item in the kit, in both MS 
Word and PDF format. This folder also contains the change log for this release. 

The include folder contains Plexon header files.
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The lib folder contains Plexon library files.

The MFC folder contains the Microsoft Foundation Classes (MFC) workspace 
file and the MFC sample client file sub-directories.

10.2.2 Using the Sample Clients

As shown in the preceding file lists, each bottom-level subdirectory contains one 
client, for example, CandC++ClientDevelopment\C\TimeStampRead. All the cli-
ents were built using Microsoft Visual C++ version 6.0, and so each client project 
is represented by a .dsw workspace file. 
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To work with a sample client

1 Before running a sample client, start MAP Server and SortClient, and sort 
some active units.

Note: Instead of starting the MAP and running Server, SoftServer can also 
be used with most clients.

2 Start Visual C++.

3 Use Open Workspace to open the .dsw file.

4 Do Rebuild All and the sample client is ready to execute.

The source code for each sample client includes the header file Plexon.h, which 
contains declarations of the Plexon functions and related constants. The source 
code also includes standard C header files such as stdio.h and stdlib.h as needed. 
Each sample client includes links to the library PlexClient.lib, in addition to the 
usual Windows libraries.

10.2.3 Client Reference Information

This section includes detailed information on each sample client. Because C and 
C++ clients and the MFC clients are similar, this section includes information for 
both types. Read the detailed information for each sample client in the order that 
follows, because the sample clients increase in complexity as they build on con-
cepts and code introduced in previous clients. In some cases, only  the differences 
are described.  

To use the MFC sample clients, a familiarity with the basics of building a simple 
dialog-based application using MFC is necessary. For more information on MFC, 
refer to Microsoft or other third-party documentation. In some cases MFC sample 
clients have slightly different functionality than their console-mode equivalents, 
due to the dialog-based GUI display versus the line-by-line text output from the 
console applications.

10.2.3.1 SimpleRead

SimpleRead reads timestamps from MAP Server or SoftServer, once per second, 
each time printing a line to the console window showing the total number of 
spike timestamps read. SimpleRead consists of a single main function that exe-
cutes in the following sequence:

1 SimpleRead calls PL_InitClientEx3( ), which connects SimpleRead to Server 
(MAP Server or SoftServer). This call registers SimpleRead with Server, 
which must be done before any other Server functions can be called. Omitting 
to start Server and SortClient will result in a long pause as Server loads and 
starts before this call returns to SimpleRead.

— Any number of independent clients can each register with Server in any 
order at any time, and each client can read data from Server completely 
independently of the other clients. From the perspective of each client, 
Server reads data from the MAP box and provides the data to that client 
alone.
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2 SimpleRead calls PL_IsSortClientRunning( ); if Sort Client is running, the 
call returns TRUE. This call insures that there are sorted units with times-
tamps available.

— The malloc( ) allocates a buffer in which Server returns the timestamps. 
The buffer is an array of structures of type PL_Event, which is the basic 
data for a single spike timestamp.

3 SimpleRead enters an infinite loop, until the window is closed by clicking on 
the Close “X” box. With each pass through the loop, SimpleRead calls 
PL_GetTimeStampStructures( ), which copies the latest batch of timestamps 
from Server into the allocated buffer and sets NumTimeStamps to the actual 
number of timestamps in the buffer.

— The value that SimpleRead passes in for NumTimeStamps is the maxi-
mum number of timestamps passed back to SimpleRead each time. If 
NumTimeStamps is 0 after the call, there was no activity since the last 
time SimpleRead called PL_GetTimeStampStructures( ). On the other 
hand, if NumTimeStamps is unchanged, this indicates that the buffer is 
completely filled; when this occurs there can be more timestamps in 
Server that were not returned on this call, but which are returned in the 
next call to PL_GetTimeStampStructures( ).

4 SimpleRead steps through the array of PL_Event structures returned from 
PL_GetTimeStampStructures( ). The loop in SimpleRead adds up the number 
of sorted spikes on all channels. This total depends on how many units Sort 
Client sorts and the level of activity present.

5 The printf( ) function writes the number of PL_Events and the number of 
timestamps to the console window. SimpleRead then goes into an idle state 
for one second, using the Sleep( ) function. Then, SimpleRead returns to the 
top of the loop to fetch another batch of timestamps. 

Note: It is important to insert a call to Sleep( ) in a loop such as this, so that 
other applications can run during the sleep interval.  

Although it is not important with the SimpleRead client, be aware that within a 
batch of PL_Events returned by Server to a client, channels can occur in any 
order. Code the clients to maintain per-channel buffers or any other suitable inter-
nal data structure as needed.

For simplicity, this sample client assumes that the user closes the client by click-
ing on the close box in the upper right corner of the console window. However, 
this action immediately exits the program without disconnecting from Server, 
which is bad coding practise.When a real client is created, recognize some condi-
tion within the infinite loop (a command, or the end of data) as an indication to 
break out of the loop and clean up. In this case, SimpleRead cleans up by freeing 
the buffer and calling PL_CloseClient( ) to disconnect from Server.



 

Version 2.6 263

10.2.3.1 TimeStampRead

TimeStampRead is similar in overall structure to “SimpleRead” on page 261, but 
it decodes the PL_Event in more detail and dumps information on every times-
tamp to the console window. The setup is identical aside from the call to 
PL_GetTimeStampTick( ), which is a function that returns the timestamp resolu-
tion in microseconds. For most MAP systems this is 25 microseconds, which cor-
responds to a sampling rate of 40 kHz.

The infinite loop is the same, except that for each timestamp, TimeStampRead 
extracts the channel, unit, and actual time and prints them to the console window.  
Each PL_Event that represents a spike timestamp has fields for Channel, Unit, 
and TimeStamp:

• Channel is a 1-based DSP channel number (DSP01, DSP02, …) and Unit 
indicates the sorted unit on that channel. For example, if Channel = 29 and 
Unit = 3, this is channel DSP29c. 

• TimeStamp is a 32-bit integer representing the time at which the spike 
crossed the threshold, in units of MAP clock ticks.  For example, on a 40 kHz 
MAP system, a timestamp of 400000 corresponds to 10 seconds after the 
MAP clock is started or reset.  The clock resets on powerup and whenever a 
new experiment file loads and the Start button is clicked. For each timestamp 
that appears in the console window, TimeStampRead divides the timestamp 
by the MAP sample rate to get the time in seconds.

The remainder of the code is identical to SimpleRead.

10.2.3.2 VTRead

VTRead is similar in overall structure to “SimpleRead” on page 261, but it 
decodes the PL_Event and extracts x/y position data for every timestamp that 
corresponds to a strobed event. VTRead then dumps the x/y coordinates to the 
console window. The setup is identical to SimpleRead.

VTRead steps through the array of PL_Event structures returned from 
PL_GetTimeStampStructures( ). The loop in VTRead looks for event timestamps 
on all channels and only extracts VT data from the strobed events. VTRead veri-
fies the data, adds it to the accumulator, and displays the timestamp and coordi-
nates in the console window. 

The remainder of the code is identical to SimpleRead.

10.2.3.3 NIDAQRead

NIDAQRead demonstrates how to read digitized data from a National Instru-
ments (NI) DAQ device. If the system does not have a NI DAQ device, this sam-
ple client can be skipped. 

Note: NIDAQRead does not work with SoftServer.
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Before NIDAQRead is run, NIDAQ must be enabled in MAP Server, and prefer-
ably have only the first NI DAQ channel (ACH0) enabled in the SortClient Ana-
log Channels window. Due to the large volume of data generated with multiple 
channels and the fact that this client dumps all of the samples to the console win-
dow, NIDAQRead works best when only one channel is enabled. Also, to further 
reduce the amount of data, set a low NI DAQ sampling rate, for example 100 Hz. 
Even with these settings, to observe the output when NIDAQRead runs,  it may 
be necessary to hit Control-S to pause the screen.

NIDAQRead setup is similar to TimeStampRead, with the following two 
changes:

1 Instead of using the PL_Event structure, NIDAQRead allocates memory for 
an array of PL_WaveLong. This structure contains extra information for 
returning the NI DAQ samples.

2 There is a call to the function PL_GetSlowInfo( ), which returns the NIDAQ 
sampling rate. NIDAQRead ignores the second and third parameters, which 
contain Dummy values.

Within the infinite loop, NIDAQRead calls 
PL_GetLongWaveFormStructuresEx2( ), which fills in the allocated array of  
PL_WaveLong. This command is essentially a superset of the SimpleRead 
PL_GetTimeStampStructures( ) command, which returns timestamps in an array 
of PL_Event. In other words, PL_GetLongWaveFormStructuresEx2( ) returns 
both spike timestamps and NI DAQ digitized waveform samples. As with a 
PL_Event, the Type field of each PL_WaveLong indicates which type of data it 
contains.

Whereas the TimeStampRead client looked for spike timestamps (Type == 
PL_SingleWFType), NIDAQRead looks for blocks of NI DAQ samples, where 
Type == PL_ADDataType. With spike timestamps, each PL_Event structure rep-
resents one spike. However, with digitized NI DAQ data, each PL_WaveLong 
contains several consecutive samples on a single channel. Therefore, within the 
loop that steps through all the PL_WaveLong structures, when NIDAQRead finds 
a block of NI DAQ samples, it steps through all of the samples in that block. In 
this sample client, NIDAQRead only looks for blocks on Channel 0 to keep 
things manageable.  

PL_WaveLong contains the number of samples in the block and the timestamp 
(in MAP clock ticks) of the first sample in the block. Each subsequent sample in 
the block has an implicit timestamp of one NI DAQ sampling tick later than the 
previous sample. Because the NI DAQ sampling rate is less than the MAP sam-
pling rate, a little thought reveals that the increment between NI DAQ samples, in 
terms of MAP clock ticks, is MAPSampleRate/NIDAQSampleRate. In the per-
sample loop, NIDAQRead adds this increment each time it advances to the next 
sample, which provides the time for that sample. NIDAQRead displays the actual 
digitized value and the timestamp (converted to seconds) for each sample.  
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For a typical setup, the NI DAQ device digitizes waveforms into 12-bit signed 
samples, for example within a range of -2047 to +2048. Clients can of course 
scale this raw data into any convenient range for their own calculations.

The remainder of the code is identical to SimpleRead and TimeStampRead.

10.2.3.4 EventWait

EventWait combines the functionality of TimeStampRead and NIDAQRead and 
introduces a method for synchronizing operation with MAP Server. EventWait 
can also be used with SoftServer.

In the previous sample clients, the client and the Server are completely asynchro-
nous. That is, Server continually fetches timestamps from the MAP box through 
the MXI interface hardware, and Server also continually fetches digitized sam-
ples from the NI DAQ device, when one is present. MAP Server places the times-
tamps and samples in a buffer called the memory mapped file (MMF). Fetching 
the information works fine as long as a given client reads the data from Server by 
calling PL_GetTimeStampStructures( ) or 
PL_GetLongWaveFormStructuresEx2( ) before the data expires in the MMF. 
Server never waits on clients to read the data; Server simply makes the data avail-
able for clients to read if and when clients call for it. This works because the 
MMF is fairly large, typically several megabytes, and the MMF size can be set in 
the Server options.

However, the client can obtain the latest timestamps and digitized data from 
Server as soon as they are available and with minimum latency.  In order to do 
this, it is necessary to use a Win32 synchronization object referred to as an event. 

Note: In the context of Win32 programming, an event refers to a type of Win32 syn-
chronization object; this is completely different from the Plexon PL_Event data 
structure type, whose name derives from the common practice of referring to a 
spike firing as a spike event. Any time a Plexon function or data type has event 
as part of its name, it refers to a spike event, not a Win32 synchronization 
object.

A discussion of Win32 synchronization in general is beyond the scope of this 
tutorial. If more information is needed, consult a book on Win32 programming 
techniques for details. However, one can use the technique in this sample client as 
part of a client that handles reading data from Server in one thread of execution 
while other threads handle computation and user interface chores. EventWait, 
which is not multithreaded, uses only the simplest synchronization to insure that 
it can read from Server as soon as new timestamps are available.

EventWait calls the Win32 function OpenEvent( ) to obtain a handle to the stan-
dard Plexon Server synchronization event. This is sometimes referred to as the 
server event or the polling event, because Server signals it every time that it com-
pletes reading timestamps from the MAP box and digitized data from the 
NI DAQ device.
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Most of the EventWait main loop consists of what amounts to the timestamp 
decoding from TimeStampRead plus the NI DAQ decoding from NIDAQRead.  
PL_GetLongWaveFormStructuresEx2( ) gets both the spike timestamps and the 
NI DAQ samples, again using the Type field of each PL_WaveLong structure to 
distinguish them. However, instead of a simple Sleep(1000) call, EventWait uses 
a call to the Win32 function WaitForSingleObject( ). When execution reaches this 
call, the system yields control to other processes, as does the Sleep( ) function; 
however, rather than this being for a fixed interval such as one second, execution 
resumes only when Server signals the server event. 

The waiting interval is approximately the same as the polling interval set in 
Server options, which is typically well under 100 ms, so that the loop executes at 
a rate over 10 Hz. If Server has a polling interval set to 20 ms, this means that 
roughly every 20 ms Server polls the MAP hardware, transfers data to the MMF, 
then immediately signals the server event, which effectively restarts all clients 
that are waiting on the server event. When the flow of execution in EventWait 
hits WaitForSingleObject( ) again, it waits until the server again signals the event 
after the next MAP polling cycle.

The duration of a Windows time slice determines the lower limit on the length of 
the polling interval. On a single-CPU machine, the polling interval is usually 
10 ms; on a multi-CPU machine, it is usually 15.625 ms. This corresponds to 
time-slice rates of 100 Hz and 64 Hz respectively.

The remainder of the code in EventWait is the same as the previous clients, with 
the addition of a call to CloseHandle( ) to close the server event.

The screen output scrolls by very quickly in the console window at typical Server 
poll intervals (10-50 ms), even if there is little activity. To more easily see the 
timestamp counts, set the poll interval in Server Options window to a larger 
value, such as 100 ms or more.

Note: Before using the MAP system for regular work again, change the polling inter-
val back to its original value so SortClient and other clients run smoothly.

10.2.3.5 MFCSimpleRead

MFCSimpleRead reads timestamps from Server 
(MAP Server or SoftServer) once per second. 
Each time MFCSimpleRead reads a timestamp, it 
sets the text of a dialog item to the total number 
of spike timestamps read.

Note: Because the MFC AppWizard inserts many 
comments in the source code, the Plexon-
specific comments appear with  //** rather 
than  // .

When click Connect, a one-time initialization 
occurs that invokes the OnConnect( ) function. 
This includes the call to PL_InitClientEx3( ), the 
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check for PL_IsSortClientRunning( ), and the allocation of the buffer into which 
Server returns MAP events.

At the end of OnConnect( ), a one-second timer starts using SetTimer( ). This 
timer replaces the Sleep(1000) call inside the infinite loop in the console-mode 
sample clients. When a WM_TIMER message arrives, the OnTimer( ) calls 
PL_GetTimeStampStructures( ) and then displays the MAP events read.

When the window closes, the OnDestroy( ) handler kills the timer and performs 
other cleanup tasks.

10.2.3.6 MFCTimeStampRead

MFCTimeStampRead is similar in overall struc-
ture to MFCSimpleRead, but it decodes the 
PL_Event in more detail. For each of the first 
eight unit channels, DSP01a through DSP02d, 
MFCTimeStampRead counts the number of 
timestamps (spikes). 

After MFCTimeStampRead loops through all 
the MAP events, the count of spikes on each 
channel appears in the window. For each times-
tamp on the first eight unit channels, MFC-
TimeStampRead also dumps the DSP channel 
number, unit, and time in seconds to the Visual 
C++ debug window, using the standard TRACE 
macro.

The remainder of the code is identical to MFC-
SimpleRead.
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10.2.3.7 MFCVTRead

MFCVTRead is similar in overall structure to 
MFCSimpleRead, but it decodes the PL_Event 
and extracts x/y position data for every times-
tamp that corresponds to a strobed event. 
MFCVTRead then dumps the x/y coordinates 
to the window. The setup is identical to MFC-
SimpleRead.

MFCVTRead steps through the array of 
PL_Event structures returned from 
PL_GetTimeStampStructures( ). The loop in 
MFCVTRead looks for event timestamps on 
all channels and only extracts VT data from 
the strobed events. MFCVTRead verifies the 
data, adds it to the accumulator, and displays 
the timestamp and coordinates in the window. 

The remainder of the code is identical to MFC-
SimpleRead.

10.2.3.8 MFCNIDAQRead

MFCNIDAQRead demonstrates how to read 
digitized data from the National Instruments 
(NI) DAQ card. The NI DAQ-specific code is 
similar to the console-mode NI DAQ sample, 
except for the display of the NI DAQ data. 
Each time MFCNIDAQRead gets a new batch 
of MAP events from Server, MFC-
NIDAQRead loops through the events, only 
looking for NI DAQ sample blocks on the first 
channel (ACH0). For this channel, MFC-
NIDAQRead displays the first eight samples in 
the block in the window, including the times-
tamp and the digitized value for each sample. 
If a low-frequency triangle wave (1 Hz) is run 
into ACH0, there will be a set of eight consec-
utive samples, updated once per second.  If the 
NI DAQ sampling rate is set to 100 Hz this is 
about 8/100 = 0.08 sec of digitized waveforms. 

The remainder of the code is identical to MFC-
SimpleRead and MFCTimeStampRead.



 

Version 2.6 269

10.2.3.9 MFCEventWait

MFCEventWait is similar to the console-mode 
EventWait sample, but it also shows basic multi-
threading techniques. MFCEventWait starts a sec-
ond reading thread that is dedicated to waiting on 
Server.

When Connect is clicked, after the usual initial-
ization, MFCEventWait calls the function Star-
tReadThread( ). StartReadThread( ) begins by 
resetting KillDataThreadEvent, a Win32 event 
that runs on shutdown to signal to the reading 
thread to kill itself. Next, MFCEventWait opens 
the Server poll event, as in the console-mode 
EventWait. Finally, MFCEventWait uses the MFC function AfxBeginThread( ) to 
actually begin execution of the reading thread, whose thread function is 
ReadThreadFunc( ). AfxBeginThread( ) also passes a pointer to KillDataThread 
so that the reading thread can use it to determine when to kill itself.

ReadThreadFunc( ) does three main things inside of an infinite loop:

1 First, it waits on the kill event, but with a timeout of 0, so that execution con-
tinues immediately unless it receives the kill event. This happens on shut-
down from OnDestroy( ), where the call to KillDataThreadEvent.SetEvent( ) 
is made. When this event is signaled, the reading thread calls the MFC func-
tion AfxEndThread( ) and terminates.

2 Second, assuming that the kill event has not been signaled yet, the reading 
thread sends a WM_USER+1 message to the main thread, which indicates 
that it should read a batch of MAP events from Server. Because this is a Send-
Message( ), as opposed to a PostMessage, the reading thread waits until the 
main thread has processed the WM_USER+1 message before continuing.

3 Last, after the main thread finishes processing the message, the reading thread 
waits on the Server polling event. MFCEventWait suspends the reading 
thread until Server signals the polling event again.

OnServerReady( ) handles the WM_USER message. The MFC technique for 
associating this function with the WM_USER+1 message is to manually add an 
ON_MESSAGE entry in CMFCEventWaitDlg message map. OnServerReady( ) 
reads a batch of timestamps from Server and displays the number of events in the 
window. The more detailed decoding of spike timestamps, or NI DAQ samples, 
or both, which is found in the other clients, is omitted here for simplicity.

As already mentioned, when the window is closed, OnDestroy( ) in the main 
thread signals the reading thread to kill itself. OnDestroy( ) also frees the times-
tamp buffer and closes the handle to the Server poll event.

A more advanced client can have several threads, for example, one for reading 
data from Server, one for updating displays, one for handling user interaction, etc. 
Such techniques are beyond the scope of this sample; please contact Plexon for 
more information.
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10.3 MATLAB® Extensions

MATLAB®* Extensions is a series of Matlab functions that can be used with Mat-
lab to transfer data from the Plexon MAP server. MATLAB, Version 6 or later, 
must be installed on the PC to use these functions. Matlab is available from The 
MathWorks, Inc., 3 Apple Hill Drive, Natick, MA 0176-2098 USA (www.math-
works.com).

10.3.1 Event-Triggered Field Potential GUI

The Event-Triggered Field Potential Graphical User Interface (GUI) is a Matlab 
display that plots a field potential signal around a spike or external event in real-
time. The field potential display can be averaged over all events or it can be set to 
single-trial mode. The following illustration shows the Figure No. 1 Matlab GUI 
prior to the establishment of a connection to the MAP Server.

For information about the Matlab Figure No. 1 window and the Matlab menu, 
see “Using Matlab Graphics” in the Matlab documentation set. The following 
items are specific to this extension:

Event: The external event input, either XS1 or XS2.

AD Channel: The number of the analog-to-digital (AD) channels to plot.

Connect to Plexon Server: Click to open a connection to the Plexon MAP 
Server.

Disconnect Server: Click to close the connection to the MAP Server.

Plot: After a connection has been established to the MAP Server, click Plot to 
view the data.

www.mathworks.com
www.mathworks.com
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Stop: Click to stop the data plot.

# Events: This field maintains a running count of the number of events repre-
sented in the plot.

Plot Mode: From the menu, chose to view a plot of each single event or a plot of 
the running average of all events.

Pre-event Time (sec): Type the time in seconds to plot on the X-axis prior to the 
event.

Post-event Time (sec): Type the time in seconds to plot on the X-axis after the 
event.

Dialog Box: This field indicates the current state of the GUI, which can be one of 
the following:

• Connect to Server: Establish a connection to Server before data is plotted.

• Error: First Connect to Server: There has been an attempt to plot data with-
out opening a connection to Server.

• Connected to Server: The connection to Server is open.

• Disconnected from Server: The connection to Server is closed.

• Plotting AD Perievent Data: The GUI is currently plotting data.

The plotting area displays Time in seconds on the X axis and raw A/D converter 
units on the Y axis. For a 12-bit conversion, A/D converter units are integers 
from -2047 to +2048.

The following illustration shows a Figure No. 1 perievent data plot. 
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10.3.2 Unzipping and Running Matlab Extensions 

Plexon provides the Matlab Client Development Kit as one .zip file, which con-
tains the following items:

• ClientSDK, which includes Matlab scripts to access online data from the 
Plexon MAP system. 

• PlexDO, which is a Matlab version of the Plexon client API that controls one 
or more National Instruments (NI) “E” series cards to perform basic digital 
output functions, such as setting individual bits high or low, outputting pulses, 
and generating clock signals. 

• SoftServer, which is a special version of the MAP server software that emu-
lates the operation of the MAP. SoftServer is an invaluable tool when using 
the Plexon client development kits to create custom client applications. 

The files are bundled with RASPUTIN software and they are typically located in 
the following directory:

C:\Program Files\Plexon Inc\Documents\ClientDevelopment

The following illustration shows the file list after unzipping the Matlab Exten-
sions.
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11.1 Overview

Continuous analog data signals (e.g. LFP, EEG, eye coil positions, continuous 
spike and wide band [spike + LFP] signals, and other such signals) can be 
recorded simultaneously with spike data from the MAP box using one or more 
National Instruments A/D (NIDAQ) boards in the host computer or in an external 
chassis. A connection between the TIM board in the MAP box and the NIDAQ 
board synchronizes the recordings of the spike and continuous signals. Several 
different physical configurations are supported. For example, an SCB-68, a 
PBOB, or a C-HUB may be used in a basic configuration or in conjuction with an 
expansion chassis (PCI/exp or PCI/exp4). There are also other configurations, 
such as those that include CinePlex. The diagrams below show the basic configu-
ration with and without the expansion chassis.

The MAP system software can support up to four A/D boards, though the boards 
in an individual system must be identical. The channels on a given board must be 
run at the same sampling rate, but different boards can be run at different sam-
pling rates (e.g. at 1 kHZ for slow signals like local field potentials, and at 20 
kHZ or 40 kHz for fast spike signals). The MAP software can only support a 
maximum of two different sampling rates across all the boards, however: a fast 
rate and a slow rate. Therefore, if one has three A/D boards with the first board 
sampling at a slow rate of 1 kHz and a second board sampling at a fast rate of 40 
kHz, then the sampling rate on the third board must be set to either 1 kHz or 40 
kHz. The sampling rates are set on the Analog Channels settings in Sort Client.
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Note: An expansion chassis is required for 40 kHz continuous recording; otherwise, 
the maximum is 20 kHz.

Supported NIDAQ boards include (channel counts based on a sampling rate of 1 
kHz):

• PCI-6040E [PCI-MIO-16E-4] (250 kSamples/sec, 16-channel, 12-bit resolu-
tion)

• PCI-6052E (333 kSamples/sec, 16-channel, 16-bit resolution)

• PCI-6070E [PCI-MIO-16E-1] (1.25 MSamples/sec, 16-channel, 12-bit reso-
lution)

• PCI-6071E (1.25 MSamples/sec, 64-channel, 12-bit resolution)

Preamp filtering for local field potential (LFP) signals is typically 0.7 Hz - 300 
Hz, although preamps are available with other filtering bandpass values. The FP 
signals come from the same electrodes as the spikes. Other analog signals that 
can be recorded through the break-out box include:

• Physiological - such as blood pressure, EKG, EMG, etc.

• Behavioral - such as eye position, arm angle, head direction, etc.

Consult the C-HUB (or PBOB) Technical Brief and the SCB-68 Data Sheet for 
information on interfacing to 64- and 16-channel NIDAQ boards, respectively.

11.2 Setup of NIDAQ Boards

Typically, Plexon will have already installed the NIDAQ software and cards leav-
ing the user to install cables to signal sources. For completeness, the table below 
shows the procedures to set up the NIDAQ cards and breakout boxes.

Step Action Diagram/Comments

1 Run the installation program 
from the National Instruments 
CD.

This step assumes that there are no NIDAQ board(s) installed 
in the PC. Only very seldom would a user have to perform this 
process (which actually contains a number of steps), so this is 
just included for completeness.

2 Insert the National Instruments 
A/D (NIDAQ) board in the 32-bit 
(short) PCI slot (typically white).

The NIDAQ (PXI version only) board may also be inserted into 
the expansion chassis, if used. For more details, see Appen-
dix B: PXI Expansion Chassis.

3 Connect the SCB-68, the C-
HUB, or PBOB to the NIDAQ 
board.

SCB-68 for 16-channel NIDAQ boards
PBOB for 64-channel NIDAQ boards
C-HUB for 64-channel NIDAQ boards

See the Map System Installation Guide for details.
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4 Connect the rainbow ribbon ca-
ble carrying the continuous an-
alog signals (from the field 
potential preamp board, or oth-
er sources) to the DB37 con-
nector on the breakout box or 
BNC panel.

See the MAP System Installation Guide for details.

5 Connect the cable from the TIM 
board in the MAP box to the 
DB9 TIM input connector on the 
breakout box.

If the expansion chassis is used, connect the TIM cable from 
the MAP box to a PXI-TIM board in the expansion chassis. 
See “Connecting a PXI-TIM Card to the MAP System 
TIM Card” on page B-16.

6 The diagrams at the right show 
the configuration of the XS1 
connector on the MAP TIM 
board for systems shipped be-
fore 2008 and those shipped in 
2008 and later. If the system 
configuration is unknown, con-
tact Plexon.

Pre-2008 systems require the TIM cable yellow wire with BNC
connector to be connected to the XS1 connector on the MAP
TIM board as shown below.

Systems shipped in 2008 and later have a cap on the XS1
connector of the MAP TIM board. In case this cap is missing
or needs to be replaced due to damage, refer to the diagram
below.

Step Action Diagram/Comments
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7 Run the National Instruments 
Measurement & Automation 
program. Select Devices and 
Interfaces. Select Traditional 
NI-DAQ (Legacy) Devices. 
Right-click on the board and se-
lect Properties.

(NOTE: The board name will 
depend on which model is in-
stalled.)

NOTE: The NI-MAX program 
may be accessed by selecting 
Measurement & Automation 
from the computer’s Start->All 
Programs->National Instru-
ments.

8 On the AI tab set:
Polarity/Range: -10V - +10V
Mode: Non-referenced Single 
Ended.

NOTE: NIDAQ specifies +-10V 
at 1/2 gain. Therefore, the 
working range at 1x gain is +-
5V.

9 On the Accessory tab select 
the appropriate breakout box or 
BNC panel as the Accessory 
(e.g. SCB-68). If using PBOB or 
C-HUB, select None (because 
neither are on the dropdown 
list).

Step Action Diagram/Comments
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10 For this step open Server and 
select View | Options. On the 
NIDAQ tab, check the Enable 
checkbox and select the num-
ber of analog channels (16 for 
16-channel NIDAQ boards 64 
for 64-channel NIDAQ board).  
Ensure that the Use PXI clock 
interface (cPCI external chas-
sis) checkbox is checked. Se-
lect the appropriate clock 
frequency (40KHz or 80KHz). If 
finished, click OK to close the 
Options dialog box. To see the 
NIDAQ devices and their de-
vice numbers, go to step 11.
Close and restart Server after 
enabling NIDAQ.

Note: All boards must be of the 
same type. Each A/D board’s 
channels will be displayed on a 
separate tab in the Analog 
Channels display in Sort Client 
(shown below in the next sec-
tion).

11 Ensure that the NI device num-
bers and boards match what is 
shown in the Configuration 
window of Step 7. Click Show 
Available NIDAQ Devices to 
get to the list of NIDAQ devices 
shown to the right.
Close Server when finished.

Step Action Diagram/Comments
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11.3 Configuration of Continuous Signals in Sort Client

The procedure below shows how to configure the continuous signals in Sort Cli-
ent.

Step Action Image/Comments

1 Enable Analog channels in 
Sort Client: Use the Enable 
checkboxes in the 
AnalogChans page(s) in Set-
tings to enable the desired 
channels on each A/D board.

NOTE: When the file is opened in NEX or OFS, the amplitude 
of the signal at the electrode is expressed in mV. NEX and 
OFS use the preamp gain value to calculate what the size of 
the signal at the electrode was.The Preamp Gain is a combi-
nation of the gain of the headstage multiplied by the gain of 
the field potential board in the preamp.

2 Set the sampling rate on the A/
D channels (A/D Frequency).
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3 Set the desired gain on the A/D 
channels (NI Gain).

NOTE: Normal default hard-
ware gain for field potential 
channels is 1000.

4 Set the preamp gain.

NOTE: The value to be entered 
in the ‘Preamp Gain’ column is 
actually the product of the 
headstage gain and the 
preamp gain, or more general-
ly, the total fixed gain before the 
signal enters the NI board.

NOTE: The preamp gain is typ-
ically only entered once (unless 
the preamp changes), whereas 
the NI ‘board gain’ can be 
changed on a per-channel ba-
sis during the experiment (but 
not during recording).

5 Click Update Server.

NOTE: Update Server must be 
clicked on each AnalogChans 
page where changes are made.

Step Action Image/Comments
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11.4 NIDAQ Multichannel Sampling Characteristics

This section provides information on the between-channel sampling offsets of 
National Instruments data acquisition (NIDAQ) devices and includes charts with 
sampling offsets for the following NIDAQ devices:

• PCI-6070E (formerly PCI-MIO-16E-1): 1.25 MS/sec, 16 channels, 12-bit res-
olution

• PCI-6071E: 1.25 MS/sec, 64 channels, 12-bit resolution

• PCI-6052E: 333 kS/sec, 16 channels, 16-bit resolution

• PCI-6040E (formerly PCI-MIO-16E-4): 250kS/sec, 16 channels, 12-bit reso-
lution

11.4.1 Instrumentation Preamp Settling Time and Sampling Offsets

The NIDAQ devices supported by Plexon hardware use a single, very-high-speed 
analog-to-digital (A/D) converter, which is multiplexed (shared) by all the input 
channels. Within a single sample period (e.g. 25 microseconds at a 40 kHz sam-
pling rate), the A/D converter scans all the input channels in rapid succession and 
sends an A/D value (sample value) to Server for each channel. Because of the 
speed at which the converter scans, under most circumstances the effect is the 
same as having a dedicated A/D converter per channel. Although the NIDAQ 
scanning introduces a small inter-channel time offset, this is less than one sample 
period and therefore it has little or no effect on the acquired data.

6 View analog signals in the Sort 
Client Activity Display.
Select View | Activity Display 
or click the Activity Display 
button on the toolbar. 

NOTE: Amplitude measure-
ments for continuous channels 
are not provided in Sort Client. 
For amplitude measurements, 
use NEX.

Step Action Image/Comments
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However, an instrumentation grade preamplifier (on the NIDAQ device) precedes 
the NIDAQ A/D converter. This preamplifier requires a finite amount of time to 
“settle” from a high-voltage level to a lower-voltage level, especially when the 
gains are very different on adjacent channels. The worst-case situation is a large-
amplitude input signal on channel i with a gain of 1, followed by a very-small 
input signal on channel i+1 with a gain of 100; this situation requires the longest 
settling time between channels for the instrumentation preamp to reproduce the 
signal on channel i+1 accurately. The net effect is similar to a “leakage” between 
channels; the voltage on channel i can affect the value of channel i+1. Ideally, sig-
nal levels are similar across channels and require moderate NIDAQ gains of 1 to 
10; in this case, settling time is generally not a problem.

The default NIDAQ hardware behavior is to scan through the channels as rapidly 
as possible within each sample period, which is necessary if the full bandwidth of 
the device is used. For example, 31 channels at 20 kHz per channel on a 1.25 
megasamples/sec board like the NI 6071E results in an inter-channel scan interval 
of about 1613 nanoseconds. However, when less than the maximum bandwidth of 
the board is used, the Sort Client software automatically reduces the channel 
scanning rate (within each sample period) in order to maximize the amount of 
time available for the instrumentation preamp to settle between channels.

Note: This reduction in the scanning rate does not affect the sampling rate, only the 
rate at which channels are scanned within each sample period. This reduces 
the number of available channels on the A/D board. NIDAQ never increases 
the inter-channel scan interval to more than one sample period, or 6 microsec-
onds, whichever is shorter.

The following tables show the inter-channel scan intervals that Plexon software 
automatically selects for various combinations of channel count and digitizing 
rate (fast spike rate) for the NIDAQ device it supports. The values highlighted in 
green have sufficient settling time to enable accurate digitalization, even in the 
worst case described earlier. The values highlighted in yellow denote the combi-
nations that can have reduced accuracy when there are widely differing gains set 
on adjacent channels. The values highlighted in red denote combinations that 
cannot be selected in Sort Client because they exceed the bandwidth of the 
NIDAQ device.

For additional information, refer to the NI PCI E Series User Manual (available 
on the National Instruments website), which describes the accuracy of various E 
series DAQ boards as a function of the inter-channel sampling offset.

Color Legend for Tables

Meets the NI worst-case settling time specification for equal gain on all channels
(this range provides accurate digitization)

Possible problems for mixed gains (this range could cause inaccurate digitization)

Sampling rate exceeds device capacity (this range exceeds the bandwidth of the
NIDAQ device)
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11.4.1.1 PCI-6071E Device

The NI “worst-case” specification for this device is 1.4 microseconds.

Samp. Freq 
(kHz)

Ch # 

1 2 4 5 8 10 16 20 24 25 31.25 40 50

1 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

2 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

3 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

4 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0

5 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0 4.0

6 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.2 4.0 3.2

7 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.8 5.6 4.4 3.4 2.8

8 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.2 5.0 4.0 3.0 2.4

9 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.4 4.6 4.4 3.4 2.6 2.2

10 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0 4.0 4.0 3.2 2.4 2.0

11 6.0 6.0 6.0 6.0 6.0 6.0 5.6 4.4 3.6 3.6 2.8 2.2 1.8

12 6.0 6.0 6.0 6.0 6.0 6.0 5.2 4.0 3.4 3.2 2.6 2.0 1.6

13 6.0 6.0 6.0 6.0 6.0 6.0 4.8 3.8 3.2 3.0 2.4 1.8 1.4

14 6.0 6.0 6.0 6.0 6.0 6.0 4.4 3.4 2.8 2.8 2.2 1.6 1.4

15 6.0 6.0 6.0 6.0 6.0 6.0 4.0 3.2 2.6 2.6 2.0 1.6 1.2

16 6.0 6.0 6.0 6.0 6.0 6.0 3.8 3.0 2.6 2.4 2.0 1.4 1.2

17 6.0 6.0 6.0 6.0 6.0 5.8 3.6 2.8 2.4 2.2 1.8 1.4 1.0

18 6.0 6.0 6.0 6.0 6.0 5.4 3.4 2.6 2.2 2.2 1.6 1.2 1.0

19 6.0 6.0 6.0 6.0 6.0 5.2 3.2 2.6 2.0 2.0 1.6 1.2 1.0

20 6.0 6.0 6.0 6.0 6.0 5.0 3.0 2.4 2.0 2.0 1.6 1.2 1.0

21 6.0 6.0 6.0 6.0 5.8 4.6 2.8 2.2 1.8 1.8 1.4 1.0 0.8

22 6.0 6.0 6.0 6.0 5.8 4.4 2.8 2.2 1.8 1.8 1.4 1.0 0.8

23 6.0 6.0 6.0 6.0 5.4 4.2 2.6 2.0 1.8 1.6 1.2 1.0 0.8

24 6.0 6.0 6.0 6.0 5.2 4.0 2.6 2.0 1.6 1.6 1.2 1.0 0.8

25 6.0 6.0 6.0 6.0 5.0 4.0 2.4 2.0 1.6 1.6 1.2 1.0 0.8

26 6.0 6.0 6.0 6.0 4.8 3.8 2.4 1.8 1.6 1.4 1.2 0.8 X

27 6.0 6.0 6.0 6.0 4.6 3.6 2.2 1.8 1.4 1.4 1.0 0.8 X

28 6.0 6.0 6.0 6.0 4.4 3.4 2.2 1.6 1.4 1.4 1.0 0.8 X

29 6.0 6.0 6.0 6.0 4.2 3.4 2.0 1.6 1.4 1.2 1.0 0.8 X

30 6.0 6.0 6.0 6.0 4.0 3.2 2.0 1.6 1.2 1.2 1.0 0.8 X

31 6.0 6.0 6.0 6.0 4.0 3.2 2.0 1.6 1.2 1.2 1.0 0.8 X

32 6.0 6.0 6.0 6.0 3.8 3.0 1.8 1.4 1.2 1.2 1.0 X X

33 6.0 6.0 6.0 6.0 3.6 3.0 1.8 1.4 1.2 1.2 0.8 X X

34 6.0 6.0 6.0 5.8 3.6 2.8 1.8 1.4 1.2 1.0 0.8 X X

35 6.0 6.0 6.0 5.6 3.4 2.8 1.6 1.4 1.0 1.0 0.8 X X

36 6.0 6.0 6.0 5.4 3.4 2.6 1.6 1.2 1.0 1.0 0.8 X X
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37 6.0 6.0 6.0 5.4 3.2 2.6 1.6 1.2 1.0 1.0 0.8 X X

38 6.0 6.0 6.0 5.2 3.2 2.6 1.6 1.2 1.0 1.0 0.8 X X

39 6.0 6.0 6.0 5.0 3.2 2.4 1.6 1.2 1.0 1.0 0.8 X X

40 6.0 6.0 6.0 5.0 3.0 2.4 1.4 1.2 1.0 1.0 0.8 X X

41 6.0 6.0 6.0 4.8 3.0 2.4 1.4 1.2 1.0 0.8 X X X

42 6.0 6.0 5.8 4.6 2.8 2.2 1.4 1.0 0.8 1.0 X X X

43 6.0 6.0 5.8 4.6 2.8 2.2 1.4 1.0 0.8 1.0 X X X

44 6.0 6.0 5.6 4.4 2.8 2.2 1.2 1.0 0.8 1.0 X X X

45 6.0 6.0 5.4 4.4 2.6 2.2 1.2 1.0 0.8 1.0 X X X

46 6.0 6.0 5.4 4.2 2.6 2.0 1.2 1.0 0.8 1.0 X X X

47 6.0 6.0 5.2 4.2 2.6 2.0 1.2 1.0 0.8 1.0 X X X

48 6.0 6.0 5.2 4.0 2.6 2.0 1.2 1.0 0.8 1.0 X X X

49 6.0 6.0 5.0 4.0 2.4 2.0 1.2 1.0 0.8 1.0 X X X

50 6.0 6.0 5.0 4.0 2.4 2.0 1.2 1.0 0.8 1.0 X X X

51 6.0 6.0 4.8 3.8 2.4 1.8 1.2 0.8 0.8 X X X X

52 6.0 6.0 4.8 3.8 2.4 1.8 1.2 0.8 0.8 X X X X

53 6.0 6.0 4.6 3.6 2.2 1.8 1.0 0.8 X X X X X

54 6.0 6.0 4.6 3.6 2.2 1.8 1.0 0.8 X X X X X

55 6.0 6.0 4.4 3.6 2.2 1.8 1.0 0.8 X X X X X

56 6.0 6.0 4.4 3.4 2.2 1.8 1.0 0.8 X X X X X

57 6.0 6.0 4.2 3.4 2.0 1.6 1.0 0.8 X X X X X

58 6.0 6.0 4.2 3.4 2.0 1.6 1.0 0.8 X X X X X

59 6.0 6.0 4.2 3.2 2.0 1.6 1.0 0.8 X X X X X

60 6.0 6.0 4.0 3.2 2.0 1.6 1.0 0.8 X X X X X

61 6.0 6.0 4.0 3.2 2.0 1.6 1.0 0.8 X X X X X

62 6.0 6.0 4.0 3.2 2.0 1.6 1.0 0.8 X X X X X

63 6.0 6.0 3.8 3.0 1.8 1.4 0.8 X X X X X X

64 6.0 6.0 3.8 3.0 1.8 1.4 0.8 X X X X X X

Samp. Freq 
(kHz)

Ch # 

1 2 4 5 8 10 16 20 24 25 31.25 40 50
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11.4.1.2 PCI-6070E (PCI-MIO-16E-1) Device

The NI “worst-case” specification for this device is 1.5 microseconds.

Samp. Freq 
(kHz)

Ch # 

1 2 4 5 8 10 16 20 24 25 31.25 40 50

1 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

2 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

3 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

4 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0

5 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0 4.0

6 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.2 4.0 3.2

7 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.8 5.6 4.4 3.4 2.8

8 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.2 5.0 4.0 3.0 2.4

9 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.4 4.6 4.4 3.4 2.6 2.2

10 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0 4.0 4.0 3.2 2.4 2.0

11 6.0 6.0 6.0 6.0 6.0 6.0 5.6 4.4 3.6 3.6 2.8 2.2 1.8

12 6.0 6.0 6.0 6.0 6.0 6.0 5.2 4.0 3.4 3.2 2.6 2.0 1.6

13 6.0 6.0 6.0 6.0 6.0 6.0 4.8 3.8 3.2 3.0 2.4 1.8 1.4

14 6.0 6.0 6.0 6.0 6.0 6.0 4.4 3.4 2.8 2.8 2.2 1.6 1.4

15 6.0 6.0 6.0 6.0 6.0 6.0 4.0 3.2 2.6 2.6 2.0 1.6 1.2

16 6.0 6.0 6.0 6.0 6.0 6.0 3.8 3.0 2.6 2.4 2.0 1.4 1.2



11 Continuous Signal Recording 

286  Continuous Signal Recording

11.4.1.3 PCI-6052E Device

The NI “worst-case” specification for this device is 4.0 microseconds.

Samp. Freq 
(kHz)

Ch # 

1 2 4 5 8 10 16 20 24 25 31.25 40 50

1 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

2 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

3 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

4 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0

5 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0 4.0

6 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.2 4.0 3.2

7 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.8 5.6 4.4 3.4 2.8

8 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.2 5.0 4.0 3.0 2.4

9 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.4 4.6 4.4 3.4 2.6 2.2

10 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0 4.0 4.0 3.2 2.4 2.0

11 6.0 6.0 6.0 6.0 6.0 6.0 5.6 4.4 3.6 3.6 2.8 2.2 1.8

12 6.0 6.0 6.0 6.0 6.0 6.0 5.2 4.0 3.4 3.2 2.6 2.0 1.6

13 6.0 6.0 6.0 6.0 6.0 6.0 4.8 3.8 3.2 3.0 2.4 1.8 1.4

14 6.0 6.0 6.0 6.0 6.0 6.0 4.4 3.4 2.8 2.8 2.2 1.6 1.4

15 6.0 6.0 6.0 6.0 6.0 6.0 4.0 3.2 2.6 2.6 2.0 1.6 1.2

16 6.0 6.0 6.0 6.0 6.0 6.0 3.8 3.0 2.6 2.4 2.0 1.4 1.2
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11.4.1.4 PCI-6040E (PCI-MIO-16E-4) Device

The NI “worst-case” specification for this device is 4.0 microseconds.

Samp. Freq 
(kHz)

Ch # 

1 2 4 5 8 10 16 20 24 25 31.25 40 50

1 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

2 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

3 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0

4 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0

5 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0 4.0

6 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.2 4.0 3.2

7 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.8 5.6 4.4 3.4 2.8

8 6.0 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.2 5.0 4.0 3.0 2.4

9 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.4 4.6 4.4 3.4 2.6 2.2

10 6.0 6.0 6.0 6.0 6.0 6.0 6.0 5.0 4.0 4.0 3.2 2.4 2.0

11 6.0 6.0 6.0 6.0 6.0 6.0 5.6 4.4 3.6 3.6 2.8 2.2 1.8

12 6.0 6.0 6.0 6.0 6.0 6.0 5.2 4.0 3.4 3.2 2.6 2.0 1.6

13 6.0 6.0 6.0 6.0 6.0 6.0 4.8 3.8 3.2 3.0 2.4 1.8 1.4

14 6.0 6.0 6.0 6.0 6.0 6.0 4.4 3.4 2.8 2.8 2.2 1.6 1.4

15 6.0 6.0 6.0 6.0 6.0 6.0 4.0 3.2 2.6 2.6 2.0 1.6 1.2

16 6.0 6.0 6.0 6.0 6.0 6.0 3.8 3.0 2.6 2.4 2.0 1.4 1.2
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11.5 Signal Mapping Between C-HUB and NI PCI-6071E

The table below shows the signal mapping between the C-HUB and the NI PCI-
6071E A/D board. See the NI PCI E-series User Manual (NI 320945D-01) on the 
National Instruments website for more information about each signal.

* The NI signals DGND and AOGND are shorted together on the C-HUB.

**CTR1 is called “Line 2” in the PlexDO utility.

C-HUB to PCI-6071E Signal Mapping

Plexon Signal Name National Instruments Signal Name

AD01 ACH0

AD02 ACH1

--- ---

AD64 ACH63

AISENSE AISENSE

AISENSE2 AISENSE2

AIGND AIGND

DO1 DIO0

DO2 DIO1

--- ---

DO8 DIO7

DGND* DGND*

CTR1 (Line 2)** GPCTR1

A/D Clock PFI8/GPCTR0_Source

A/D Start PFI0_TRIG1

CPX Clock GPCTR0_OUT

AO1 DAC0_OUT

AO2 DAC1OUT

AOGND* AOGND*
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This appendix provides information on the following topics:

• What is needed before installing the Plexon RASPUTIN Software

• RASPUTIN Software installation 

• Hard key installation

A.1 Before Beginning

Before beginning the RASPUTIN Software installation, ensure that the following 
hardware and software are installed and configured correctly on the PC.

A.2 Hardware

To install RASPUTIN software, it is necessary to have the following hardware

• Plexon recommends a PC with

— An Intel Pentium 4 1-GHz processor or faster 

— A minimum 512 Mbyte of memory 

— 10 Gbytes of hard disk space—this can vary depending on the record-
ing requirements

— Microsoft Windows NT4.0 or Windows XP operating system

• A complete Plexon Multi-channel Acquisition Processor (MAP) system. For 
hardware information, refer to the Plexon MAP System Installation Guide.

• A Rainbow Technologies Sentinel* System security key, which can be either 
a parallel-port key or a USB key. Parallel-port keys have two oblong connec-
tors—one male and one female, which enables several keys to stacked 
together. USB keys have a single male connector. 

A.2.1 Hardware Installation

Determine if the RASPUTIN Software Sentinel System key is a parallel-port key 
or a USB key. Keys are channel-count specific and they are available in 16, 32, 
64, 96, and 128-channel capacities. Locate a suitable port to install the key. If 
assistance is needed with the port locations on the PC, refer to the PC manufac-
turer’s instructions. Do not install the key until the software installation is com-
pleted. See the Caution on page A-7.

A.3 Software

If a complete MAP system is installed and configured, the RASPUTIN Software 
automatically uses it. 

A.3.1 Installing the RASPUTIN Software

There are three major steps to installing the RASPUTIN Software:

• Install the RASPUTIN Software files and run the setup program.

http://www.plexoninc.com/pdf/MAP%20System%20Installation%20v1.1.pdf
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• Install and configure the Rainbow Sentinel system drivers.

• Install the Sentinel hardware key.

To install the RASPUTIN Software files

1 Close all applications.

2 Place the RASPUTIN Software setup CD in the computer's CD-ROM drive.

3 Find the RASPUTINv2Setup.exe file on the CD.

4 Double-click RASPUTINv2Setup.exe.

5 When the Welcome 
screen appears, 
follow the on-screen 
instructions. Click 
Next to acknowledge 
acceptance of the 
copyright warning 
and to proceed with 
installation.

6 Review the 
information in the 
Read Me File window.

Note: If Cancel is clicked, the 
Install window opens. 
Click Exit Setup to can-
cel.
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7 In the Choose 
Destination 
Location window, a 
location for the 
RASPUTIN 
Software files can be 
specified. Click 
Browse to choose a 
different location. 
Otherwise, click 
Next to accept the 
default location.

8 To upgrade from 
RASPUTIN Version 
2.2, in the Backup 
Replaced Files win-
dow, click Yes to 
create backup cop-
ies of the Version 2 
software. Make sure 
Version 2.4 is work-
ing correctly before 
deleting the backup 
copies. Click Next to 
continue the installa-
tion. 

9 In the Select 
Program Manager 
Group window, a 
program group for 
the RASPUTIN 
Software icons may 
be chosen. To 
accept the default 
group and proceed 
with the installation, 
click Next. 
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10 At the Start 
Installation window, 
to return to the 
previous window to 
change information, 
click Back. 
Otherwise, click 
Next to begin the 
RASPUTIN 
Software installation. 

11 The Installing 
window includes a 
progress bars that 
will show when the 
installation is 
complete. 

12 When the 
RASPUTIN 
Software 
installation 
process is 
complete, the 
Sentinel System 
Driver - 
InstallShield 
Wizard welcome 
window opens. 
Click Next to 
proceed with 
driver installation.
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13 In the Program 
Maintenance 
window, click 
Modify and then 
click Next to 
continue the 
installation.

14 In the Custom 
Setup window, 
click the driver 
that matches the 
Sentinel System 
security key. To 
determine type of 
key is installed, 
see “Hardware 
Installation” on 
page A-2. The 
following 
illustration shows 
the installation 
window with the 
parallel-port key 
driver selected.

Caution
USB Security Key Damage
Before installing Sentinel System security key drivers it is necessary 
to remove all Sentinel USB keys from the PC. If a system driver is 
installed with a USB key in the port, the key becomes unusable.
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15 Ensure that all 
USB keys have 
been removed 
from the PC. Click 
Install to proceed 
with the driver 
installation.

16 When the Sentinel 
driver installation 
completes, the 
following window 
opens. Click 
Finish to 
complete the 
driver installation.

17 When the Sentinel 
System Driver - 
InstallShield 
Wizard window 
closes, the 
Installation 
Complete window is 
visible. Click Finish 
to complete the 
RASPUTIN 
Software software 
installation.



A  

A-8  RASPUTIN Software

To install the Sentinel hardware key

1 Plexon provides two types of hardware keys with RASPUTIN Software: a 
Universal Serial Bus (USB) key and parallel-port key. Each key is marked with 
“R” to indicate that it is a RASPUTIN Software key. Determine which ports are 
available on the computer and choose the appropriate key.

2 If a USB key has been chosen, locate an available USB port on the computer 
and insert the USB key. 
– or –
If a parallel-port key has been chosen, locate an available parallel port on the 
computer and continue with Step 3.

Note: If the computer has only one parallel port, parallel-port devices like 
printers or Zip drives may be temporarily removed to connect the key. 
After installing the key, these devices may be reconnected to the par-
allel port on the key.

3 Insert the key into the computer parallel port. Tighten the mounting screws.

4 Reconnect any other parallel-port devices to the key. 

Note: If a printer is to be connected to the computer through a Sentinel key, 
Sentinel recommends using shielded printer cables.

Note: More than one parallel-port key can be attached to the same parallel 
port. SentinelSuperPro* keys, which are provided with Plexon 
Offline Sorter software, can be cascaded (one key connected to 
another key in a series) with other Rainbow Technologies keys that 
support cascading. If cascaded keys are used, the SentinelSuperPro 
key must be the last key in the series, that is, the one located farthest 
from the computer port.

http://www.plexoninc.com/OFS.htm
http://www.plexoninc.com/OFS.htm
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B.1 Introduction

B.1.1 Overview

In a typical Plexon MAP System, additional PCI slots may be needed for A/D 
boards (the MAP system supports up to 4 A/D boards), the HLK2 interface, digi-
tal I/O boards for CinePlex, etc. However, PCs have a limited number of PCI 
slots, and there may not be enough available slots to accommodate individual 
needs. To provide a solution to this problem, Plexon offers the Plexon Expansion 
Chassis. With the Plexon Expansion Chassis it is not necessary to be dependent 
on the PC manufacturer for the number of PCI slots available.

Note: The PC uses PCI cards while the expansion chassis uses smaller PXI cards 
(otherwise known as compact PCI or cPCI). The PCI and PXI cards are differ-
ent and are not interchangeable.

B.1.2 Expansion Chassis Models

Plexon offers three models of the Expansion Chassis (PXI/exp, PXI/exp4, and 
PXI/exp4-RM).

B.1.2.1 PXI/exp

The PXI/exp consists of a chassis which has 8 usable cPCI slots on the left half of 
the chassis. The space over unused slots in the chassis may be used for mounting 
C-HUB and BNC-16B panels (break out panels used to interface to or to provide 
access to A/D channels). If nothing is mounted in this area, filler panels cover the 
space - as shown in the diagram below. Any of the unused slots are also covered 
with filler panels. The chassis has space for 10 slots, but the first two are taken up 
by the power supply. This means that the slot numbering begins after the first two 
slots; a point that is illustrated in the diagram below. 

To the right of the power supply, the PXI-8360 link card is mounted in Slot 1 and 
the Plexon PXI-TIM card is mounted in Slot 2. If CinePlex and the digital video 
recording system is used with the expansion chassis, a FireWire® card for con-
necting a CinePlex camera will likely be installed in Slot 3. A/D cards may 
installed in any remaining slots (The Plexon system supports up to 4 A/D cards). 
A/D card installed in the expansion chassis must all be of the same type (for 
example, all 6071E, all 6070E, or etc.).
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The top picture shows an empty expansion chassis (except for the power supply), 
and the bottom picture shows the expansion chassis in a typical installation with 
cards and breakout boxes.

B.1.2.2 PXI/exp4 and PXI/exp4-RM

The PXI/exp4 is a National Instruments PXI-1033 chassis which contains a 5-slot 
PXI backplane. The PXI/exp4 and PXI/exp4-RM both contain an embedded PC 
interface with a connector on the back of the chassis.

The PXI/exp4-RM is the same as the PXI/exp4 except that it has a rack mount on 
the top. The rack mount is used to mount various combinations of Plexon’s inter-
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face cards (C-HUB and BNC-16B) as shown in the sample mounting picture 
below. If additional space is needed, multiple rack mounts can be used together.
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B.2 Interface Modules

B.2.1 Expansion Chassis Modules

The table below describes the modules used for the PXI/exp, PXI/exp4, and PXI/
exp4-RM.

Expansion Chassis Modules

Module Image Description Comments

Chassis Power Supply The Expansion Chassis power 
supply occupies the left-most 
area (covering two slots) of the 
PXI/exp.

Built into PXI/exp4 and PXI/
exp4-RM

PXI-8360 Controller The PXI-8360 controller module 
provides a data link between the 
Expansion Chassis and the PC. 
This NI module occupies Slot 1 
in the PXI/exp.

Built into PXI/exp4 and PXI/
exp4-RM and accessed us-
ing the connector on back of 
chassis

PXI-TIM card This Plexon module occupies 
Slot 2 in the PXI/exp, the PXI/
exp4, or PXI/exp4-RM. This 
module receives timing and 
control signals from the MAP 
system and distributes the tim-
ing signal to the other cards in 
the PXI expansion chassis. It 
has two 9-pin connectors on the 
faceplate. The TIM connector 
provides a connection to the 
TIM board in the MAP. Current-
ly, the CPX connector is re-
served for future use with the 
Plexon CinePlex Video Capture 
and Tracking System.

PXI/exp, PXI/exp4, and PXI/
exp4-RM need this module. 
The PXI-TIM card con-
tains jumpers to send ei-
ther a 40kHz or 80kHz 
clock signal to the A/D 
cards in the expansion 
chassis. The NI A/D cards 
divide this clock signal by 
2, so that a 40kHz clock 
signal is required to run 
the A/D cards at a 20kHz 
sampling frequency. An 
80kHz clock signal is re-
quired to run the A/D 
cards at a 40kHz sam-
pling frequency.
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B.2.2 Nose Cards

A nose card is an adaptor board that is mounted directly on the front of another 
card. There are two types of nose cards. One type connects preamps directly to 
the A/D cards and the other type connects breakout cards to the A/D cards. The 

A/D cards The NI A/D cards may occupy 
any available PXI slot. They are 
normally positioned to the right 
of the PXI-TIM and PXI-8252 
FireWire card. The image 
shows the ADC/PXI-6071E, 
which it provides up to 64 chan-
nels of analog input with 12-bit 
resolution.

Other supported NI A/D 
cards include:
PXI-6040E
PXI-6052E
PXI-6070E

NOTE: If more than one A/D 
card is installed in an expan-
sion chassis, Sort Client  re-
quires all of them to be the 
same type.

PXI-8252 FireWire card The National Instruments PXI-
8252 FireWire card is used to 
connect the camera for the 
Plexon CinePlex system. It can 
be placed in any slot between 
slots 3 and 6 in the PXI/exp4 
and PXI/exp4-RM. Typically, 
this card will reside in Slot 3 of 
the PXI/exp. This will allow an 
A/D card to be placed in close 
proximity to a C-HUB; should 
they need to be connected.

If a CinePlex camera needs 
to be connected and there is 
no expansion chassis, the 
FireWire card must be in-
stalled in the PC.

Expansion Chassis Modules

Module Image Description Comments
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nose cards permit the use of shorter, more flexible cables. The table below 
describes the various nose cards.

The diagrams below show the Plexon PXI-6071E P50E-100 nose card, but they 
also apply to the ADP/PXI6071E-DB37m nose card. 

The illustration on the left is correct, and the illustration on the right is incorrect. 
Note that in the incorrect illustration, the printed circuit side of the card is on the 
right - the card should be rotated by 180 degrees to be correct. The printed circuit 
side of the card should be on the left.

Nose Cards

Module Image Description Comments

PXI-6071E P50E-100 Adaptor The Plexon PXI-6071E P50E-
100 Adaptor card connects the 
PXI-6071E I/O Module to the C-
HUB.

Damage can result if the 
card is installed backwards. 
See below for details.

ADP/PXI6071E-DB37m This adaptor connects a 
preamp output directly to the 
PXI-6071E, circumventing the 
need for a breakout box. Only 
16 of the 64 channels are used, 
and the unused 48 channels are 
grounded.

Damage can result if the 
card is installed backwards. 
See below for details.

PXI-6070E Adaptor This adaptor connects a 
preamp output directly to the 
PXI-6070E 16-channel A/D 
card. This card may also be 
used to connect a BNB-16B to 
the PXI-6070E.

The connectors are beveled 
- this prevents this card from 
being installed backwards.
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B.2.3 Breakout Cards

There are two types of breakout cards - rack-mounted and remotely-mounted. 
The table below describes the breakout cards that may be used in conjunction 
with any of the expansion chassis models. These cards are mounted on a rack 
above the PXI/exp4 and PXI/exp4-RM or may be mounted directly on the PXI/
exp. They do not plug into any of the expansion chassis slots.

Breakout Cards

Module/Image Description Comments

C-HUB-r The C-HUB-r (rack-mounted) 
has the PXI-6071E connector 
mounted perpendicular to the 
circuit card as shown in the im-
age at the left.

C-HUB-r uses a gray ribbon ca-
ble to connect to the PXI-
6071E. Rainbow-colored twist-
ed-pair cables are used to con-
nect to the DB37 connectors on 
the C-HUB-r.

C-HUB and C-HUB-r are in-
terfaces to  the National In-
struments 6071E A/D cards. 
For more details, see C-HUB 
Technical Brief.

The C-HUB-r uses the PXI-
6071E P50E-100 adaptor to 
connect to the PXI-6071E 
described in the previous 
section.
See “Connecting an A/
D Card to a C-HUB-r or 
PBX” on page B-12 for-
pictures of the cabling.
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C-HUB The C-HUB (remotely-mount-
ed) has the PXI-6071E connec-
tor mounted in-line with the 
circuit card as shown in the im-
age at the left. This version is 
the table-top version.

C-HUB uses a thick, black,  in-
flexible cable to connect to the 
PCI-6071E. Rainbow-colored 
twisted-pair cables are used to 
connect to the DB37 connectors 
on the C-HUB.

NOTE: This model is not in-
tended to be mounted on the 
rack. If it is mounted on the 
rack, it may be difficult or im-
possible to connect the cable 
to the PCI-6071E connector. 
For more details, see C-HUB 
Technical Brief

See “Connecting an A/
D Card to a C-HUB-r or 
PBX” on page B-12 for 
cabling pictures.

BNC-16B The BNC-16B (rack- or remote-
ly-mounted) mounts on the PXI/
exp, on the rack of the PXI/
exp4(-RM), or in a table-top 
configuration with the C-HUB.

The BNC-16B uses BNC cables 
to connect to the individual 
channels. For other input and 
output the BNC-16B uses a 
DB37 connector (P2) and a 34-
pin box header connector.

The BNC-16B is a breakout 
box for the C-HUB. It con-
nects to the C-HUB and pro-
vides access of up to 16 
channels of analog signals 
for straight-through connec-
tion, signal substitution, or 
signal monitoring. For more 
details see BNC-16B Tech-
nical Brief.

See “Connectors” on 
page D-4 and “Connect-
ing Signals to the BNC-
16B” on page D-6 for de-
tails on the connectors and 
pictures of the cabling.

Breakout Cards

Module/Image Description Comments
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B.3 Installation

The appropriate cards will already be installed prior to shipment. Connecting the 
required cables between the correct expansion chassis connectors and the appro-
priate connectors in the PC, MAP system, or other devices is all that is required. 
To install a card into the expansion chassis, see “Expansion Chassis Cards and 
Cabling” on page B-20. The following may also need to be performed:

• Connect the link controller in the expansion chassis to the PC - see “Connect-
ing the Link Controller to a PC” on page B-11.

• Connect one or more expansion chassis A/D cards to a C-HUB - see “Con-
necting an A/D Card to a C-HUB-r or PBX” on page B-12.

• Connect an expansion chassis FireWire card to the CinePlex camera - see 
“Connecting a FireWire Card to the CinePlex Camera” on page B-15.

• Connect an expansion chassis Plexon PXI-TIM card to the MAP system - see 
“Connecting a PXI-TIM Card to the MAP System TIM Card” on page B-16.

• Set the jumpers on the Plexon PXI-TIM card to determine clock frequency - 
see “Setting PXI-TIM Jumpers” on page B-17.

• Connect a C-HUB to a BNC-16B - see “Connecting a BNC-16B to a C-HUB-
r/C-HUB” on page B-19.

There are other interface options for the C-HUB. For information on those con-
nections, see C-HUB Technical Brief. There are also other interface possibilities 
for the BNC-16B. For details see BNC-16B Technical Brief.
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B.3.1 Connecting the Link Controller to a PC

The table below contains the procedure to connect the expansion chassis link 
controller to a PC.

Link Controller to PC

Step Action Image/Comments

1 Ensure the PC power and the expansion chassis 
power are both turned OFF.

Damage to the equipment is possible if the 
power is on.

2 Connect the link cable to the PCI Express card in 
the PC (see the red rounded rectangle). Use the 
left-most port (Port 1) - at the left of Port 1 are two 
LEDs (one orange and one green).

3a For the PXI/exp4 or PXI/exp4-RM expansion chas-
sis, connect the other end of the link cable to the 
connector on the back of the PXI/exp4 or PXI/
exp4-RM expansion chassis.

3b For the PXI/exp expansion chassis, connect the 
other end of the link cable to the connector on the 
front of the PXI-8360 Controller card in the PXI/exp 
expansion chassis.
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B.3.2 Connecting an A/D Card to a C-HUB-r or PBX

The table below contains the procedure to connect an expansion chassis PXI-
6071E A/D card to a C-HUB-r using an adaptor card.

A/D Card to C-HUB-r with the PXI-6071E P50-100 Adaptor Card

Step Action Image/Comments

1 Ensure the PC power and the expansion chassis 
power are both turned OFF.

Damage to the equipment is possible if the 
power is on.

2 Connect the PXI-6071E P50-100 adaptor card to 
the A/D card in the expansion chassis. Ensure that 
the adaptor card is inserted correctly as shown in 
the top diagram. Damage could result if the adap-
tor card is inserted as shown in the right diagram.

3 Connect the gray A/D ribbon cable to the PXI-
6071E P50-100 adaptor card.
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4 Connect the other end of the gray A/D ribbon cable 
to the C-HUB-r. 

NOTE: The C-HUB-r has the PXI-6071E connector 
mounted perpendicular to the circuit card.

A/D Card to PBX with ADP/PX-6071E-DB37m Adaptor

Step Action Image/Comments

1 Ensure the PC power and the expansion chassis 
power are both turned OFF.

Damage to the equipment is possible if the 
power is on.

2 Connect the PXI-6071E DB37m adaptor to the A/D 
card in the expansion chassis. Ensure that the 
adaptor card is inserted correctly as shown in the 
top diagram. Damage could result if the adaptor 
card is inserted incorrectly. Note: The correct cir-
cuit card orientation is the same as it was for the 
previous procedure.

3 Connect the rainbow A/D ribbon cable to the PXI-
6071E DB37 adaptor card.

4 Connect the other end of the rainbow A/D ribbon 
cable to the PBX.

Note: Connection could be made to the MAP OUT 
card instead of a PBX. Contact Plexon for assis-
tance, if needed. 

A/D Card to C-HUB-r with the PXI-6071E P50-100 Adaptor Card

Step Action Image/Comments



B PXI Expansion Chassis 

B-14  Expansion Chassis

A/D Card to C-HUB (in-line connector)

Step Action Image/Comments

1 Ensure the PC power and the expansion chassis 
power are both turned OFF.

Damage to the equipment is possible if the 
power is on.

2 Connect the NI cable to the connector on the PCI-
6071E.

3 Connect the other end of the NI cable to the PCI-
6071E output connector on the C-HUB. 

NOTE: The C-HUB has the PCI-6071E connector 
mounted in-line with the circuit card.
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B.3.3 Connecting a FireWire Card to the CinePlex Camera

The table below contains the procedure to connect a FireWire card in the expan-
sion chassis to the CinePlex camera.

FireWire Card to Camera

Step Action Image/Comments

1 Ensure the CinePlex camera and expansion chas-
sis are both turned OFF.

Damage to the equipment is possible if the 
power is on.

2 Connect the FireWire cable to any connector on 
the FireWire card in the expansion chassis.

3 Connect the other end of the FireWire cable to the 
single or left-most connector of the CinePlex cam-
era (depending on the type of camera to be in-
stalled -  Plexon offers two types of cameras as 
shown in the diagram).
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B.3.4 Connecting a PXI-TIM Card to the MAP System TIM Card

The table below contains the procedure for connecting a Plexon PXI-TIM card in 
the expansion chassis to the MAP System TIM board.

PXI-TIM Card to PC

Step Action Image/Comments

1 Ensure the MAP System power and the expansion 
chassis power are both turned OFF.

Damage to the equipment is possible if the 
power is on.

2 Connect the DB9 end of a TIM cable to the TIM 
connector on the Plexon PXI-TIM card in the ex-
pansion chassis. For details on settings the jump-
ers for 40K and 80K clock speeds, see “Setting 
PXI-TIM Jumpers” on page B-17

3 Connect the other end of the TIM cable to the con-
nector on the MAP System TIM board.

4 For a pre-2008 MAP System, connect the yellow 
wire on the TIM cable to the XS1 BNC connector 
on the MAP TIM board (indicated by the red arrow). 
This step is not needed for MAP systems built in 
2008 and later, which are shipped with a cap on the 
XS1 BNC connector. The cap should remain on the 
XS1 connector on these newer MAP systems at all 
times.
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B.3.5 Setting PXI-TIM Jumpers

Some clock modules have jumpers to set clock speeds of 40 kHz or 80 kHz. Look 
at the lower right corner of the circuit card to determine if the proper jumpers are 
present. Above the name of the card (CCPI SCLCK) there will appear an engi-
neering number (10-04-A-01) if the proper jumpers are there as shown in the dia-
gram below. The engineering number is not present on earlier versions of the 
card. 

Typically, the clock speed is 80 kHz, which corresponds to a ‘fast’ sampling rate 
of 40 kHz. If a smaller file size is desired or there is a need to digitize more spike 
channels at 40 kHz per channel than the card’s bandwidth will allow, set the 
jumpers for a 40 kHz clock, which corresponds to a 20 kHz maximum sampling 
rate. 

Note: A 20 kHz sampling rate will result in spikes being recorded less accurately than 
at 40 kHz; make sure that a 20 kHz rate is adequate before using the lower 
rate.

The table below shows how to set the jumpers on the PXI-TIM card for clock 
speeds of 40KHz or 80KHz.

PXI-TIM Jumper Settings

Step Action Image/Comments

1 Locate the jumper settings on the PXI-TIM circuit 
card.
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2 Ensure that the J15 jumper is set according to the 
image at the right (Jumper across the top two pins).

3a For an 80KHz clock signal, ensure that jumpers J3 
through J14 are set according to the image at the 
right (Jumpers on J6-J11 and J14). An 80kHz clock 
signal is required to run the A/D cards in the chas-
sis at a 40kHz sampling rate (the A/D cards divide 
the incoming clock signal by 2).

3b For a 40KHz clock signal, ensure that jumpers J3 
through J14 are set according to the image at the 
right (Jumpers on J3, J7-J10, and J13). A 40kHz 
clock signal is required to run the A/D cards in the 
chassis at a 20kHz sampling rate (the A/D cards di-
vide the incoming clock signal by 2).

PXI-TIM Jumper Settings

Step Action Image/Comments
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B.3.6 Connecting a BNC-16B to a C-HUB-r/C-HUB

The table below contains the procedure for connecting a C-HUB-r or a C-HUB  
to a BNC-16B.

C-HUB-r/C-HUB to BNC-16B

Step Action Image/Comments

1 Ensure the all power supplies of devices connect-
ed to the C-HUB and BNC-16B are turned OFF.

Damage to the equipment is possible if the 
power is on.

2 Connect one end of a ribbon jumper cable to the 
right-most connector of the C-HUB.

NOTE: The diagram shows a C-HUB-r (PXI-6071E 
connector mounted perpendicular to the circuit 
card). The procedure is the same for the C-HUB.

3 Connect the other end of the ribbon jumper cable 
to the left-most connector of the BNC-16B.

For additional details about the other BNC-16B 
connectors, see BNC-16B Technical Brief.

4 The resulting connection looks like this.
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B.3.7 Expansion Chassis Cards and Cabling

This section describes how to remove and install cards in the PXI/exp expansion 
chassis and how to arrange the cabling.

Cards may never need to be installed or removed from the expansion chassis, but 
follow the procedures below, if necessary.

Removing Cards from the PXI/exp Expansion Chassis

Step Action Image/Comments

1 Make sure the MAP and the expansion chassis are 
plugged into an AC power source.

The power cord provides a ground for the 
chassis and protects components from 
electrical damage while removing the card.

2 Turn off the chassis power.

3 Unscrew the two (2) bracket-retaining screws on 
the faceplate of the card.

NOTE: The screw at the bottom is below the ejec-
tor handle.

NOTE: PXI bracket-retaining screws are 
captive and cannot be removed from the 
card.

4 Touch the metal part of the chassis to discharge 
any static electricity from clothes and body.
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5 Push down on the ejector handle to unseat the 
card connector.

6 Carefully remove the card from the chassis while 
being careful not to snag components on adjacent 
cards during the card’s removal.

CAUTION: Some devices can be dam-
aged by improper handling. Use appropri-
ate electrostatic discharge (ESD) 
procedures when handling these devices. 
See http://www.esda.org/ for additional in-
formation on ESD procedures.

7 Place the card in an anti-static package or follow 
ESD procedures while handling the card.

Installing Cards in the PXI/exp Expansion Chassis

Step Action Image/Comments

1 Make sure the rack and the expansion chassis are 
plugged into an AC power source.

The power cord provides a ground for the 
chassis and protects other components 
from electrical damage while installing the 
card

2 Turn off the chassis power.

3 Clear any obstructions that might cause misalign-
ment of the card on insertion.

4 Touch the metal part of the chassis to discharge 
any static electricity from clothes and body.

Removing Cards from the PXI/exp Expansion Chassis

Step Action Image/Comments

http://www.esda.org/
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5 Set the injector handle in the down position. Re-
move any packaging and any protective caps from 
the retaining screws and connectors.

6 Align the bottom edge of the circuit card with the 
guide channel in the bottom of the slot. Carefully tilt 
the card up and align the top edge of the circuit 
card with the guide channel in the top of the slot.

When the PXI cards are installed, make 
sure the injector handle is in the down po-
sition. Otherwise, the handle interferes 
with correct seating of the card.
Handle Down (correct)

Handle Up (incorrect)

7 Hold the card by the injector handle and carefully 
slide the card into the chassis until the injector han-
dle catches on the rail.

Installing Cards in the PXI/exp Expansion Chassis

Step Action Image/Comments
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The remainder of this section includes explanations and illustrations of rack-
cabling arrangements that include the MAP Expansion Chassis.

8 Raise the injector handle to fully seat the card in 
the chassis. Make sure the front panel of the card 
is even with the front panel of the chassis.

9 Tighten the two (2) bracket-retaining screws on the
faceplate of the card.

Installing Cards in the PXI/exp Expansion Chassis

Step Action Image/Comments
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To simplify packaging and shipping, some cables must be attached after unpack-
ing the expansion chassis. Use the following procedure to complete the cabling.

Cabling the PXI/exp Expansion Chassis

Step Action Image/Comments

1 Follow the procedure in “Connecting a PXI-TIM 
Card to the MAP System TIM Card” on 
page B-16to connect the PXI-TIM card to the MAP 
TIM board.

2 Place the PBX preamp in a convenient location. 
Connect one end of the PBX power cable to the 
power connector on the preamp. For more informa-
tion on PBX connections, refer to the Plexon MAP 
System Installation Guide. At the MAP, turn the 
PREAMP POWER switches OFF (see the red 
oval). As shown in the illustration, connect the oth-
er end of the cable to PREAMP POWER outlet 1 
on the MAP.

3 Connect ribbon cables from the spike boards in the 
PBX preamp to the SIG boards in the MAP. For 
more information on PBX connections, refer to the 
Plexon MAP System Installation Guide. 

The illustration shows a basic connections
for a single PBX with two spike boards.

4 Connect ribbon cable(s) from the field potential 
board(s) in the PBX to the Plexon C-HUB-r card(s)  
as shown in the following illustration.

http://www.plexoninc.com/pdf/MAP%20System%20Installation%20v1.1.pdf
http://www.plexoninc.com/pdf/MAP%20System%20Installation%20v1.1.pdf
http://www.plexoninc.com/pdf/MAP%20System%20Installation%20v1.1.pdf
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5 Complete the installation by connecting the PC   
peripherals to the connectors on the patch panel. 
Connect monitors to the VIDEO connectors. Con-
nect the keyboard and mouse to USB ports. Use 
the LAN connector to connect the computer to a 
network.

6 Before powering down, see “Power Up and Ini-
tialization” on page B-26.

Cabling the PXI/exp Expansion Chassis

Step Action Image/Comments
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B.4 Power Up and Initialization

Pay attention to the following sequence when powering on Plexon MAP System 
equipment.

CAUTION
MAP System Power On/Off Sequence
Required power-on sequence for the MAP system:

  1. PXI Expansion Chassis, if present
  2. MAP box main power
  3. Preamp power switch (on MAP box)
  4. Preamp power switch (on preamp box)
  5. The power to any other digital input device.
  3. The MAP system PC 

Reverse this sequence to power off the MAP system.

.

Using the PXI Expansion Chassis with a MAP System

Step Action Image/Comments

1 Plug the MAP system into a grounded AC outlet. 
Make sure the PC power switch is off.

NOTE: Do not turn the PC on at this step. 
All PXI devices are treated as a single 
chassis. The PC BIOS and operating sys-
tem assume that all PXI devices are avail-
able as soon as code execution begins 
when the PC power switch is turned on. 
This means that all expansion chassis 
must be turned on before the PC. If 
there are more than one expansion chas-
sis, they can be turned on in any order.

2a (Applicable to PXI/exp) From the front of the rack, 
reach above and behind the left side of the expan-
sion chassis to locate the chassis power switch, 
which is shown in the following illustration. Toggle 
the power switch to the on position (located on the 
back left of the expansion chassis).
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2b (Applicable to PXI/exp) In the left-most slot of the 
expansion chassis, the power supply includes two 
LEDs labelled FAULT and POWER. When the 
chassis power switch is turned on, the yellow 
FAULT LED blinks briefly before the green POW-
ER LED turns on. Proper operation is with the 
FAULT light off and the POWER light on.

NOTE: If the POWER LED is off, verify that 
the rack AC power is connected.

3a (Applicable to PXI/exp4 and PXI/exp4-RM) On 
the front of the PXI/exp4 (or PXI/exp4-RM) turn the 
expansion chassis power switch on - shown in the 
top diagram. Ensure that the POWER LED is on - 
shown in the bottom diagram.

The PWR and LINK LEDS display a variety of con-
ditions as follows:
LED          COLOR

PWR         Off
                 Red
                 Green

LINK          Off
                 Green
                 Alternating Green and Red
                 Red
                 Blinking Red

MEANING

No power
Power problem - call Plexon for assistance
Power OK

Link not established
Link established
Link established and activity on PXI bus
Link corrupted -- call Plexon for assistance
Link corrupted -- call Plexon for assistance

Using the PXI Expansion Chassis with a MAP System

Step Action Image/Comments
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3b (Applicable to PXI/exp only) On the left side of 
the expansion chassis, locate the PXI-8360 mod-
ule. Observe the PWR and LINK LEDs. When the 
chassis power is within specifications and a link to 
the PC is established, both LEDs are green. The 
meanings of the PWR and LINK LEDs are as fol-
lows:
LED          COLOR          MEANING
------------------------------------------------------------------
PWR         Off                 No power
                 Red               Power out of spec
                 Green            Power within spec
------------------------------------------------------------------
LINK          Off                 Link not established
                 Green            Link established

NOTE: If the PWR LED is red, contact
Plexon for assistance.

4 At the MAP chassis, turn the power switch on and 
then push RESET (This will reset the clock and re-
set all power in the MAP).

5 At the PC, turn the PC power on. Wait for the PC to 
boot and log on.

See the computer user manual for the lo-
cation of the PC power switch.

Device Configuration

6 (Performed only the first time the system is 
used or when hardware configuration changes) 
This step is performed at Plexon but should be 
confirmed. At the PC, start the MAP Server. From 
the Server View menu, click Options. The Options 
dialog box opens. Select the NIDAQ tab and the il-
lustration at the right appears. Ensure that the Use 
PXI clock interface (cPCI external chassis) 
checkbox is checked. Select the appropriate clock 
frequency (40KHz or 80KHz). If finished, click OK 
to close the Options dialog box and go to step 9. 
To see the NIDAQ devices and their device num-
bers, go to step 7.

Using the PXI Expansion Chassis with a MAP System

Step Action Image/Comments
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7 (Performed only the first time the system is 
used or when hardware configuration changes) 
This step is performed at Plexon but should be 
confirmed. Clicking the Show Available NIDAQ 
Devices button scans the available devices and 
displays a dialog box (a sample appears at the 
right). Verify that the device numbers are the same 
as shown in the NI-MAX program. If not, click OK 
to close this dialog box and correct the device num-
bers on the NIDAQ tab of the Options dialog box. 
When finished, click OK to close the Options dia-
log box.

NOTE: The NI-MAX program may be accessed by 
selecting Measurement & Automation from the 
computer’s Start->All Programs->National In-
struments.

8 (Performed only the first time the system is 
used) Restart the PC to set the PXI interface.

CAUTION: Do not remove any PCI cables 
when the PC is on. Removing the PCI Ex-
press cable between the expansion chas-
sis and the PC while the PC is on can 
cause the PC to hang or cause errors in 
applications communicating with the ex-
pansion chassis.

End of Device Configuration

9 When finished working, turn off the PC power 
switch then turn off the expansion chassis power 
switch.

CAUTION: PC operating systems and 
drivers assume PCI devices are present 
from power on to power off. Do not turn the 
expansion chassis power off before turn-
ing the PC power off. Turning off the ex-
pansion chassis while the PC is running 
can cause the PC to hang or crash.

Using the PXI Expansion Chassis with a MAP System

Step Action Image/Comments
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C.1 Block Diagram

C.2 Description

The C-HUB (Cable Hub) is an interface to most of the inputs and outputs of the 
National Instruments 6071E cards. The 6071E cards provide 64 channels of ana-
log to digital conversion. Physically, C-HUB provides access to the 64 channels 
through four 16-channel connectors. Functionally, however, the 64 channels of 
the 6071E are divided into two groups. The first group consists of channels 1-16 
and the second group consists of channels 17-64. When the 6071E cards are con-
figured in the non-referenced single-ended (NRSE) configuration, as recom-
mended by Plexon, the output of each channel is the amplified difference 
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between the channel input an a common reference input called AISENSE or 
AISENSE2. AISENSE is the common reference input for channels 1-16 and 
AISENSE 2 is the common reference input for channels 17-64. The differential 
recording between the channel input and the AISENSE input helps remove com-
mon mode noise and ground fluctuations from the recorded signal.

• Example 1: The output of channel 3 is the amplified difference between the 
input to channel 3 and the input to AISENSE.

• Example 2: The output of channel 43 is the amplified difference between the 
input to channel 43 and the input to AISENSE2.

The C-HUB provides an interface to the MAP system. When used without an 
expansion chassis, a clock signal from the MAP TIM board is connected to the 
MAP TIM input connector on the C-HUB. When used with an expansion chassis, 
it is not necessary to insert a clock signal into the MAP TIM connector on the C-
HUB. C-HUB also has a Digital Output connector with eight digital outputs (DO 
1 to DO 8). There are individual BNC digital outputs for digital outputs DO 1 
through DO 4. C-HUB also provides an interface to connect the NI-based 
Recorder system output to CinePlex via the REC->CPX output connector as well 
as two BNC analog outputs (AO1 and AO2) and a counter output (CTR1). Each 
of the inputs and outputs are discussed in more detail in later sections. For more 
details, see “Connectors” on page C-6.

C.3 Reference Jumpers

For each 16-channel input connector there is a jumper to determine whether or 
not to use the differential reference input for those channels. In most cases the 
reference input should be used to take advantage of the noise rejection it pro-
vides. The jumper for channels 1-16 should be placed in the AISENSE position, 
and the jumpers for channels 17-32, 33-48, and 49-64 should be placed in the 
AISENSE2 position. 

The only time one or more input connectors may be disconnected from the refer-
ence input is when it is desired to have more than two signal sources and it is nec-
essary to connect two different sources to the same group of C-HUB inputs. In 
this case, disconnect the source with the highest amplitude signals from the refer-
ence input.

C.4 Input Filtering

On the C-HUB, there are no input filters and, therefore, no need for the bypass 
jumpers. All of the inputs are passive and DC-coupled.
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C.5 Card Versions

C-HUB is manufactured in two configurations based on the mounting of the 
6071E A/D output connector. Version 09-02-A-03-01 (CHUB-r) is manufactured 
with the output connector perpendicular to the circuit card while version 09-02-
A-03-02 (CHUB) is manufactured with the output connector in-line with the cir-
cuit card. The images below show the two configurations with the main differ-
ence noted by the red arrows.
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C.6 Connector Layout Diagram

The diagram below identifies the connectors and shows their location on the cir-
cuit card.
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C.7 Connectors

The following sections describe the various input and output connectors.

C.7.1 MAP TIM Input

The MAP TIM Input Connector is a male DB9 connector that can be used to 
bring external timing signals to the 6071E A/D board. When used in conjunction 
with a MAP system, the TIM Input Connector receives a clock signal and a start 
signal from the MAP. When used with a chassis, it is not necessary to use the 
MAP-TIM input. If it is used, it would receive a clock signal and start signal from 
the PXI-TIM card. These signals ensure that the continuous data acquired by the 
A/D card is synchronized with the spike data recorded by the MAP box.

C.7.2 Analog Inputs

These four connectors provide access to the 64 analog input channels AD01 To 
AD64 (in four groups - AD01-AD16, AD17-AD32, AD33-AD48, and AD49-
AD64). There are also reference signals AISENSE (channels 1-16), AISENSE2 
(channels 17-64), and AIGND (all channels). A jumper is used to select whether 
several pins are connected to AISENSE/AISENSE2 or AIGND. When the 
jumper next to CH 1 - 16 is set on AIGND, the AISENSE signal is also connected 
to AIGND. A socket is provided next to each connector for installing optional 
pull-down resistors (resistor from the input to AISENSE or AIGND depending 
on the jumper setting). Standard 10-pin resistor SIPs may be installed in these 
sockets (e.g. Bourns 4610X-101-223LF). 

Plexon does not recommend the use of pull-down resistors. However, they may 
be used if it is necessary to isolate inputs that are not being used or possibly to 
dampen AC hum that may be on certain input channels.
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C.7.2.1 Channels 1-16 Connector

C.7.2.2 Channels 17-32 Connector
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C.7.2.3 Channels 33-48 Connector

C.7.2.4 Channels 49-64 Connector

C.7.3 Output to NI PCI-6071E A/D Card

The National Instruments PCI-6071E Output is a 100-pin connector that connects 
to the National Instruments 6071E A/D card. This output is the primary output of 
the C-HUB.
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C.7.4 Digital Out

This connector provides access to all eight digital output lines (DO1-DO8) which 
may be controlled with the PlexDO utility (The PlexDO readme file may be 
accessed from the C and C++ Client Development Kit or the MATLAB Client 
Development Kit found at http://www.plexoninc.com/support/softwaredev-
kit.html). The LEDs indicate when the corresponding digital output is 5V.

C.7.5 DO1, DO2, DO3, and DO4

These connectors provide BNC access to four of the digital output lines.

C.7.6 REC->CPX

This connector is used to output a clock signal and control signals from the 
Plexon Recorder data acquisition software to a CinePlex video tracking and 
recording system.

http://www.plexoninc.com/downloads/softwareuserguides/PLX_Util.pgf
http://www.plexoninc.com/downloads/softwareuserguides/PLX_Util.pgf


C C-HUB Technical Brief 

C-10  Expansion Chassis

C.7.7 AO1 and AO2

AO1 is Analog Output 1 channel, used by the Plexon Recorder as a monitor chan-
nel. AO2 is not currently used.

C.7.8 CTR1 (GPCTR1)

This connector provides access to GPCTR1 which can be used to output preci-
sion pulses or clock signals using the PlexDO utility.

C.8 Connecting Signals to the C-HUB

The C-HUB was primarily designed to receive the output of up to 64 channels 
from Plexon field potential preamplifiers, but it may be used with a wide variety 
of signal sources. Before connecting multiple signal sources to the C-HUB, it is 
necessary to consider the number of signal sources and the number of outputs 
coming from each source. The goal is to keep the signals from each source iso-
lated from each other and to take advantage of the common mode noise rejection 
provided by the AISENSE and AISENSE2 inputs whenever possible. For exam-
ple, sources of more than 16 signals should be connected to the second group of 
inputs (channels 17-64) since the first group can only accommodate 16 channels. 

When there are more than two distinct signal sources it is not possible to have a 
distinct reference input for each source. In this case, consider the type and ampli-
tude of the signal source before deciding how to connect the sources. For sources 
with low amplitude signals, take advantage of the common mode noise rejection 
provided by having a reference input. Digital (TTL) signals or large amplitude 
signals may not require this noise rejection. The examples on the following pages 
illustrate these points.

Feel free to contact Plexon with questions about connecting more than two 
sources to the C-HUB.

CAUTION
Ground-reference Sources
All signal sources should be ground-referenced, not ‘floating.’ If there 
is a ‘floating’ signal source such as a battery-powered device, please 
contact Plexon for assistance in connecting it to the C-HUB.
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C.9 Examples of Input Connector Configurations

C.9.1 Example 1 (Two Sources)

The primary signal source is a 16-channel preamplifier. The second source has up 
to 16 channels. The BNC-16B panel provides a convenient mechanism for bring-
ing signals to the C-HUB from sources with standard BNC connectors.

Connect the primary source to the first group of C-HUB inputs, channels 1-16. 
The reference jumper for channels 1-16 should be placed in the AISENSE posi-
tion (no jumper).

Connect the secondary signal source to the second group of channels, channels 
17-32. The reference jumper for channels 17-32 should be set to AISENSE2.
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C.9.2 Example 2 (Two Sources)

The primary signal source is a 32-channel preamplifier. The second source has up 
to 16 channels.

Connect the primary source to the second group of C-HUB inputs, channels 17-
48. The reference jumper for channels 17-32 and for channels 33-48 should be set 
to AISENSE2.

Connect the second signal source to the first group of C-HUB inputs, channels 1-
16. The reference jumper for channels 1-16 should be placed in the AISENSE 
position.
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C.9.3 Example 3 (Three Sources)

The primary source is a 32-channel preamplifier. The second source has up to 16 
channels and has low amplitude signals. The third source has up to 16 channels 
and has large amplitude signals.

Connect the primary signal source to the second group of C-HUB inputs, chan-
nels 17-64. In the example it is connected to channels 33-64. The reference 
jumper for channels 33-48 and 49-64 should be set to the AISENSE2 position.

Connect the second signal source (with low amplitude signals) to the first group 
of C-HUB channels (1-16) to take advantage of the reference input AISENSE. 
The reference number for channels 1-16 should be set to the AISENSE position.

Connect the third signal source to the remaining channels in group 2, channels 
17-32. To prevent ground noise from this source from coupling onto the other 
channels of group 2, set the reference jumper for channels 17-32 to the AIGND 
position (or remove the jumper completely).
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D.1 Description

The BNC-16B is a break-out panel with 16 BNC connectors, a 37-pin D-sub con-
nector, and a 34-pin box header connector.

In a typical Plexon data acquisition system Dsub connectors are often used as 
input connectors for 16 recording channels and 34-pin box headers are often used 
as output connectors for 16 recording channels. The BNC-16B provides easy 
access to individual input and output channels.

The BNC-16B may also be inserted between a signal source and its destination to 
provide the means of monitoring the signals by a third device. The BNC-16B also 
provides the means of interrupting signal flow on selected channels and injecting 
alternate signals in their place by using jumper blocks dedicated to this purpose.

D.2 Card Configurations

The BNC-16B may be used in two configurations. One configuration is to mount 
the BNC-16B on a rack or chassis (3U) and the other is to use it on a table top by 
attaching the feet included with the BNC-16B.
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D.3 Connector Layout Diagram

The diagram below identifies the connectors and shows their location on the cir-
cuit card.
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D.4 Connectors

The following sections describe the various input and output connectors.

D.4.1 Dsub Connector (37-pin)

The 37-pin Dsub connector may be used to connect input signals from  a PBX, 
OUT, or DO board. It may also be used to connect the output from the BNC-16B 
to a C-HUB.

D.4.2 BNC Connectors

The BNC connectors may be used to monitor signals by connecting one or more 
to a third device, such as an oscilloscope. These connectors may also be used for 
signal injection by removing the appropriate jumpers next to one of the main con-
nectors (the 37-pin Dsub or the 34-pin block header - later examples show how 
this is accomplished).

D.4.3 Box Header (34-pin)

The 34-pin box header connector may be used to connect inputs from a PBX, 
OUT board, or DO board. It may also be used to connect the output of the BNC-
16B to a C-HUB, PBOB, or SIG board.
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D.4.4 Jumper Blocks

Each jumper block has 16 jumpers corresponding one-to-one to the BNC connec-
tors. There is a jumper block (P3) between the BNC connectors and the 37-pin 
Dsub connector and a jumper block (P4) between the BNC connectors and the 
34-pin block header. Mounting the jumper on the posts connects the BNC con-
nector to the adjacent pin on the 37-pin or 34-pin connector. Examples that show 
how to input signals are shown later in the technical brief.
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D.5 Connecting Signals to the BNC-16B

The diagram below shows how inputs and tap signals for outputs may be con-
nected to the BNC-16B.
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D.6 Examples of BNC-16B Connections

The BNC-16B may be used in a variety of configurations. The following sections 
show the various configurations.

D.6.1 Example 1 (Accessing Outputs)

The output from a Plexon preamplifier (PBX) or a Plexon MAP System analog 
board, OUT/32 board, or digital output (DO) board may be connected to the 
BNC-16B. Both of these connections are shown in the diagram below.

P3 P4
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D.6.2 Example 2 (Accessing Inputs)

The BNC-16B may be used to feed signals into an A/D subsystem through a C-
HUB interface by connecting the 34-pin header to the C-HUB using Plexon cable 
06-18-A-03-xxxx as shown in the diagram below. The xxxx in the part number 
identifies the cable type number and the length of the cable as described below:

When a BNC-16B is mounted very close to a C-HUB, it is convenient to connect 
the BNC-16B to the C-HUB using Plexon cable 06-18-A-01-xxxx as shown in 
the diagram below.

x (left digit) xxx (right 3 digits)

cable type = 1, 2, or 3 length of cable (inches) e.g. 095 = 9.5
inches

Note: the right digit designates the
fractional part of an inch.
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D.6.3 Example 3 (Signal Monitoring)

The BNC-16B may be inserted between a signal source and its destination to 
monitor signals flowing through the BNC-16B by using a third device, such as an 
oscilloscope. For example, a preamplifier may be connected to the 37-pin Dsub 
connector using Plexon cable 06-18-A-03-xxxx while the 34-pin header is con-
nected to an A/D subsystem using a second Plexon cable 06-18-A-03-xxxx as 
shown in the diagram below.

In this case the signal source (i.e. PBX or OUT) should be connected to the 34-
pin header using Plexon cable 06-18-A-02-xxxx as shown in the diagram below.



D BNC-16B Technical Brief 

D-10  Expansion Chassis

D.6.4 Example 4 (Signal Substitution)

When the BNC-16B is used in the Signal Substitution configuration, any of the 
individual signal channels may be disconnected from the source using the jump-
ers on the BNC-16B (P3 or P4). After the signal channel has been disconnected 
from the source, an alternate input signal may be connected to the BNC connector 
as shown in the diagram below.

The diagram below shows a Signal Substitution example when a BNC-16B is 
mounted very close to a C-HUB.
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use of in classification 14

toolbar
for GAC 224
in GridMon 251
in PEC 240
in Ref2 167
in Sort Client, list of items 105
use in GAC 212
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U
unit channels

in PEC, selection of 239
Units display

in Sort Client, description of 103
Update Server button

use for 86

V
views

in GAC, adjusting of 214
in GAC, descriptions of 211
in GAC, list of 213
in GAC, resizing and moving windows 

212
in PEC, switching of 243

VLSI headstages
referencing connections for 170

W
waveform templates

use of in classification 14
window width

in Sort Client, setting of 54

Z
zoom

in Sort Client, Settings table 84
Zoom factor

in Sort Client, setting of 29
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trademark of WinZip Computing Inc. NeuroExplorer is a trademark of Nex Technologies. Adobe and Reader are trademarks of Adobe 
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